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Предисловие
В этой книге вы найдете примеры, демонстрирующие широкие возможности языка 
Visual Basic. Понятное описание поможет вам воссоздать их на своем компьютере без 
труда. Кроме того, вы можете скачать архив со всеми примерами из книги, выполнив 
следующие шаги.

1. Откройте браузер и загрузите архив по ссылке eksmo.ru/files/VB_Primers.rar.

2. Извлеките содержимое ZIP-архива в любую удобную для вас папку на компьюте­
ре. Для удобства все проекты распределены по папкам, имена которых совпадают 
с названиями глав. При этом название каждого проекта совпадает с упоминаю­
щимся в книге. Например, проект «Первые шаги», создаваемый в первой главе, 
находится в папке 01.

3. Для запуска проекта в интегрированной среде разработки Visual Studio дважды 
щелкните мышью по файлу Visual Basic (расширение файла.s/и).



Первые шаги

Добро пожаловать 
в восхитительный 

мир программирования 
на языке Visual 

Basic. В этой главе 
мы познакомим вас 

с интегрированной средой 
разработки Visual Studio 

и покажем. как создавать 
приложения для Windows.

• Введение

• Установка пакета Visual Studio

• Исследование среды разработки

• Создание нового проекта

• Добавление визуального элемента 
управления

• Добавление функционального кода

• Сохранение проектов

• Повторное открытие проектов

• Заключение
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Решив начать программировать на Visual Basic, вы сделали правильный 
выбор, ведь создавать на нем программы для Windows просто и весе­
ло. На этом языке вы можете писать собственные программы, получать 
максимальный контроль над личным компьютером, а также автомати­
зировать свою работу и повышать производительность.

Как и другие языки, Visual Basic имеет определенное количество важ­
ных «ключевых слов» и набор правил синтаксиса. Новички зачастую 
находят синтаксис этого языка более простым по сравнению с другими 
языками программирования, и это делает Visual Basic популярным язы­
ком для самостоятельного изучения.

Несмотря на то, что написание программ может быть сложной задачей, 
Visual Basic позволяет упростить первые шаги в программировании — 
вы сами выбираете, насколько глубоко его изучать. Еще одним преиму­
ществом Visual Basic является то, что он работает как с Microsoft Office, 
так и в Интернете, таким образом, количество возможностей этого 
языка велико...

• Visual Basic (VB) — это лучший язык программирования для но­
вичков или любителей, позволяющий быстро начать создавать соб­
ственные приложения для Windows

• Visual Basic for Applications (VBA) — это диалект языка Visual Basic, 
встроенный во все приложения Microsoft Office. Программы, со­
зданные на этом языке, запускаются внутри приложений Microsoft 
Office, а не как отдельные приложения.



Эволюция языка Visual Basic

Visual Basic 1.0 представлен в мае 1991 на ярмарке Comdex в городе Ат­
ланта, США.

Visual Basic 2.0 выпущен в ноябре 1992-го — представлена облегченная
и ускоренная среда программирования.

• Visual Basic 3.0 выпущен летом 1993-го — представлен механизм 
Microsoft Jet Database Engine для программ, работающих с базами 
данных.

• Visual Basic 4.0 выпущен в августе 1995-го — предоставлена под­
держка элементов управления на основе объектной модели компо­
нентов (Component Object Model, COM).

• Visual Basic 5.0 выпущен в феврале 1997-го — представлена возмож­
ность создания пользовательских элементов управления.

• Visual Basic 6.0 выпущен летом 1998-го — представлена возможность 
создавать веб-приложения. Эта чрезвычайно популярная редакция 
языка стала последней, основанной на технологии СОМ, сегодня ее 
часто называют «Классическим Visual Basic».

• Visual Basic 7.0 (также известный как Visual Basic .NET), выпущен­
ный в 2002 году, представлял собой очень отличающийся от пред­
шественников объектно-ориентированный язык, основанный 
на технологиях Microsoft .NET Framework. Эта спорная редакция 
нарушила обратную совместимость с предыдущими версиями и вы­
звала раскол в сообществе программистов.

• Visual Basic 8.0 (доступен в составе пакета Visual Studio 2005) — 
по сравнению с предыдущей версией добавлены возможности язы­
ка .NET 2.0.

• Visual Basic 9.0 (доступен в составе пакета Visual Studio 2008) — 
по сравнению с предыдущей версией добавлены возможности язы­
ка .NET 3.5.

• Visual Basic 10.0 (доступен в составе пакета Visual Studio 2010) — 
по сравнению с предыдущей версией добавлены более мощные воз­
можности среды  .NET 4.0 Framework.

• Visual Basic 11.0 (доступен в составе пакета Visual Studio 2012) — 
по сравнению с предыдущей версией добавлены более мощные воз­
можности среды .NET 4.5 Framework.

Visual Basic берет свое 
начало от раннего, более 
простого языка BASIC, на­
звание которого на англий­
ском — это акроним фразы 
«Многоцелевая символьная 
программная инструкция 
для начинающих» (Beginners 
All-purpose Symbolic Instruc­
tion Code). Часть названия 
Visual была добавлена позд­
нее, когда стало возможным 
визуальное выполнение 
большинства задач без 
необходимости написания 
программного кода.



• Visual Basic 12.0 (доступен в составе пакета Visual Studio 2013) — 
по сравнению с предыдущей версией реализованы инновации новой 
платформы Windows 8.1 и улучшен пользовательский интерфейс.

• Visual Basic 14.0 (доступен в составе пакета Visual Studio 2015) — 
по сравнению с предыдущей версией добавлены более мощные 
возможности среды .NET 4.6 Framework и новые инструменты для 
более комфортной работы с кодом.

• Visual Basic 14.0 (доступен в составе пакета Visual Studio 2017) 
по сравнению с предыдущей версией добавлены новые возможно­
сти управления точками останова и расширения языков програм­
мирования, в том числе и Visual Basic.

Все примеры из этой книги были созданы для Visual Studio 2017, впро­
чем, все основные функции языка также характерны и для предыдущих 
версий Visual Studio / Visual Basic.
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Установка Visual Studio
Для того чтобы начать создавать приложения для Windows с помощью 
языка программирования Visual Basic, вы сначала должны установить 
интегрированную среду разработки Visual Studio.

Microsoft Visual Studio — это профессиональный инструмент, предо­
ставляющий полноценную интегрированную среду разработки для 
языков Visual C++, Visual С#, Visual J# и Visual Basic.

Microsoft Visual Studio Express — это упрощенная версия Visual Studio, 
созданная специально для тех, кто обучается программированию. Эту 
среду характеризует минималистичный интерфейс и отсутствие неко­
торых сложных функций, присутствующих в профессиональной вер­
сии, — это сделано во избежание возникновения путаницы. С помощью 
этой среды вы можете создавать приложения для Windows, используя 
язык Visual Basic (или другие языки) для написания программного кода.

В отличие от полнофункционального продукта Visual Studio, Visual 
Studio Express — абсолютно бесплатная программа, которая может 
быть установлена на любой системе, соответствующей следующим тре­
бованиям.

Операцион­
ная система

ЦПУ
(процессор)

ОЗУ (память)

НЖМД (жест­
кий диск)

Видеокарта

Windows 10 версии 1507 или более поздней
Windows Server 2016
Windows 8.1 (с обновлением 2919355)
Windows Server 2012 R2 (с обновлением 
2919355)
Windows 7 SP1 (с обновлением 3033929)

1,8 ГГц или более мощный. Рекомендуется 
использовать как минимум двухъядерный 
процессор.

Не менее 2048 Мб (2 Гб)

от 1 Гб до 40 Гб, в зависимости от установлен­
ных компонентов, скорость HDD не ниже 5400 
об./мин

DirectX 9-совместимая, с разрешением экрана 
720р (1280 на 720 пикселов) или выше

Visual Studio
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Basic при написании данной книги была использована среда Visual 
Studio Express для Windows Desktop. Чтобы установить ее, выполните 
шаги, перечисленные далее.

1. Откройте браузер и перейдите к странице загрузки Visual Studio Ex­
press на сайте компании «Майкрософт». В момент написания книги ад­
рес страницы выглядел следующим образом: www.visualstudio.com/ 
vs/visual-studio-express/.

2. Щелкните мышью по кнопке Download Community (Загрузить вер­
сию Community), в появившемся диалоговом окне Сохранить как 
(File Download) щелкните мышью по кнопке Сохранить (Save) и со­
храните файл установщика vs_community.exe в любой папке.

3. Для запуска установщика щелкните мышью по файлу vs_community. 
ехе, в появившемся окне установите флажок Разработка классиче­
ских приложений .NET (.NET desktop development). Нажмите кноп­
ку Установить (Install) для продолжения установки.

Позднее вы можете устано­
вить (или удалить) дополни­
тельные компоненты среды 
разработки, если это пона­
добится.

Выбор другой папки для 
установки продукта может 
потребовать изменения 
путей к требуемым файлам 
в дальнейшем, поэтому 
рекомендуется согласиться 
с предложенным вариантом 
установки.

http://www.visualstudio.com/


Исследование среды 
разработки
Для запуска интегрированной среды разработки Visual Studio нажмите 
кнопку Пуск (Start) и щелкните мышью по значку установленной среды 
разработки Visual Studio:

Visual Studio
здравствуйте!

Просмотр своего профиля Visual Studio

Запуск в знакомом окружении

Параметры разработки:

Выберите цветовую схему

Эти параметры можно будет изменить позже.

В раскрывающемся списке выберите пункт Visual Basic и укажите же­
лаемую цветовую схему. После этого нажмите кнопку Запуск Visual 
Studio (Run Visual Studio) на экране появится интегрированная сре­
да разработки (IDE) Visual Studio. Данная среда предоставляет доступ 
практически ко всем средствам, которые понадобятся вам для создания

Через некоторое время на экране появится диалоговое окно, предназна­
ченное для задания первичных параметров среды разработки.
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здавать восхитительные графические интерфейсы, вводить программ­
ный код, компилировать и запускать приложения, выполнять отладку 
ошибок и многое другое.

По умолчанию интегрированная среда разработки Visual Studio откры­
вает вкладку Начальная страница (Start page), а также стандартные 
компоненты IDE и выглядит следующим образом:

Элементы вкладки Начальная страница

По умолчанию вкладка Начальная страница (Start page) содержит сле­
дующие элементы.

• Удобный список открывавшихся ранее проектов, позволяющий 
выбрать и повторно открыть уже имеющийся проект либо создать 
новый.

• Полезные гиперссылки, предлагающие помощь по различным во­
просам, связанным со средой разработки Visual Studio, технологией 
Microsoft Azure и новым возможностям.

• Последние новости, публикуемые сетью разработчиков Microsoft 
Developer Network (MSDN).

Вы можете вернуться 
к вкладке Начальная стра­
ница (Start раде) в любое 
время, выбрав пункт На­
чальная страница (Start 
Раде) меню Файл (File).

Обозреватель решений

Строка меню

Панель
инструментов

Панель
элементов

Последние
проекты

Строка
состояния



Компоненты среды Visual Studio

По умолчанию среда разработки Visual Studio предоставляет следую­
щие стандартные компоненты.

• Строка меню — здесь вы можете выбрать действия, которые необ­
ходимо совершить с проектами, и получить доступ к Справке. Меню 
состоит из разделов Файл (File), Правка (Edit), Вид (View), Проект 
(Project), Отладка (Debug), Команда (Command), Сервис (Tools), 
Тест (Test), Анализ (Analyze), Окно (Window) и Справка (Help).

• Панель инструментов позволяет вам совершать самые востребо­
ванные действия, доступные в меню, с помощью всего одного щелч­
ка по соответствующему значку-закладке.

• Панель элементов — здесь вы можете выбрать необходимый визу­
альный элемент и добавить его в проект. Чтобы увидеть содержи­
мое панели, установите указатель мыши на название панели. Когда 
открыт проект, на этой панели вы сможете увидеть такие элемен­
ты управления как Button, Label, CheckBox, RadioButton, 
TextBox.

• Обозреватель решений (Solution Explorer) — здесь вы можете уви­
деть все файлы и ресурсы, содержащиеся в открытом проекте.

• Строка состояния — здесь вы можете узнать состояние выполняе­
мого в настоящий момент задания. При сборке решения в строке 
состояния будет отображено сообщение Сборка начата (Building 
started), а по завершении оно будет изменено на Сборка успешно 
завершена (Build succeeded) или Ошибка при сборке (Build failed).

Ссылки на онлайн-ресурсы 
на вкладке Начальная стра
ница (Start раде) требуют 
подключения компьютера 
к Интернету. В случае если 
ссылки не открываются 
или работают некорректно, 
проверьте подключение 
к Интернету.
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1. В строке меню выберите пункт Файл => Создать проект (File => New 
Project) или просто воспользуйтесь сочетанием клавиш Ctrl+N для 
открытия диалогового окна Создание проекта (New Project).

2. В диалоговом окне Создание проекта (New Project) щелкните по ша­
блону Приложение Windows Forms (Windows Forms Application).

В диалоговом окне Созда­
ние проекта (New Project) 
по умолчанию выбран вари­
ант Приложение Windows 
Forms (Windows Forms Appli­
cation), так как это наиболее 
часто используемый шаблон.

3. В поле Имя (Name) введите название проекта на свое усмотрение. 
В нашем случае проект будет носить название Первые шаги.

В диалоговом окне Создание проекта (New Project) вы при желании 
можете изменить имя проекта, если он является частью более крупного 
решения. Для простых приложений просто оставьте имя проекта та­
ким же, как и имя решения.



Выбрать папку, в которой вы хотите сохранить свой проект, можно бу­
дет во время сохранения.

4. Нажмите кнопку ОК для создания нового проекта.

Среда Visual Studio создаст новый проект и загрузит его в интерактив­
ную среду разработки. Вместо вкладки Начальная страница (Start page) 
вы увидите вложенное окно конструктора форм, в котором отображена 
форма по умолчанию, кроме того, под панелью Обозреватель решений 
(Solution Explorer) вы можете видеть новую панель Свойства (Properties).

Панель
Обозреватель решений

Панель Свойства

Конструктор форм

Конструктор форм — это холст, на котором вы создаете визуальные ин­
терфейсы своих приложений, а панель Свойства (Properties) содержит 
дополнительную информацию об элементе, выделенном в настоящий 
момент в окне конструктора форм.

Теперь среда разработки Visual Studio собрала все ресурсы, необходи­
мые для сборки простейшего приложения для Windows. Для запуска 
приложения нажмите кнопку Запуск (Start) на панели инструментов.

Данное приложение создает простое 
окно, которое вы можете перемещать, 
сворачивать и разворачивать, изме­
нять его размер или закрывать его, 
тем самым выходя из приложения. 
Конечно, это приложение не обладает 
богатым функционалом, но зато вы 
уже создали свою первую программу 
для Windows!

Вы также можете запускать 
приложения, нажав клави­
шу F5.
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При щелчке мышью по дру­
гой части интерфейса Visual 
Studio панель элементов авто­
матически спрячется, однако 
ее можно закрепить, чтобы 
предотвратить закрывание. 
Для этого воспользуйтесь 
значком с изображением кан­
целярской булавки в заголов­
ке панели элементов.

Любое закрепленное окно 
(вкладка или панель) Visual 
Studio может быть перене­
сено в любое удобное вам 
место. Для закрепления окна 
перенесите его в исходное 
положение.

Добавление визуального 
элемента управления
Панель элементов интегрированной среды разработки Visual Studio со­
держит большое количество визуальных элементов управления, являю­
щихся строительными блоками ваших приложений. Для начала рабо­
ты с панелью элементов, используя проект, созданный на предыдущей 
странице, выполните нижеследующие шаги.

1. Чтобы отобразить содержи­
мое панели элементов, щелк­
ните мышью по вертикальной 
вкладке Панель элементов 
(Toolbox) в левой части окна 
Visual Studio или выберите 
команду меню Вид => Панель 
элементов (View => Toolbox).

2. Откройте список наиболее 
часто используемых элемен­
тов управления, щелкнув
по заголовку категории Стан­
дартные элементы управ­
ления (Common Controls). 
Очень полезно, что название 
каждого элемента управления 
приводится справа от значка, 
в качестве подсказки изобра­
жающего этот элемент управ­
ления. Чтобы закрыть список 
элементов, вы можете еще 
раз щелкнуть мышью по за­
головку категории и откры­
вать другие категории, чтобы 
осмотреть все разнообразие 
элементов управления, кото­
рые вы можете использовать 
для создания графических 
интерфейсов своих приложе­
ний.



3. Нажав и удерживая кнопку мыши на элементе управления Button 
в категории Стандартные элементы управления (Common 
Controls), перенесите ее в форму в окне конструктора, либо дважды 
щелкните мышью по элементу управления Button, это также до­
бавит его в форму.

Button — один из наиболее 
полезных элементов управ­
ления: ваша программа 
определяет, что происходит, 
когда пользователь щелкает 
мышью по этому элементу.

В окне конструктора форм элемент управления Button отображается 
окруженным «маркерами», которые можно перетаскивать для измене­
ния ширины или высоты кнопки. Щелкните мышью по кнопке Запуск 
(Start) или нажмите клавишу F5, чтобы запустить приложение и проте­
стировать работу кнопки.

При щелчке мышью элемент 
управления Button (Кноп­
ка) не выполняет никаких 
функций до тех пор, пока вы 
не добавите немного кода.

Элемент управления Button ведет себя знакомым образом: как любая 
кнопка в приложениях для Windows, при этом реакцией на указатель 
мыши является изменение «состояния» кнопки:

Состояние Состояние при уста- Нажатое
по умолчанию новленном указателе состояние



Добавление 
функционального кода
Среда разработки Visual Studio автоматически в фоновом режиме ге­
нерирует код, необходимый для вставки добавляемых вами элементов 
управления в интерфейс вашей программы. Дополнительный код мо­
жет быть добавлен вручную с помощью встроенного редактора кода 
Visual Studio. Такой код позволяет установить, каким образом вашей 
программе следует отвечать на события интерфейса, например, когда 
пользователь нажимает на кнопку.

Чтобы начать пользоваться редактором кода в Visual Studio, для проек­
та, созданного на предыдущей странице, выполните следующие шаги.

1.  В окне конструктора форм 
дважды щелкните мышью 
по кнопке, которую вы доба­
вили в форму. В ответ на это 
действие откроется новое вло­
женное окно — это и есть окно 
редактора кода.

2. Текстовый курсор автоматически помещен именно в том месте, где 
необходимо ввести код, отвечающий за реакцию программы на щел­
чок мышью по данной кнопке. Введите программную инструкцию 
MsgBox ("Здравствуй, мир! ") так, чтобы окно редактора кода 
выглядело точно следующим образом:

Для быстрого переключения 
между редактором кода 
и конструктором форм (или 
вкладкой Начальная стра­
ница (Start page)) щелкните 
мышью по соответствующей 
вкладке.
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3. Запустите приложение, щелкнув мышью по кнопке Запуск (Start) 
или нажав клавишу F5, чтобы протестировать только что написан­
ный код и то, каким образом этот код обрабатывает событие, насту­
пающее, когда пользователь нажимает кнопку.

4. Чтобы закрыть создаваемое приложение, нажмите кнопку ОК, а за­
тем щелкните мышью по кнопке х в диалоговом окне или нажми­
те кнопку Остановить отладку (Stop Debugging) на панели среды 
Visual Studio, чтобы остановить выполнение программы.

Каждый раз, когда пользователь нажимает кнопку в приложении, про­
грамма считывает строку кода, которую вы вписали вручную, и выво­
дит диалоговое окно, содержащее определенное сообщение. Нажатие 
кнопки создает событие Click, связанное с введенным вами участком 
кода, называемым «обработчик события». Таким образом, программа 
«узнает», как необходимо реагировать на произошедшее событие.

Предоставление осмысленных реакций на события, происходящие 
в ваших программах, — это сама квинтэссенция создания приложений 
для Windows на языке Visual Basic.

Чтобы в любое время 
открыть окно Код (Code), 
Конструктор (Designer) или 
любое другое, воспользуй­
тесь меню Вид (View).
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Даже самый простой проект Visual Basic состоит из большого количе­
ства файлов, которые должны храниться на вашем компьютере.

Для сохранения текущего проекта на жестком диске выполните следую­
щие шаги.

1. Щелкните по кнопке Сохра­
нить все (Save All), воспользуй­
тесь командой меню Файл => 
Сохранить все (File => Save 
All) либо нажмите сочетание 
клавиш Ctrl+Shift+S, чтобы 
сохранить все файлы проекта.

2. В диалоговом окне Сохранить проект (Save Project) вы можете из­
менить названия проекта и решения. В большинстве случаев эти 
названия совпадают.

3. В поле Расположение (Location) укажите каталог, в котором следует 
сохранить проект.

4. Убедитесь, что флажок Создать каталог для решения (Create direc­
tory for solution) установлен, и нажмите кнопку Сохранить (Save), 
чтобы сохранить файлы проекта.

В меню вы можете выбрать 
пункт Файл => Закрыть 
проект (File=> Close Project), 
чтобы закрыть текущий про­
ект. В этом случае система 
предложит вам перед закры­
тием сохранить изменения, 
внесенные в проект.

Каталог Debug в папке 
с сохраненным проектом со­
держит исполняемый файл 
приложения (с расширени- 
ем.ехе). Вы можете дважды 
щелкнуть мышью по этому 
файлу — и запустить свою 
программу как любое другое 
приложение для операцион­
ной системы Windows.



Повторное открытие 
проектов
Выполните следующие шаги для повторного открытия сохраненных 
проектов Visual Studio.

1. Выберите команду меню Файл => Открыть проект (File => Open 
Project) или воспользуйтесь сочетанием клавиш Ctrl+O для откры­
тия диалогового окна Открыть проект (Open Project).

Во избежание путаницы 
не открывайте несколько 
проектов одновременно. Так 
следует поступать только 
в тех случаях, когда несколь­
ко проектов должны быть 
открыты одновременно для 
целей программирования 
более высокого уровня.

2.  В диалоговом окне Открыть проект (Open Project) перейдите к пап­
ке, в которой вы сохранили свой проект.

3.  Дважды щелкните мышью по файлу Visual Studio с расширением.s/и, 
чтобы открыть проект в интегрированной среде разработки, либо 
откройте папку с именем проекта и дважды щелкните файл проекта 
Visual Studio с расширением.vbproj, что также приведет к открытию 
проекта в Visual Studio.

Если после повторного от­
крытия проекта вы не види­
те окно конструктора форм, 
щелкните по пункту Form!. 
vb на панели Обозреватель 
решений (Solution Explorer).



Заключение
• Для создания проекта приложения Windows используется шаблон 

Приложение Windows Forms (Windows Forms Application) в диало­
говом окне Создание проекта (New Project).

• При создании нового проекта Visual Studio в соответствующем поле 
диалогового окна Создание проекта (New Project) должно быть вве­
дено уникальное название проекта.

• Окно конструктора форм интегрированной среды разработки Visual 
Studio — это то место, в котором вы создаете визуальный интерфейс 
своей программы.

• Визуальные элементы управления, составляющие интерфейс вашей 
программы, могут быть добавлены с помощью панели элементов.

• Элемент управления может быть перенесен мышью из панели эле­
ментов в форму или добавлен в форму двойным щелчком.

• При добавлении новых элементов управления в форму, Visual Studio 
автоматически в фоновом режиме генерирует необходимый про­
граммный код.

• Редактор кода в IDE Visual Studio — это область, где вы вручную 
добавляете дополнительный код в свою программу.

• Дважды щелкните мышью по любому элементу управления в окне 
конструктора форм, чтобы открыть редактор кода, при этом тексто­
вый курсор будет установлен в той позиции кода, где находится об­
работчик события для выбранного элемента управления.

• Для запуска приложения открытого в настоящий момент проекта 
вы можете воспользоваться кнопкой Запуск (Start), находящейся 
на панели инструментов Visual Studio.

• Нажатие кнопки запущенного приложения создает событие Click  
в программе.

• Код, добавленный в обработчик события Click  кнопки, определя­
ет, каким образом программа отреагирует на нажатие этой кнопки.

• Предоставление осмысленных программных ответов на события — 
квинтэссенция программирования на языке Visual Studio.

• Во избежание случайных потерь не забывайте явно сохранять про­
ект, над которым работаете, с помощью кнопки Сохранить все (Save 
All) на панели инструментов.

• Для повторного открытия проекта выберите файл с расширением .sin 
в папке, которую вы использовали для сохранения данного проекта.



Установка
параметров

В этой главе описывается, 
каким образом свойства 

приложения могут 
быть изменены во время 

проектирования или 
во время работы (прогона) 

приложения, то есть 
тогда, когда приложение 
запушено и используется.

• Свойства формы

• Первая встреча с панелью Свойства

• Редактирование значений свойств

• Кодирование значений свойств

• Применение вычисленных значений

• Применение пользовательских значений

• Запрос ввода данных

• Установка свойств диалогового окна

• Заключение
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Большинство приложений, создаваемых с помощью Visual Studio, осно­
ваны на окне формы — холсте, на котором вы рисуете пользовательский 
интерфейс. В некоторых случаях приложение может иметь несколько 
форм — и язык Visual Basic позволяет вам отображать и скрывать фор­
мы во время работы приложения. Закрытие основной формы означает 
выход из приложения.

Как и все прочие объекты Visual Basic, форма имеет несколько интерес­
ных и знакомых вам свойств, как, например, выделенные ниже.

Icon — маленький графический 
значок, появляющийся в левом 
верхнем углу открытой формы 
и в свернутом состоянии

Text — надпись, появляю­
щаяся в строке заголовка от­
крытой формы и в свернутом 
состоянии

BackColor — 
цвет фона формы

Size — высота 
и ширина формы

StartPosition — 
изначальное положе­
ние формы на Рабо­
чем столе Windows

Форма — это окно, имен­
но поэтому на форме есть 
кнопки сворачивания, раз­
ворачивания и закрытия,как 
и у всех обычных окон.



Первая встреча с панелью 
Свойства
Интегрированная среда разработки Visual Studio предоставляет панель 
Свойства (Properties), в которой вы можете просмотреть свойства лю­
бого объекта. Данная панель отображает перечень свойств выделенно­
го в настоящий момент объекта, а также значения этих свойств. К при­
меру, полный список свойств формы гораздо больше, чем показанный 
на рисунке ниже. Вы можете посмотреть полный перечень свойств 
на панели Свойства (Properties).

1. Найдите панель Свойства (Properties) в Visual Studio. Если панель 
закрыта, выберите команду меню Вид => Окно свойств (View => 
Properties Window) или нажмите клавишу F4.

2. Выберите команду меню Файл => Создать проект (File => New 
Project), чтобы создать новый проект Windows Forms с именем, 
предложенным по умолчанию.

3. Щелкните мышью по пустой форме в окне конструктора, чтобы ото­
бразить свойства этой формы на панели Свойства (Properties).

4. Нажимайте кнопки в верхней 
части панели Свойства (Pro­
perties), чтобы ознакомиться 
с различными вариантами 
отображения списка свойств: 
по категориям или в алфавит­
ном порядке.

5. Чтобы осмотреть весь список 
свойств формы и их значения 
в настоящий момент времени, 
воспользуйтесь полосой про­
крутки на панели Свойства 
(Properties).

У каждого объекта в Visual 
Studio есть свое имя. Имя 
выбранного в настоящий мс 
мент объекта отображается 
в раскрывающемся списке 
в верхней части панели 
Свойства (Properties).

Несмотря на то, что 
Forml — это значение 
по умолчанию как для свой­
ства Text, так и для свой­
ства (Name), очень важно 
понимать, что свойство 
Text устанавливает только 
надпись в строке заголовка 
формы, тогда как значение 
свойства (Name) исполь­
зуется для ссылки на эту 
форму из программного 
кода Visual Basic.
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свойств
Изменение свойств объекта Visual Basic позволяет определить внешний 
вид этого объекта. Во время проектирования при создании интерфей­
са вы можете изменить значение свойства Size  объекта, просто пере­
тащив маркеры этого объекта, тем самым скорректировав его размер. 
Новые значения высоты и ширины объекта автоматически отобразятся 
на панели Свойства (Properties). Более полезным и удобным является 
то, что значения всех свойств формы и элементов управления могут 
быть изменены напрямую на панели Свойства (Properties).

Редактирование значений свойств формы

1. Щелкните мышью по создаваемой автоматически пустой форме 
в окне конструктора форм, чтобы отобразить свойства этой формы 
на панели Свойства (Properties).

2. На панели Свойства (Properties) найдите свойство Text ,  затем два­
жды щелкните мышью по тексту Forml в ячейке правее, чтобы вы­
делить текущее значение данного свойства.

3. Введите с клавиатуры новое 
значение свойства Text, 
например Новая надпись. 
По мере ввода в столбце зна­
чения будет появляться новая 
строка текста.

4. Нажмите клавишу Enter или щелкните мышью по любому участ­
ку экрана, чтобы применить новое значение свойства. В результате 
введенная строка текста теперь также будет отображена на заголов­
ке формы в окне конструктора.

Несмотря на то, что нами 
было установлено новое 
значение свойства Text 
формы, свойство (Name) 
по-прежнему имеет задан­
ное по умолчанию значение 
Forml, которое использу­
ется для ссылки на данную 
форму из программного 
кода Visual Basic.



Редактирование значений свойств элемента 
управления

Выберите команду меню Вид => Панель элементов (View => Toolbox) 
в строке меню или воспользуйтесь сочетанием клавиш Ctrl+Alt+X, что­
бы открыть панель элементов.

1. Нажав и удерживая кнопку мыши, перетащите элемент управления 
Label из категории Стандартные элементы управления (Common 
Controls) панели элементов в пустую форму или дважды щелкните 
мышью по значку данного элемента управления.

2. В окне конструктора форм дважды щелкните мышью по элементу 
управления Label для отображения его текущих свойств на панели 
Свойства (Properties).

3. На панели Свойства (Properties) найдите свойство Text, затем два­
жды щелкните мышью по значению в ячейке справа от названия 
свойства, чтобы выделить его. По умолчанию свойству присвоено 
значение Label 1.

5.  Введите с клавиатуры новое 
значение свойства Text, 
например Новая тексто­
вая надпись. По мере ввода 
в столбце значения будет появ­
ляться новая строка текста.

6.  Нажмите клавишу Enter или
щелкните мышью по любому участку экрана, чтобы применить но­
вое значение свойства. В результате введенная строка текста теперь 
будет отображена на форме в окне конструктора.

Каждый раз, когда вы вноси­
те определенные изменения 
с помощью Visual Studio, IDE 
работает в фоновом режиме 
для внесения изменений 
в соответствующий про­
граммный код.

Для некоторых свойств, на­
пример Icon, предусмотре­
на кнопка выбора файла (...)• 
Щелчок мышью по данной 
кнопке позволяет перейти 
к папке, хранящей локаль­
ный ресурс, который можно 
выбрать в качестве значения 
данного свойства.



Кодирование значения 
свойств
Кроме установки значений свойств вашего приложения на панели 
Свойства (Properties), вы также можете изменять некоторые свойства 
текста и цвета в программном коде таким образом, что данным свой­
ствам будут заданы начальные значения (т. е. свойства будут «инициа­
лизированы») при первичной загрузке формы.

Инструкции, инициализирующие значения свойств, должны быть по­
мещены внутрь обработчика события загрузки формы (Form Load). 
Инструкции, содержащиеся в этом участке кода, будут выполнены ком­
пьютером при наступлении события загрузки формы, аналогично тому, 
как обработчик события Click запускает выполнение содержащихся 
в нем инструкций, когда пользователь щелкает мышью по элементу 
управления Button.

Инициализация свойств элементов управления

1. Выберите команду меню Файл => Создать проект (File => New 
Project) или воспользуйтесь сочетанием клавиш Ctrl+N для созда­
ния нового приложения Windows Forms. Присвойте новому прило­
жению имя Инициализация.

2. Перенесите в форму элемент управления Labe1 из категории Стан­
дартные элементы управления (Common Controls) или дважды 
щелкните по данному элементу управления мышью, чтобы доба­
вить его на пустую форму.

3. В окне конструктора дважды щелкните по пустой области формы, 
чтобы открыть редактор кода. Последний откроется таким образом, 
что текстовый курсор будет автоматически помещен в тело обра­
ботчика события загрузки формы — и система будет готова для 
принятия программных инструкций.

4. Введите инструкцию Labell.BackColor = Color Yellow, 
чтобы сделать цвет фона элемента управления Labell желтым, за­
тем нажмите клавишу Enter.

5. Введите инструкцию Label1.Text = "Инициализированный 
текст", чтобы задать содержимое элемента управления Label, 
затем нажмите клавишу Enter.

6. Нажмите кнопку Запуск (Start) или клавишу F5, чтобы запустить 
приложение. Вы увидите, что в окне запущенного приложения
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Для установки каких-либо 
дизайнерских особенно­
стей интерфейса, напри­
мер шрифта или разметки 
формы, пользуйтесь пане­
лью Свойства (Properties).
А программным кодом поль­
зуйтесь для инициализации 
таких свойств, как текст или 
цвет.

Объект Color языка Visual 
Basic позволяет установить 
широкий спектр цветов. 
Попробуйте добавить 
инструкцию, присваиваю­
щую свойству ForeColor 
элемента управления Label 
значение Color Red.



свойства элемента управления Label1 были инициализированы 
согласно введенным значениям.

Инициализация свойств Формы

1. Нажмите кнопку Остановить отладку (Stop Debugging) для прекра­
щения работы приложения Инициализация и возвращения к ре­
дактору кода и участку программного кода с обработчиком события 
загрузки формы.

2. Добавьте инструкцию Forml.BackColor = Color.Blue, что­
бы изменить цвет фона формы на синий, а затем нажмите клавишу 
Enter. Обратите внимание, что инструкция Forml.BackColor 
подчеркнута волнистой линией.

3. Установите указатель мыши на волнистое подчеркивание, чтобы 
прочитать всплывающую подсказку.

После ввода каждой ин­
струкции вы должны нажи­
мать клавишу Enter с тем, 
чтобы на каждой строке 
присутствовала только одна 
инструкция.

4. Сообщение во всплывающей подсказке гласит, что вы не можете 
ссылаться на форму по ее имени внутри обработчика события са­
мой формы, поэтому поменяйте инструкцию следующим образом: 
Me BackColor = Color Blue и нажмите клавишу Enter — вы 
увидите, что подчеркивание исчезло.

5. Введите инструкцию Me.Text = "Инициализированный за­
головок", чтобы установить текст заголовка формы, и нажмите 
клавишу Enter.

6. Нажмите кнопку Запуск (Start) или клавишу F5, чтобы запустить 
приложение, и убедитесь, что свойства формы инициализируются 
согласно указанным значениям.

При обращении к форме 
используйте ключевое слово 
Me вместо имени формы.



2.
 У

ст
ан

ов
ка

 п
ар

ам
ет

ро
в Применение вычисленных 

значений
Панель Свойства (Properties) и инициализация значений в программ­
ном коде позволяют программисту задавать статические значения 
во время разработки программного обеспечения. Создание программ­
ного кода для вычисления новых значений свойств с использованием 
известных статических значений позволит вычислять значения свойств 
во время работы (прогона) программы.

1. Выберите команду меню Файл => Создать проект (File => New 
Project) или воспользуйтесь сочетанием клавиш Ctrl+N для созда­
ния нового приложения Windows Forms. Присвойте новому прило­
жению имя Вычисление.

2. Из панели элементов добавьте в форму шесть элементов управления 
Label и один элемент управления Button. Выровняйте их таким 
образом, чтобы расположение элементов управления примерно со­
ответствовало примеру на рисунке ниже.

3. Поочередно выбирая элементы управления, на панели Свойства 
(Properties) измените значение свойства Text формы и элементов 
управления Label и Button как показано на рисунке ниже.

Для упрощения процедуры 
выравнивания элементов 
управления на форме исполь­
зуйте направляющие линии, 
появляющиеся при переме­
щении элементов управления 
в окне конструктора.



4. Чтобы избежать путаницы, на панели Свойства (Properties) при­
свойте свойству (Name) трех элементов управления Label, нахо­
дящихся в правой части формы, значения Numl, Num2 и Sum со­
ответственно, если читать сверху вниз. Теперь новые имена могут 
быть использованы в программном коде Visual Basic для ссылки 
на эти три элемента управления.

5. Дважды щелкните мышью по элементу управления Button, что­
бы открыть редактор на участке кода обработчика события Click. 
Именно сюда вы можете добавлять инструкции для вычисления 
суммы статических значений свойств Text элементов управления
Numl и Num2.

6. Введите текст Sum.Text=Val (Numl Text) + Val (Num2 Text) 
и нажмите клавишу Enter, чтобы добавить в программу инструк­
цию, вычисляющую сумму двух чисел и записывающую результат 
в свойство Text элемента управления Sum.

7 Нажмите кнопку Запуск (Start) или клавишу F5, чтобы запустить 
приложение. Щелкните мышью по кнопке, чтобы выполнить вве­
денную вами инструкцию и отобразить на элементе управления 
Sum сумму двух чисел.

Функция Val () языка Visual 
Basic используется здесь 
для выделения числового 
значения из строки текста 
с тем, чтобы компьютер мог 
совершить арифметические 
действия. Чуть позже мы 
более детально расскажем 
об арифметических функциях.

Добавьте в форму еще одну 
кнопку, чтобы предоставить 
пользователю возможность 
сброса результата сложения. 
Для этого в обработчике 
события данной кнопки 
введите инструкцию 
Sum.Text="".
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Несмотря на то, что элемент управления Label хорошо подходит для 
отображения присвоенных ему значений свойства Text, он не позво­
ляет пользователю напрямую вводить новое значение свойства. Эле­
мент управления TextBox пригоден для обеих целей и должен быть 
использован вместо элемента Label, когда от пользователя требуется 
непосредственный ввод данных.

Замена элементов управления Label с именами Numl и Num2 из пре­
дыдущего примера на элементы TextBox позволяет пользователю ди­
намически изменять значения, необходимые для вычисления суммы 
двух чисел по нажатию кнопки.

1. Выберите команду меню Файл => Создать проект (File => New 
Project) или воспользуйтесь сочетанием клавиш Ctrl+N для созда­
ния нового приложения Windows Forms. Присвойте новому прило­
жению имя ПользовательскийВвод.

2. Из панели элементов добавьте в форму четыре элемента управления
Label, два элемента TextBox и два — Button.

3. Поочередно выбирая элементы управления, на панели Свойства 
(Properties) измените значение свойства Text формы и элементов 
управления Label и Button и выровняйте элементы управления 
их относительно друг друга, как показано на рисунке ниже.

Присваивание осмысленных 
имен элементам управления 
является хорошей прак­
тикой программирования 
и улучшает узнаваемость 
элементов управления 
в коде. Так, имя AddBtn 
делает кнопку более узна­
ваемой, нежели стандартное 
имя Buttonl.



4. Чтобы избежать путаницы, на панели Свойства (Properties) при­
свойте свойству (Name) двух элементов управления TextBox зна­
чение Numl и Num2 соответственно и свойству (Name) элементов 
управления Button — значение AddBtn и ClearBtn соответ­
ственно. Присвойте свойству (Name) элемента Label (значением 
свойства Text которого является строка Результат) значение 
Sum. Теперь новые имена могут быть использованы в программном 
коде для ссылки на вышеперечисленные элементы управления.

5. Дважды щелкните мышью по кнопке AddBtn, чтобы открыть ре­
дактор кода. В код обработчика события Click добавьте следую­
щую инструкцию:
Sum.Text=Val(Numl.Text)+Val(Num2.Text)

6. Дважды щелкните мышью по кнопке ClearBtn, чтобы открыть 
редактор кода. В код обработчика события Click добавьте следую­
щую инструкцию:
Sum Text="Результат":Numl.Text=""Num2.Text=""

7 Нажмите кнопку Запуск (Start) или клавишу F5, чтобы запустить 
приложение. Введите любые числовые значения в текстовые поля 
и нажмите кнопку Добавить, чтобы увидеть сумму двух чисел.

На одной строке может 
находиться сразу несколько 
инструкций,разделенных 
двоеточием.

8. Нажмите кнопку Сбросить, чтобы задать новые значения свойств, 
сохраняя при этом изначальное состояние приложения и его готов­
ность принимать и складывать следующую пару чисел.

При вводе кода с клавиа­
туры нет нужды обращать 
внимание на строчные 
и прописные буквы, так как 
язык Visual Basic не чувстви­
телен к регистру.
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Кроме ввода через элементы управления формы приложение также мо­
жет запросить ввод данных через диалоговое окно InputBox. Данное 
диалоговое окно очень похоже на окно сообщения MsgBox, но, в от­
личие от последнего, содержит поле ввода текста, куда пользователь 
может ввести данные, которые в последствие будут переданы прило­
жению. После этого данные, введенные пользователем, могут быть при­
своены в качестве значения какому-либо свойству в обычном порядке.

В отличие от простой инструкции, вызывающей окно MsgBox, сооб­
щающее пользователю какую-то информацию, инструкция, вызываю­
щая диалоговое окно InputBox, должна присваивать возвращаемое 
значение.

1. Выберите команду меню Файл => Создать проект (File => New 
Project) или воспользуйтесь сочетанием клавиш Ctrl+N для созда­
ния нового приложения Windows Forms. Присвойте новому прило­
жению имя ВводЧерезДиалог.

2. Из панели элементов добавьте в форму элемент Button.

3. Дважды щелкните мышью по элементу управления Button, чтобы 
открыть редактор кода. В код обработчика события Click добавьте 
следующую инструкцию:
Me Text=InputBox("Введите заголовок...")

4. Нажмите кнопку Запуск (Start) или клавишу F5, чтобы запустить 
приложение. Щелкните мышью по кнопке Buttonl, чтобы открыть 
диалоговое окно InputBox с заголовком ВводЧерезДиалог.

5. Введите любой текст по выбору в поле ввода текста, а затем нажмите 
кнопку ОК, чтобы присвоить введенное значение в качестве значе­
ния свойства Text формы, задающее текст заголовка окна.

Для обращения к текущей 
форме используйте ключе­
вое слово Me. Обращение 
к элементам управления 
происходит по имени.

Инструкция InputBox 
всегда должна содержать 
операцию =.



Заголовок окна InputBox и ответ 
по умолчанию

Обратите внимание, что по умолчанию заголовок диалогового окна 
InputBox совпадает с названием приложения, в нашем случае это 
ВводЧерезДиалог. Однако вы можете указать собственный заголовок 
для данного диалогового окна, добавив еще одну строку текста после 
строки сообщения в скобках.

Дополнительно вы также можете указать ответ по умолчанию, который 
будет автоматически появляться в поле ввода текста при вызове диало­
гового окна InputBox. Для этого необходимо добавить третью строку 
в скобки. Все строки должны быть разделены запятыми.

1. В приложении ВводЧерезДиалог дважды щелкните мышью по кноп­
ке Button, чтобы повторно открыть редактор кода и обработчик 
события Click для этой кнопки, и отредактируйте ранее добавлен­
ную инструкцию следующим образом:
Me Text=InputBox("Введите заголовок...",

"Установка_заголовка","Привет! Мне хорошо, а вам?")

2. Нажмите кнопку Запуск (Start) или клавишу F5, чтобы запустить 
приложение. Щелкните мышью по элементу управления Button, 
чтобы открыть диалоговое окно InputBox.

Обратите внимание на ис­
пользование в коде специ­
ального символа обозна­
чающего место переноса 
кода инструкции на следую­
щую строку.

3. Обратите внимание на заголовок диалогового окна InputBox, 
а затем нажмите кнопку ОК, чтобы применить ответ по умолчанию 
в качестве значения свойства Text формы и, соответственно, заго­
ловка окна приложения.

Попробуйте указать текст 
сообщения и ответ по умол­
чанию, разделив при этом 
эти строки ДВУМЯ запятыми.



Установка свойств 
диалогового окна
Вы можете установить дополнительные параметры диалогового окна 
MsgBox, добавив запятую и спецификатор в скобки инструкции, вы­
зывающей диалоговое окно. Таким способом вы можете указать, какие 
кнопки, а также какой графический значок (если он нужен) будут ото­
бражены в диалоговом окне.

Комбинации кнопок диа­
логового окна могут быть 
заданы с помощью соот­
ветствующих констант 
языка Visual Basic или их 
цифровых эквивалентов, 
приведенных в таблице. 
Например, если вам не­
обходимо вывести диало­
говое окно с тремя кноп­
ками Да, Нет и Отмена, 
используйте константу 
vbYesNoCancel или ее 
числовой эквивалент 3.

Значок диалогового окна 
может быть задан с по­
мощью соответствующих 
констант языка Visual 
Basic или их цифровых 
эквивалентов, приведен­
ных в таблице. Напри­
мер, если вам необходи­
мо вывести диалоговое 
окно со значком в виде 
вопросительного знака, 
используйте константу 
vbQuestion или ее чис­
ловой эквивалент 32.

Для того, чтобы вывести диалоговое окно MsgBox с нужной комбинаци­
ей кнопок и нужным графическим значком, в спецификаторе вы може­
те сложить константу кнопки и константу значка, используя операцию 
сложения +. Например, спецификатор диалогового окна, содержащего 
кнопки Да, Нет, Отмена и значок в виде вопросительного знака, будет

Всегда устанавливайте гра­
фический значок при вызове 
диалогового окна MsgBox: 
это поможет пользователям 
понять тип сообщения.

vbOkOnly

vbOkCancel

vbAbortRetrylgnore

vbYesNoCancel

vbYesNo

vbRetryCancel

Значение
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выглядеть следующим образом: vbYesNoCancel + vbQuestion. 
Вы также можете указать итоговую сумму числовых эквивалентов обе­
их констант. В данном случае сумма равна 35 (3 + 32).

Кнопки диалогового окна MsgBox могут возвращать в приложение 
определенное числовое значение при нажатии. Данное цифровое зна­
чение также может быть присвоено какому-либо свойству, аналогично 
значению, возвращаемому диалоговым окном InputBox из предыду­
щего примера.

1. Выберите команду меню Файл => Создать проект (File => New 
Project) или воспользуйтесь сочетанием клавиш Ctrl+N для созда­
ния нового приложения Windows Forms. Присвойте новому прило­
жению имя ДиалогМвдВох.

2. Из панели элементов добавьте в форму по одному элементу управле­
ния Button,Label и  TextBox, расположите их по своему вкусу.

3. Присвойте свойству Text элемента Label значение Значение 
кнопки: и измените имя элемента TextBox на  BtnValue.

4. Дважды щелкните мышью по элементу управления Button, что­
бы открыть редактор кода и обработчик события Click для этой 
кнопки. В обработчик события добавьте следующую инструкцию:
BtnValue Text=MsgBox("Нажмите любую кнопку" ,  
_vbYesNoCancel+vbQuestion)

5. Нажмите кнопку Запуск (Start) или клавишу F5, чтобы запустить 
приложение. Щелкните мышью по любой из кнопок и обратите вни­
мание на то, какое значение было возвращено в элемент управления
TextBox. Попробуйте изменить 

спецификацию комбинации 
кнопок диалогового окна 
MsgBox, используя констан­
ты или их числовые значе­
ния, и обратите внимание 
на то, какое значение воз­
вращает каждая из кнопок.



Заключение
• У всех объектов Visual Basic есть имена и свойства.

• Когда объект выделен в конструкторе форм, на панели Свойства 
(Properties) отображаются все его свойства.

• Значение любого свойства может быть отредактировано на панели 
Свойства (Properties), что приведет к присвоению нового значения 
данному свойству.

• Свойства, определяющие внешний вид приложения, например 
шрифт или расположение элементов управления, могут быть уста­
новлены во время разработки, вместе с контентом приложения.

• Контент, например значения свойств Text и Color, может быть 
инициализирован во время работы приложения в обработчике со­
бытия Load формы.

• К элементам управления, помещенным в форму, можно обращаться 
по именам, однако вы должны использовать ключевое слово Me для 
обращения к самой форме.

• В программном коде текущие значения свойств могут быть использо­
ваны для вычисления новых значений во время работы приложения.

• Элементы управления Label только отображают текст, но не при­
нимают пользовательский ввод.

• Элементы управления TextBox не только отображают текст, 
но и принимают вводимый пользователем текст.

• Рекомендуется давать всем элементам управления осмысленные 
имена: это значительно упрощает распознавание имен в коде.

• Язык Visual Basic нечувствителен к регистру, поэтому вам нет необ­
ходимости соблюдать осторожность при использовании строчных 
или прописных букв в программном коде.

• Диалоговое окно InputBox позволяет присвоить введенный поль­
зователем текст в качестве значения любого свойства

• В отличие от инструкции MsgBox, вызов диалогового окна InputBox 
всегда должен присваивать чему-либо возвращаемое значение.

• Для диалогового окна InputBox вы также можете указать заголо­
вок и текст ответа по умолчанию.

• Для диалогового окна MsgBox вы также можете указать комбина­
цию кнопок и графический значок.



Использование
элементов
управления

В этой главе мы покажем, 
каким образом вы можете 

использовать большое 
количество стандартных 

элементов управления для 
создания восхитительного 

пользовательского 
1 ттерфейса приложения.

• Порядок табуляции

• Элемент управления Button
• Элемент управления TextBox
• Элемент управления CoraboBox
• Элемент управления Label
• Элемент управления PictureBox
• Элемент управления ListBox
• Элемент управления CheckBox
• Элемент управления RadioButton
• Элемент управления WebBrowser
• Элемент управления Timer
• Заключение



В приложениях Windows 
термин «фокус» означает то, 
какой из элементов управ­
ления активен (находится 
в фокусе) в данный момент. 
Нажатие клавиши Enter 
эквивалентно щелчку левой 
кнопкой мыши по элементу 
управления,находящемуся 
в фокусе.

Порядок табуляции
При создании пользовательского интерфейса приложения с нескольки­
ми элементами управления задумайтесь над тем, каким образом будет 
осуществляться переход между этими элементами управления, так как 
некоторые пользователи предпочитают для этих целей использовать кла­
виатуру, а не мышь. Как правило, такие пользователи ожидают, что пе­
реход между элементами управления может быть осуществлен нажатием 
клавиши Tab. Поэтому очень важно, чтобы при нажатии клавиши Tab 
фокус перемещался в логической последовательности. Эта задача реша­
ется настройкой значений свойства Tablndex элементов управления.

1. Поместите несколько элементов управления в форму, затем щелк­
ните мышью по одному из них, который должен быть первым в по­
рядке табуляции.

2. Задайте значение свойства Tablndex данного элемента управле­
ния равным 0 с тем, чтобы этот элемент получил фокус первым.

3. Повторите это действие для остальных элементов управления, зада­
вая значения свойства Tablndex по возрастанию: 1,2,3 и так далее.

Не все элементы управления 
могут получить фокус. Так, 
в данном примере элементы 
управления Label не могут 
получить фокус, поэтому они 
будут просто пропущены 
при табуляции.
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Вы можете присвоить 
свойству Enabled значение 
False, чтобы предотвратить 
нажатие кнопки пользовате­
лем до тех пор, пока про­
грамма не разблокирует этот 
элемент управления.

Стандартный внешний 
вид окна в операционной 
системе Windows знаком 
и привычен большинству 
пользователей. Избегайте 
радикальных изменений 
оформления пользователь­
ского интерфейса.

3.  Повторите операции для других элементов управления Button, из­
меняя свойство Text каждой кнопки и устанавливая клавиатурное 
сокращение, затем нажмите сочетание клавиш Alt+П, чтобы проте­
стировать сокращение для кнопки Пуск.

2. Для создания клавиатурного сокращения добавьте символ ампер­
санд & перед текстом — значением свойства Text.

Элемент управления
Button
Элемент управления Button предоставляет пользователю простой 
инструмент для начала какой-либо операции, подтверждения или от­
мены выбора, получения справки. В языке Visual Basic для определения 
функций кнопок необходимо вводить соответствующий программный 
код в обработчик событий каждой кнопки. Для изменения внешнего 
вида кнопки необходимо настроить ее свойства, например Size, Text, 
BackColor, Font и так далее. Во время изменения значения свойства 
Text вы также можете настроить клавиатурное сокращение для дан­
ной кнопки, указав для этого знак & перед нужным символом.

1. В окне конструктора форм выделите элемент управления Button, 
затем на панели Свойства (Properties) измените размер и цвет кнопки.



Элемент управления
TextBox
Элемент управления TextBox — неотъемлемая часть большин­
ства приложений. Как правило, данный элемент управления предо­
ставляет пользователю однострочное поле для ввода текста. Гораздо 
большее количество текста может уместиться в элемент TextBox, 
если его свойству Multiline присвоено значение True, а свойству 
ScrollBars значение Vertical.

1. Поместите в форму элементы управления TextBox и Button.

2. Выделите элемент управления TextBox и воспользуйтесь панелью 
Свойства (Properties), чтобы присвоить свойству ScrollBars значение 
Vertical (тем самым активировав вертикальные полосы прокрутки).

3. Щелкните по кнопке смарт-тега со стрелочкой над полем ввода тек­
ста TextBox или воспользуйтесь панелью Свойства (Properties), 
чтобы присвоить свойству Multiline значение True (тем самым 
позволив вводить в поле текст, состоящий из нескольких строк).

Ввод пробела в элемент 
управления TextBox добав­
ляет символ пробела.

В этом примере мы исполь­
зовали символ & для конка­
тенации (объединения) кода.

4. В обработчик события Click элемента управления Button до­
бавьте следующую инструкцию:
MsgBox("Вы ввели:"&Str(Len(TextBoxl.Text))&
"_символов")

5. Запустите приложение и введите какой-нибудь текст в элемент 
управления TextBox, а затем нажмите кнопку и протестируйте ра­
боту приложения.



Элемент управления
СоmЬоВох
Элемент управления СошЬоВох может использоваться вместо TextBox, 
чтобы предоставить пользователю дополнительный выбор из стан­
дартных значений, организованных в раскрывающийся список. Поль­
зователь может выбрать одно из перечисленных значений или ввести 
его с клавиатуры напрямую, как в случае с элементом управления 
TextBox. Элемент управления СошЬоВох предоставляет понятный 
пользователю список ожидаемых вариантов ввода, но занимает на фор­
ме места не больше, чем стандартное однострочное поле для ввода тек­
ста TextBox.

1. Выделите элемент управления СошЬоВох, а затем найдите его свой­
ство Items на панели Свойства (Properties).

2. Щелкните мышью по кнопке с многоточием (...) для открытия диа­
логового окна Редактор коллекции строк (String Collection editor).

3. Введите список вариантов, которые вы хотели бы предложить поль­
зователю, а затем нажмите кнопку ОК.

Вы можете узнать, какое 
значение выбрал пользо­
ватель, проверив свойство 
Text элемента управления
СошЬоВох.
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Элемент управления
Label
Изначально элемент управления Label предназначался для подсказки 
пользователю и чаще всего используется для предоставления опреде­
ленной текстовой информации. Данный элемент управления также мо­
жет представлять собой простой прямоугольный графический элемент: 
для этого достаточно лишь не указывать значение свойства Text, изме­
нить цвет фона (свойство BackColor) и настроить значение свойства 
AutoSize.

1. Добавьте в форму три элемента управления Label.

2. По очереди выберите каждый элемент управления Label и на панели 
Свойства (Properties) присвойте свойству AutоSizе значение Fа1sе.

3. По очереди выберите каждый элемент управления Label и на пане­
ли Свойства (Properties) присвойте свойству BackColor значение 
по своему усмотрению.

С помощью свойства 
BorderStyle вы можете 
добавить обрамление эле­
менту управления Label.

Вы можете использовать 
раскрывающийся спи­
сок на панели Свойства 
(Properties) для выбора эле­
мента управления,свойства 
которого требуется отредак­
тировать.

4. По очереди выберите каждый элемент управления Label и на па­
нели Свойства (Properties) удалите значение свойства Text, чтобы 
сделать его пустым.



Элемент управления
PictureBox
Элемент управления PictureBox позволяет добавлять изображения 
в интерфейс вашего приложения. Данный элемент управления может 
быть настроен на отображение локальных файлов или изображений, 
импортированных в приложение в качестве ресурса. Добавление изо­
бражения в качестве ресурса обеспечивает портативность вашего при­
ложения при его развертке, так как оно будет содержать собственную 
копию нужного изображения.

1. Добавьте в форму элемент управления PictureBox и выделите его.

2. На панели Свойства (Proper­
ties) найдите свойство Image 
данного элемента управле­
ния — и нажмите кнопку с мно­
готочием (...), чтобы открыть 
диалоговое окно Выбор ресур­
са (Select Resource).

3. Установите переключатель в положение Файл ресурсов проекта 
(Project resource file), затем нажмите кнопку Импорт (Import), чтобы 
перейти к папке, в которой хранится нужный файл изображения.

Допустимы графические 
файлы с расширениями 
.bmp, .ico, .gif, .wmf и .jpg. Изо­
бражения других форматов 
не могут быть импортиро­
ваны без предварительной 
конвертации.

4. Щелкните мышью по кнопке ОК, чтобы импортировать файл изо­
бражения в приложение и отобразить его на элементе управления 
PictureBox.

Обратите внимание на то, 
что после импорта изобра­
жения в каталог Resources 
на панели Обозреватель 
решений (Solution Explorer) 
появляется новый файл.
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Элемент управления
ListBox
Элемент управления ListBox языка Visual Basic — один из самых по­
лезных, так как предоставляет пользователю удобный интерфейс для 
отображения доступных вариантов выбора. Данный элемент управле­
ния позволяет компактно отобразить очень большие списки, насчи­
тывающие до нескольких тысяч вариантов. Как правило, данные для 
таких списков могут быть получены из внешних ресурсов, например 
баз данных. В дальнейшем вы можете использовать эти данные с вашим 
приложением, например, для создания адресных книг, деловых орга­
найзеров, коллекций и т. д.

Несмотря на то, что панель Свойства (Properties) позволяет вруч­
ную вводить элементы списка, как и в случае с элементом управления 
ComboBox, зачастую более подходящим решением было бы динамиче­
ское добавление элементов списка во время работы приложения с по­
мощью обработчика события загрузки формы.

1. Добавьте в форму элементы управления ListBox, Label и Button.

2. Присвойте элементу управления ListBox имя BookList, также 
измените значение свойства Text элементов управления Label 
и Button, как показано на рисунке:

Вам не нужно беспокоить­
ся по поводу настройки 
вертикальных полос про­
крутки элемента управления 
ListBox: они добавляются 
автоматически.

Все элементы маленького 
списка в этом примере 
добавляются поочередно. 
Для более крупных списков 
существует менее затратный 
метод циклического повто­
рения кода, о котором вы 
можете прочесть в следую­
щей главе.

3. Дважды щелкните мышью по форме, чтобы открыть редактор кода 
и обработчик события загрузки формы Forml Load и введите сле­
дующую инструкцию:
BookList Items Add("Программирование на Python для 
начинающих")

4. Повторите вышеуказанную инструкцию на новой строке, заменяя 
название книг в скобках.



5. Для того чтобы отсортировать список в алфавитном порядке, до­
бавьте следующую инструкцию:
BookList Sorted=True

6. Для того чтобы первый элемент списка был всегда выделен по умол­
чанию, пропишите следующую программную инструкцию:
BookList Selectedlndex=О

7 Чтобы отобразить длину списка в заголовке окна формы, добавьте 
следующую инструкцию:
Me Text="Доступно книг:"&_BookList Items Count

8. Вернитесь к конструктору форм и дважды щелкните мышью 
по кнопке, чтобы открыть редактор кода и обработчик события дан­
ной кнопки. Чтобы отобразить выделенный в настоящий момент 
элемент списка, добавьте следующую инструкцию:
MsgBox(BookList Text)

9. Запустите приложение и обратите внимание, что по умолчанию вы 
делен первый элемент списка. Выделите любой другой элемент спис 
ка, а затем нажмите кнопку для подтверждения выбора. Свойство Sorted элемента 

управления ListBox также 
можно задать на панели 
Свойства (Properties).

Запомните, что номер перво­
го элемента списка 0 а не 1
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Элемент управления
CheckBox
Элемент управления CheckBox (Флажок) представляет собой неболь­
шой квадратик, сопровожденный текстовой меткой. Данный элемент 
управления позволяет пользователю сделать определенный выбор, 
обозначенный сопроводительной надписью. Для этого необходимо 
щелкнуть мышью по квадратику — ив нем появится галочка, обозна­
чающая, что выбор сделан (т. е. флажок установлен). Повторный щел­
чок по квадратику обозначает отмену выбора, соответственно, галочка 
будет скрыта (флажок сброшен).

Элемент управления CheckBox идеально подходит для визуального 
представления вариантов выбора, из которых пользователь может вы­
брать один или несколько вариантов, кроме того, пользователь может 
не выбрать ни один из предоставленных вариантов.

1. Добавьте в форму элемент управления CheckBox, а также Label, 
ListBox и Button.

2. Воспользуйтесь панелью 
Свойства (Properties) 
для изменения значения 
свойства Text элементов 
управления CheckBox, 
Label и Button, как по­
казано на рисунке. Элемен­
ту управления ListBox 
присвойте имя Pizza.

3. В обработчик события Click элемента управления Button до­
бавьте инструкцию, сбрасывающую элемент управления ListBox 
по нажатию кнопки:
Pizza Items Clear()

4. Теперь введите следующие инструкции, добавляющие к списку элемен­
ты, соответствующие каждому установленному флажку CheckBox:
IfCheckBoxl Checked=True Then

Pizza.Items Add(CheckBoxl Text)
End If

IfCheckBox2 Checked=True Then
Pizza Items Add(CheckBox2 Text)

End If

Более подробно условная 
инструкция If— Then, 
использованная нами в этом 
примере, будет объяснена 
позже. Сейчас запомните 
лишь, что свойству Checked 
присваивается значение 
True при установке флажка.



При создании групп пере­
ключателей всегда устанав­
ливайте один из переклю­
чателей по умолчанию. Для 
этого на панели Свойства 
(Properties) необходи­

мо свойству Checked этого 
переключателя присвоить 
значение True.

Элемент управления
RadioButton
Элемент управления RadioButton (Переключатель) очень похож 
на элемент управления CheckBox, но с одним значительным отличием: 
пользователь может выбрать только один вариант из предоставленного 
списка. Установка переключателя RadioButton в одно из положений 
автоматически сбрасывает все прочие его положения.

Элемент управления RadioButton идеально подходит для визуаль­
ного представления списка вариантов, из которого пользователь может 
выбрать только один.

1. Добавьте в форму два элемента управления RadioButton, а затем 
отредактируйте их значение свойства Text, как показано на рисун­
ке ниже.

2. В обработчик события Click  элемента управления Button сразу 
после инструкции сброса вставьте следующие строки:
If RadioButtonl Checked=True Then

Pizza Items Add(RadioButtonl Text)
End If

If RadioButtonl2 Checked=True Then 
Pizza.Items Add(RadioButton2.Text)

End If

3. Запустите приложение, установите флажки и переключатель в одно 
из положений, а затем нажмите кнопку, чтобы вывести результаты 
выбора. Добавьте в форму кнопку 

Сброс, при нажатии которой 
очищалось бы окно списка 
ListBox, а также сбрасыва­
лись бы все флажки и пере­
ключатели.
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Элемент управления
WebBrowser
Элемент управления WebBrowser языка Visual Basic предоставляет 
инструмент для простого и быстрого просмотра HTML-документов 
в приложении, причем эти документы могут как храниться на вашем 
компьютере, так и загружаться из Всемирной паутины. Данный эле­
мент управления также может отображать простой текст и графиче­
ские изображения, совсем как Internet Explorer.

1. Добавьте элемент управления WebBrowser в форму — и он авто­
матически займет все рабочее пространство формы.

2. Щелкните по кнопке смарт-тега с изображением треугольника и вы­
берите пункт Открепить в родительском контейнере (Undock in 
Parent Container).

3. Добавьте в форму элементы управления TextBox и Button, а за­
тем расположите их как показано на рисунке:

Для изменения размеров 
элементов управления 
на форме воспользуйтесь 
маркерами, расположенны­
ми по их периметру.



Нажатие клавиши Enter 
не приведет к активации 
события Click элемента 
управления Button, разу­
меется, если вы не настрои­
ли соответствующее клавиа 
турное сокращение.

Вы можете загрузить проек­
ты для этой книги по ссыл­
ке: https://eksmo.ru/files/ 
VB_Primers.rar,

6. Теперь в поле TextBox введите адрес локального файла и нажмите 
кнопку Просмотр, чтобы просмотреть этот файл в элементе управ­
ления WebBrowser

4. Дважды щелкните мышью по элементу управления Button, чтобы 
открыть редактор кода. В обработчике события кнопки введите сле­
дующую инструкцию:
WebBrowserl Navigate(TextBoxl Text)

5. Запустите приложение и введите в поле TextBox действитель­
ный URL-адрес, а затем щелкните мышью по элементу управления 
Button, чтобы открыть запрашиваемую веб-страницу.

https://eksmo.ru/files/
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Настройте свойство автома­
тического подбора размера 
(AutoSize) элемента управ­
ления PictureBox, исполь­
зуя смарт-теги или панель 
Свойства (Properties).

Элемент управления
Timer
Timer — это невидимый элемент управления. На панели элементов 
среды Visual Studio данный элемент управления находится в категории 
Компоненты (Components). Его добавление в приложение позволяет 
повторно запускать определенное событие в установленный вами ин­
тервал времени. Инструкции, находящиеся внутри обработчика со­
бытия элемента управления Timer выполняются каждый раз, когда 
в приложении происходит событие Timer.

1. Добавьте в форму два элемента управления PictureBox и один 
Button.

2. Назначьте элементам управления PictureBox два похожих рисунка 
одинакового размера, затем, нажав и удерживая клавишу Shift, щелк­
ните мышью по обоим элементам управления, чтобы выделить их.

3. Выберите команду меню Формат => Выровнять => Центры 
(Format => Align => Centers), чтобы точно наложить два элемента 
управления PictureBox один на другой.

4. Выберите команду Формат =>  Порядок => На передний план
(Format => Order => Bring to Top) или На задний план (Send to Back), 
чтобы убедиться в том, что элемент PictureBoxl находится поверх 
(на переднем плане) элемента PictureBox2. Щелкните по верхнему 
элементу и проверьте его имя на панели Свойства (Properties).

5. Добавьте элемент управления Timer из категории Компоненты 
(Components) панели элементов. Значок данного элемента управле­
ния появится в нижней части окна конструктора форм.

6. Дважды щелкните мышью по значку элемента управления Timer, 
чтобы открыть редактор кода и обработчик события данного эле­
мента управления, а затем введите следующие инструкции:



If PictureBoxl Visible=True Then 
PictureBoxl Visible=False 

Else
PictureBoxl.Visible=True 

End If

Данный фрагмент кода проверяет свойство Visible верхнего эле­
мента управления PictureBox и включает либо выключает види­
мость элемента управления подобно мигающему фонарику.

7 Дважды щелкните мышью по элементу управления Button, что­
бы открыть редактор кода и обработчик события данного элемента 
управления, а затем введите следующие инструкции:
If Timerl.Enabled=False Then 

Timer1.Enabled=True 
Else

Timerl.Enabled=False 
End If

Данный фрагмент кода проверяет свойство Enabled элемента 
управления Timer и включает либо выключает его при щелчке мы­
шью по элементу Button.

8. Запустите приложение, затем нажмите кнопку и пронаблюдайте 
за тем, как элемент управления Timer управляет анимацией с по­
мощью элементов PictureBox.

Для изменения скорости 
анимации вы можете на­
строить значение свойства 
Interval элемента Timer.

В данной главе мы про­
демонстрировали лишь 
несколько наиболее по­
пулярных элементов управ­
ления из всего многообра­
зия, доступного на панели 
элементов. Поэксперимен­
тируйте с каждым из пред­
ставленных в ЮЕ элементов 
управления,чтобы понять 
принципы их работы.



Заключение
• Свойство Tablndex определяет, каким образом пользователь смо­

жет переключаться между элементами управления, используя кла­
вишу Tab.

• Кнопкам можно присвоить клавиатурные сокращения, для этого 
необходимо вставить символ & перед нужным символом значения 
свойства Text.

• Элемент управления TextBox запросто может отображать сразу 
несколько строк текста, если свойству Multiline присвоено зна­
чение True, a ScrollBars — значение Vertical.

• Элемент управления ComboBox позволяет вводить текст с клавиа­
туры, аналогично элементу TextBox, но также предоставляет спи­
сок ожидаемых вариантов вводимых данных, которые пользователь 
может выбрать щелчком мыши.

• Элемент управления Label содержит текстовую информацию, од­
нако не получает фокус и не позволяет вводить данные напрямую. 
Однако данные элементы управления могут быть использованы для 
создания простых прямоугольников.

• Импорт изображений как ресурсов позволяет быть уверенным 
в том, что приложение будет переносимым при развертке.

• Элемент управления ListBox используется для компактного ото­
бражения большого количества строк данных, источник которых мо­
жет находиться как внутри программы, так и может быть внешним.

• Элемент управления CheckBox позволяет пользователю выбрать 
один, несколько или ни один из предоставленных вариантов, тогда 
как элемент RadioButton позволяет пользователю выбрать толь­
ко один вариант из группы.

• Элемент управления WebBrowser может отображать документы 
HTML, а также простой текст и изображения, аналогично веб-браузеру.

• Вы можете использовать элемент управления Timer для создания 
события приложения, происходящего через определенный проме­
жуток времени.

• Переключение — полезная техника программирования на языке 
Visual Basic, используемая для выбора значения свойства.



Изучение языка

В этой главе мы 
продемонапр! шуем 

вам механику 
программирования 

на языке Visual Basic, 
позволяющую сохранять. 
контролировать данные 

и производить с ними 
различные манипуляции, 

используя приложение.

• Элементы программы

• Объявление типов переменных

• Понимание области действия переменной

• Работа с массивами переменных

• Арифметические и логические операции

• Ветвление кода

• Циклическое повторение кода

• Вызов методов объектов

• Создание подпрограммы

• Передача параметров

• Создание функции

• Математические вычисления

• Генерация случайных чисел

• Заключение



Примеры из этой главы 
демонстрируют различные 
элементы программы. При 
необходимости уточнения 
всегда возвращайтесь к это­
му разделу.

Интегрированная среда 
разработки Visual Studio — 
это безопасная среда для 
экспериментов и обучения 
на собственных ошибках.

Элементы программы
Программа — это всего-навсего набор инструкций, сообщающих 
компьютеру, какие действия необходимо выполнить. Несмотря на то, 
что программы могут быть сложными, каждая отдельная инструкция 
проста. Компьютер начинает выполнение программы с самого начала, 
проходит по программному коду строка за строкой до тех пор, пока 
не достигает конца программы. Далее перечислены несколько основ­
ных элементов программ на языке Visual Basic.

Инструкции

Инструкция — это команда, производящая какое-либо действие. На­
пример, инструкция Lbl.BackColor=Color.Blue изменяет цвет 
фона объекта Lbl на Blue.

Функции

Функция — это инструкция, возвращающая значение. Например, 
функция InputBox() возвращает значение, введенное в текстовое 
поле соответствующего диалогового окна.

Переменные

Переменная — это слово, определенное в программе и хранящее значе­
ния. Например, инструкция msg="Здравствуй, мир! " сохраняет 
строку символов в переменной msg.

Операции

Операция — это арифметический символ. Например, символ «звездоч­
ка» * — это операция умножения, а слеш / — операция деления.

Объекты

Объект — это «строительный блок» программы. Объект может быть 
видимым, как элемент управления Button, или скрытым — как эле­
мент управления Timer.
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Свойства

Свойство — это характеристика объекта. Например, Btn.Text — это 
свойство Text объекта Btn.

Методы

Метод это действие, которое может совершать объект. Например, 
Btn.ClickO —это метод Click () объекта Btn.

Комментарии

Комментарий это пояснительная строка программного кода, начи­
нающаяся с апострофа: ' Такая строка не считывается компилятором: 
она существует только для того, чтобы объяснить предназначение того 
или иного фрагмента кода. Например, комментарий 'Очистить спи­
сок мог бы быть использован для пояснения инструкции Clear.

На рисунке ниже показан пример программного кода на языке Visual 
Basic, открытый в редакторе кода. Программный код соответствует об­
работчику события Click элемента управления Button. Мы включи­
ли нумерацию строк для облегчения анализа кода.



4.
 И

зу
че

ни
е 

яз
ык

а

Для того чтобы ВКЛЮЧИТЬ 

нумерацию строк, выберите 
команду меню Сервис => Па­
раметры (Tools =*> Options), 
в появившемся диалоговом 
окне откройте категорию 
Текстовый редактор => 
Basic (Text Editor Basic) 
и установите флажок Номе­
ра строк (Line Numbers).

Вы можете изменить цвет 
подсветки элементов 
синтаксиса, выбрав коман­
ду меню Сервис => Пара­
метры (Tools => Options).
В появившемся диалоговом 
окне выберите категорию 
Среда => Шрифты и цвета 
(Environment => Fonts and 
Colours).

Построчный анализ кода

• Строки 1 и 17 — начало и конец кода формы

• Строки 3 и 15 начало и конец кода обработчика события элемента 
управления Button

• Строки 6, 9 и 12 комментарии

• Строка 7 создание переменной с именем msg для хранения дан­
ных типа String

• Строка 10 запись значения-строки текста в переменную msg

• Строка 13 вызов функции MsgBox () для отображения значения 
переменной msg

Выделение синтаксиса

• Ключевые слова основные слова языка Visual Basic выделяются 
голубым цветом

• Строки — текстовые значения, заключенные в двойные кавычки, 
выделяются красным

• Комментарии пояснительные строки подсвечены зеленым цветом

• Код — для всего остального используется черный цвет



Всегда присваивайте пере­
менным что-либо значащие 
имена, это поможет вам 
распознавать переменные 
в дальнейшем.

Объявление типов 
переменных
В программе переменная выполняет функцию своеобразного контей­
нера, в котором можно хранить значения. Переменной этот контейнер 
назван потому, что его содержимое может изменяться по ходу выпол­
нения программы.

Создать переменную можно, объявив ее с помощью ключевого слова 
Dim языка Visual Basic, после которого следует указать уникальное имя 
переменной по вкусу. Например, строка Dimmsg объявляет новую пе­
ременную с именем msg.

Объявление переменной также должно содержать спецификацию типа 
данных, которые могут быть сохранены в данной переменной. Для это­
го используется ключевое слово As, после которого указывают один 
из типов данных языка Visual Basic. Таким образом, объявление Dim 
msg As String создает новую переменную с именем msg, в которой 
могут быть сохранены строки символов.

В языке Visual Basic реализовано большое количество типов данных, 
в таблице ниже приведены лишь наиболее часто используемые.

После создания переменная может хранить только данные указанно­
го при объявлении типа. Например, переменной типа String нельзя 
присвоить значение типа Integer

Данные подходящего типа могут быть присвоены переменной в лю­
бом фрагменте кода программы. Объявление переменной также может 
выполнять и ее инициализацию. Например, инструкция Dim msg As 
String = "Здравствуй" инициализирует переменную типа String 
с именем msg и имеющую значение Здравствуй.

Любые данные, заключен­
ные в двойные кавычки, 
являются строкой (счита­
ются типом String), таким 
образом, "123" — это 
строка типа String, содер­
жимое элемента управления 
TextBox — это тоже строка.

Boolean

String

Integer

Double

True (Истина) или False (Ложь)

Символы 

Целое число

Десятичная дробь (число с плавающей точкой)
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• Оно позволяет вам выполнять задачи, специфичные для каждого 
типа данных: манипуляция с символами для типа String, вали­
дация для Boolean, а также арифметические операции для типов
Integer и Double

• Позволяет системе IntelliSense отображать дополнительные функ­
ции при вводе команд с клавиатуры

• Позволяет компилятору выполнять проверку соответствия типов 
для предотвращения возникновения ошибок

• Программный код выполняется быстрее

Вы запросто можете вывести на экран значение, сохраненное в пере­
менной, для этого переменную необходимо присвоить любому тексто­
вому значению визуального элемента управления, например ListBox.

1. Добавьте в форму элементы управления ListBox и Button.

2. Дважды щелкните мышью по элементу управления Button, чтобы 
открыть редактор кода и обработчик события кнопки.

3. Введите следующие строки кода, объявляющие и инициализирую­
щие переменные:
Dim bool as Boolean = False
Dim str As String = "Какой-то текст"
Dim int As Integer = 1000 
Dim num As Double = 75

4. Теперь введите следующие строки для отображения значений пе­
ременных:
ListBoxl.Items.Add("значение bool: "&bool)
ListBoxl.Items.Add("значение str: "&str)
ListBoxl.Items.Add("значение int: "&int)
ListBoxl.Items.Add("значение num: "&num)

5. Запустите приложение, щелкните мышью по элементу управления 
Button и проверьте данные, сохраненные в переменных.

Visual Basic реализованы 
две полезные функции: 
Str (), конвертирующая 
числа в строки, и Val (), 
преобразующая строки 
в числа. Функция Str () 
была использована в при­
мере в главе 3, а функция 
Val () —в главе 2.



Обратите внимание, что пер­
вая строка кода обработчика 
события начинается со слов 
Private Sub, которые 
идентифицируют фрагмент 
кода как подпрограмму Sub.

В проектах Visual Studio есть 
настройка под названием 
Option Explicit, которая 
отслеживает правильность 
объявления переменных, 
как показано в тексте. Всегда 
оставляйте эту настройку 
включенной (она включена 
по умолчанию), и вы будете 
вынуждены объявлять пере­
менные корректно.

Понимание области 
действия переменной
Доступность переменной определяется ее «областью действия» и зависит 
от того, в каком участке программного кода данная переменная была объ­
явлена. Область действия переменной определяет, какие части программы 
могут проверять или изменять значение, сохраненное в переменной.

Переменные, объявленные внутри подпрограммы Sub, это может 
быть, например, обработчик события, доступны только в рамках этой 
подпрограммы. Обращение к этим переменным извне данной подпро­
граммы вызовет ошибку, так как такие переменные не видны из других 
подпрограмм. Таким образом, говорят, что переменная, объявленная 
внутри подпрограммы, имеет «локальную» область действия и доступ­
на только внутри данной подпрограммы.

Как правило, локальные переменные объявляются с ключевым словом 
Dim, именем и спецификатором типа данных. Имя переменной дол­
жно быть уникальным в рамках области действия и может повторно 
использоваться для другой локальной переменной с другой областью 
действия. Например, в подпрограммах двух обработчиков событий 
могут быть объявлены переменные с именем msg. При этом никакого 
конфликта не возникнет, так как обе переменные друг другу не видны.

1. Добавьте в форму три элемента управления Button.

2. Дважды щелкните мышью по кнопке Buttonl и вставьте следую­
щий код в обработчик события:
Dim msg As String = "Привет из Sub Buttonl"
MsgBox(msg)

3. Теперь дважды щелкните по кнопке Button2 и вставьте следующий 
код в обработчик события, обратите внимание, что в данном участ­
ке кода также объявляется переменная с именем msg:
Dim msg As String="Привет из Sub Button2"
MsgBox(msg)

4. Запустите приложение и нажмите по очереди на каждую из кнопок, 
дабы удостовериться в том, что значение обеих переменных msg об­
рабатывается без возникновения конфликта.
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Зачастую вам может потребоваться, чтобы переменные были доступны 
сразу из нескольких подпрограмм, для этого объявление таких пере­
менных должно находиться вне подпрограммы, в разделе объявлений 
формы, сразу же после строки объявления класса формы в начале про­
граммного кода. В этом участке кода переменные могут быть объявле­
ны как с ключевым словом Dim, так и Private, при этом они будут 
доступны по всей области действия формы, то есть любая подпрограм­
ма может обращаться к этим переменным.

Раздел объявления формы также может содержать переменные, объ­
явленные с ключевым словом Public. Такие переменные доступны 
по всему проекту, в том числе и из других форм. Такие переменные на­
зывают «глобальными», так как они доступны отовсюду.

5. В редакторе кода введите следующие строки кода в раздел объявле­
ния формы:
Public globalVar As String = "Привет из Проекта"
Private formVar As String = "Привет из этого Модуля"

6. В обработчик события кнопки Button3 вставьте следующую строку:
MsgBox (globalVar & vbCrLf & formVar)

7 Запустите приложение и щелкните мышью по элементу управления 
Button3, чтобы получить значения переменных с областью дей­
ствия проект и модуль.

Раздумывая над тем, где луч­
ше объявить переменную, 
старайтесь сделать ее как 
можно более локальной: это 
позволит избежать оши­
бок. Таким образом, вашим 
первым выбором должно 
быть объявление локальной 
переменной с ключевым 
словом Dim, затем — объяв­
ление Private на уровне 
модуля и,наконец, — объяв­
ление глобальной перемен­
ной Public.

Внутри области действия 
имена переменных должны 
быть уникальными.

Привет из Проекта 
Привет из этого Модуля



Работа с массивами 
переменных
Все переменные, с которыми мы уже познакомились к настоящему момен­
ту, позволяют сохранить только одно значение, но иногда гораздо удоб­
нее сохранять целый набор значений. Например, если вы хотите создать 
приложение, которое сохраняло бы данные об уровне продаж по месяцам 
для квартального отчета, то вместо создания трех отдельных переменных, 
скажем, JanSales, FebSales и MarSales, вы можете создать един­
ственный массив переменных с именем Sales и содержащий три элемен­
та, по одному на каждый месяц. К этим элементам вы сможете обращаться 
как Sales (0), Sales (1) и Sales (2) соответственно.

1. В форму добавьте элемент управления Button, а затем в обработчике со­
бытий данного элемента управления создайте массив из трех элементов:
Dim Sales (2) As Double

2. Поочередно присвойте значения каждому из элементов массива:
Sales (0) = 5245 00 
Sales(1) =4785.00 
Sales(2) = 7365 50

3. Создайте обычную переменную, а затем присвойте ей сумму значе­
ний элементов массива:
Dim Quarter as Double
Quarter = Sales (0) + Sales (1) + Sales (2)

4. Наконец, добавьте инструкцию для отображения суммы в формате, 
соответствующем региональным настройкам компьютера:
MsgBox ("Квартальные продажи: "&
FormatCurrency(Quarter) )

5. Запустите приложение и проверь­
те полученный результат. На ри­
сунке объем продаж написан 
в российских рублях, но формат 
отображения денежных значе­
ний зависит от региональных 
настроек компьютера, на котором 
запущенно данное приложение.

При желании вы могли бы инициализировать элементы массива в мо­
мент объявления, при этом необходимость в явном указании коли­
чества элементов отсутствует. Все значения должны быть заключены 
в фигурные скобки и отделены друг от друга запятыми. Для данного 
примера такое объявление массива выглядело бы следующим образом: 

DimSales() = {5245 0, 4785 0 7365 5}

Нумерация массивов 
по умолчанию начинается 
с нуля, поэтому индекс по­
следнего из трех элементов 
массивов не 3, а 2.

Не пытайтесь обратиться 
к несуществующему эле­
менту массива. В данном 
примере обращение к эле­
менту массива Sales (3) 
вызвало бы ошибку Out of 
Range.

Квартальные продажи: 17 395,50 Р



Многомерные массивы

Массивы могут иметь несколько измерений. Например, для хране­
ния квартальных уровней продаж двух магазинов, вы могли бы со­
здать двумерный массив, объявив его как Sales (2, 1) As Double. 
В последующем к отдельным элементам массива можно обратиться 
следующим образом: Sales (0, 0), Sales (1, 0), Sales (2, 0), 
Sales (0, 1), Sales (1, 1) и Sales (2, 1)

1. В форму добавьте элемент управления Button, а затем в обработ­
чике событий данного элемента управления создайте массив 3x2:
Dim Sales (1,2) As Double

2. По очереди присвойте значения каждому из элементов массива:
Sales (0,0) =1255: Sales(l,0) =1845.5: Sales(2,0) =1065 
Sales (0,1) =2175: Sales (1,1) =2215.5: Sales(2,l) =2453

3. Создайте две обычные переменные. Одной присвойте общую сумму 
значений элементов первого измерения, а другой — общую сумму 
значений элементов второго измерения:
DimStorel, Store2 As Double
Storel=Sales(0,0) +Sales(0,l) +Sales (0,2)
Store2=Sales(1,1) +Sales(l,l) +Sales (1,2)

4. Наконец, добавьте инструкцию для отображения суммы в формате, 
соответствующем региональным настройкам компьютера:
MsgBox ("Квартальные продажи... " & vbCrLf & _

"Магазин1: "&FormatCurrency(Storel) &vbCrLf&_ 
"Магазин2: " & FormatCurrency(Store2))

5. Запустите приложение и про­
верьте полученный результат. 
На рисунке объем продаж 
написан в российских рублях, 
но формат отображения денеж­
ных значений зависит от регио­
нальных настроек компьютера, 
на котором запущенно данное 
приложение.

Квартальные продажи.. 
Магазин! 4 165,50Р 
Магазин2: б 843,50 Р

Визуально двумерные мас­
сивы представляют собой 
квадрат, трехмерные масси­
вы — куб. Массивов, имею­
щих более трех измерений, 
следует избегать, так как они 
достаточно сложны для визу­
ального представления.

Обратите внимание на ис­
пользование символа 
подчеркивания и константы 
vbCrLf для форматирова­
ния сообщения MsgBox.



Арифметические 
и логические операции
В таблице ниже приведены арифметические операции Visual Basic, ко­
торые используются для возврата результата вычислений.

В инструкциях с двумя и более арифметическими операциями очень 
важно указывать последовательность их выполнения, чтобы повысить 
удобочитаемость кода. Например, инструкция 6 * 3 + 5 могла бы вер­
нуть 48 (6*8)  или 23 (18 + 5), в зависимости от того, какая операция 
будет выполнена первой. Заключив часть инструкции, выполняемой пер­
вой, в круглые скобки, вы повысите удобочитаемость кода. Таким обра­
зом, инструкция ( 6 * 3 )  + 5  гарантированно вернет  23 (18 + 5).

Для проверки инструкции на истинность или ложность (возврат True 
или False  соответственно) в Visual Basic используются операции срав­
нения, приведенные в таблице ниже.

В языке Visual Basic символ = 
используется и для присвое­
ния значений, и для про­
верки равенства. В других 
языках программирования 
для проверки равенства 
используется специальная 
операция ==.
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Арифметические операции в Visual Basic могут использоваться для со­
здания простого калькулятора или вычислений в ваших программах.

1. Добавьте в форму два элемента управления TextBox, четыре эле­
мента управления Button, три элемента управления Label и рас­
положите их так, как показано на рисунке.

2. Дважды щелкните мышью по кнопке Сложить, чтобы открыть ре­
дактор кода и обработчик событий данного элемента управления. 
В обработчик событий введите следующий программный код:
Label3 Text="Решение: " &_
Str(Val(TextBoxl Text)+Val(TextBox2 Text))

3. Повторите шаг 2 для остальных элементов управления Button, за­
менив символ + на соответствующую арифметическую операцию: — 
для вычитания, / для деления и * для умножения.

4. Запустите приложение, введите два числа в соответствующие поля 
TextBox и нажмите поочередно на все кнопки.

В Visual Basic есть и другие 
операции, например &, ис­
пользующаяся для конкате­
нации (объединения)кода 
и позволяющая пере­
носить код на следующую 
строку.



Инструкция I f всегда дол­
жна заканчиваться ключевы­
ми словами End If.

Инструкция If уже исполь­
зовалась нами в главе 3, что­
бы переключать значения 
свойств и без необязатель­
ной части Else (Иначе) для 
проверки статуса элементов 
управления CheckBox 
и RadioButton.

Ветвление кода
Создание инструкций, проверяющих то или иное выражение, позволят 
выполнять то или иное действие, в зависимости от результатов про­
верки. Эта важная методика называется «условное ветвление». Выпол­
нение кода пойдет по одной или другой ветви, в зависимости от того, 
истинно (True) или ложно (False) проверяемое условие. В языке 
Visual Basic условное ветвление кода можно осуществить с помощью 
инструкции If (если), имеющего следующую структуру (синтаксис):

If (тестовое-выражение-возвращает-Тгuе) Then 
выполнить-эту-инструкцию

Else
вылолнить-эту-альтернативную-инструкцию

End If

Дополнительно данный код позволяет проверить сразу несколько вы­
ражений, подключаемых с помощью ключевых слов-союзов And (И), 
в этом случае оба выражения должны быть истинны (True) и Or 
(Или), в случае использования которого хотя бы одно выражение дол­
жно быть истинным (True).

1. Добавьте в форму элемент управления Label.

2. Дважды щелкните мышью по форме, чтобы открыть код обработчи­
ка события загрузки формы (Form_Load).

3. Введите следующую инструкцию If, чтобы присвоить элемен­
ту управления Label соответствующее значение, в зависимости 
от того, истинно ли хотя бы одно из двух проверяемых выражений:
If (WeekDay (Now) =vbSaturday) Or_
(WeekDay (Now) =vbSunday) Then

Labell Text="Расслабьтесь: сегодня выходной"
Else

Labell Text = "Соберитесь:сегодня рабочий день"

4. Запустите приложение. Сообщение будет варьироваться в зависи­
мости от того, рабочий сегодня день или выходной.

Соберитесь: сегодня рабочий день



Вы также можете ис­
пользовать инструкцию 
SelectCase для ветвления 
кода в соответствии со зна­
чением, возвращенным 
диалоговым окном MsgBox 
с кнопками Да (Yes), Нет (No) 
и Отмена (Cancel) (см. главу 2).

Условное ветвление также может осуществляться с помощью инструк­
ции Select Case, предоставляющей реализовать возможность выбо­
ра одного из множества вариантов:

Select Case выражение-для-проверки 
Case Is тест-вернул-Тгue

выполнить-зту-инструкцию-и-выйти 
Case Is тест-вернул-True

выполнить-эту-инструкцию-и-выйти 
Case Else

выполнить-инструкцию-по-умолчанию
End Select

Вы можете добавлять столько тестов Case, сколько пожелаете, вы 
также можете использовать Case Else для предоставления послед­
ней инструкции, выполняемого по умолчанию, если ни один из тестов 
не вернул значение True.

1. Добавьте в форму элемент управления Label.

2. Дважды щелкните мышью по форме, чтобы открыть код обработчи­
ка события загрузки формы (Form_Load).

3. Введите следующую инструкцию Select Case, чтобы присвоить 
элементу управления Label соответствующее значение, в зависи­
мости от того, какое из проверенных инструкций Case вернет ре­
зультат True:
Select Case WeekDay (Now)
Case Is =vbSaturday

Labell .Text = "Сегодня суперсуббота"
Case Is = vbSunday

Labell Text = "Сегодня ленивое воскресенье"
Case Else

Labell Text = "Сегодня еще один рабочий день"
End Select

4. Запустите приложение, чтобы увидеть соответствующее сообщение.

Инструкция If всегда 
должна заканчиваться 
ключевыми словами End 
I f, а инструкция Select 
Case — ключевыми слова­
ми  End Select.

Сегодня еще один рабочий день
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Циклическое 
повторение кода
В программировании циклы позволяют повторно выполнять содержа­
щиеся в них инструкции до тех пор, пока цикл не подойдет к концу. 
Среди них всегда должно быть одно тестовое выражение, чтобы прове­
рить, не пришло ли время завершить выполнение цикла, в противном 
случае цикл будет повторяться бесконечное количество раз. Самый по­
пулярный цикл среди пользователей языка Visual Basic — For Next. 
В данном цикле используется счетчик, проверяющий, сколько раз уже 
был выполнен цикл (сколько итераций цикла было выполнено). Ниже 
приведен синтаксис данного цикла:

For счетчик = начало То конец 
выполнять-эту-инструкцию 

Next обновить-счетчик

Часто оказывается весьма полезным использовать увеличивающееся 
значение счетчика в инструкциях, выполняемых при каждой итерации 
(проходе) цикла.

1. Добавьте в форму следующие элементы управления: TextBox, 
Button и ListBox.

2. Дважды щелкните мышью по элементу управления Button, чтобы 
открыть редактор кода и обработчик события Click данного эле­
мента управления, и введите следующий цикл For Next:
Dim amount As Double = Val (TextBoxl. Text)
Dim counter As Integer 
For counter = 1 To 10

ListBoxl.Items Add("Значение " & counter &_
"% равно " & _

FormatCurrency((amount * counter) / 100))
Next counter

3. Запустите приложение, введите число в поле ввода текста TextBox, 
затем нажмите кнопку Button, чтобы запустить выполнение цикла.

Переменная-счетчик хра­
нит индекс цикла, поэто­
му не присваивайте этой 
переменной никакое другое 
значение.
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В Visual Basic также можно создать и другие циклы, например Do Until 
и Do While. Несмотря на внешнюю похожесть, у этих циклов все же 
есть незначительное отличие. Цикл Do Until выполняется до тех пор, 
пока тестовое выражение не вернет значение True, тогда как цикл Do 
While будет выполняться, пока тестовое выражение не станет False.

Все циклы очень хорошо подходят для прохода по спискам данных 
и особенно полезны для прохода по значениям, содержащимся в эле­
ментах массивов.

1. Добавьте в форму элемент управления ListBox.

2. Дважды щелкните мышью по форме, чтобы открыть редактор кода 
и обработчик события загрузки формы (Form_Load), а затем со­
здайте следующий массив:
Dim Sales()As Double={5601, 8502, 6703, 4204, _7605, 
8206, 9107, 6508, 7209, 5010, 8011, 7012}

3. С помощью инструкции Dim sum As String создайте символьную 
переменную типа String.

4. Теперь введите следующий цикл Do Until и запустите приложение:
Do Until counter = Sales length

sum = FormatCurrency(Sales(counter))
counter = counter + 1
sum = sum & vbTab & MonthName (counter)
ListBoxl Items.Add(sum)

Loop

Выбирайте тот цикл Do, кото 
рый лучше отвечает вашим 
целям, однако не забывайте, 
что такой цикл должен со­
держать отдельную инструк­
цию, изменяющую значение 
счетчика, а также должен 
заканчиваться ключевым 
словом Loop.

Лимит данного цикла 
устанавливается значением 
свойства Length массива. 
Счетчик обращается к каж­
дому элементу (0-11) масси­
ва Sales, а также к каждому 
названию месяцев (1-12) 
из функции MonthName 
языка Visual Basic.



Вызов методов объектов
У всех объектов языка Visual Basic есть методы, которые могут быть 
вызваны из программного кода. Методы позволяют объекту совершать 
какие-либо действия во время работы программы. Это работает при­
мерно аналогично создаваемому вами программному коду, присваи­
вающему новые значения свойствам объекта и тем самым изменяюще­
му его характеристики.

Для просмотра всех свойств и методов, доступных для объекта, в ре­
дакторе кода введите название интересующего вас объекта и поставьте 
точку. Всплывающее окно-подсказка IntelliSense будет содержать все 
свойства и методы данного объекта. Пролистайте список и дважды 
щелкните мышью по любому элементу списка, чтобы добавить нужное 
свойство или метод в программный код.

1. В форму добавьте два элемента управления Label и пять элементов 
управления Button.

2. На панели Свойства (Properties) присвойте свойству AutoSize 
каждого элемента управления Label значение False и удалите 
присвоенное по умолчанию значение свойства Text.

3. Сделайте фон одного из элементов управления Label красным (из­
менив соответствующим образом значение свойства BackColor) 
и переименуйте данный элемент управления в RedLbl, фон второ­
го элемента управления Label сделайте желтым.

4. Настройте свойство Text 
каждого элемента управления 
Button, а затем расположите 
все элементы управления как 
показано на рисунке.

5. Дважды щелкните мышью по кнопке Расположить, чтобы открыть 
редактор кода и обработчик события, после чего введите текст RedLbl.

Присвоив свойству 
AutoSize значение True 
(используемое по умолча­
нию), вы предотвратите из­
менение размеров элемен­
тов управления Label.
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а затем дважды щелкните по нему мышью, чтобы добавить данный 
метод в программный код.

7 Метод SetBounds используется для установки размера и положе­
ния элемента управления через установку координат по осям X и Y, 
а также ширины и высоты. Сразу после имени метода введите сле­
дующие настройки:
(45, 45, 45, 100)

8. Повторите действие для остальных элементов управления Button, 
добавляя в программный код вызов методов Hide(), Show(), 
BringToFront () и SendToBack () соответственно названию кнопок.

9. Запустите приложе­
ние и понажимайте 
на каждую из кнопок, 
чтобы увидеть работу 
методов в действии. 
Пронаблюдайте, каким 
образом изменяется 
порядок наложения 
элементов управления 
Label.

Использование блока With

Создание кода, обращающегося к нескольким свойствам или методам 
одного и того же объекта может быть утомительным из-за необходимо­
сти вновь и вновь вводить имя объекта.

BlueLbl.AutoSize = False 
BlueLbl.BackColor=Color Blue 
BlueLbl Width=50 
BlueLbl.Height = 50 
BlueLbl.SendToBack()

С помощью блока Width вы можете компактно и быстро указать все 
значения и вызвать все необходимые методы:

With BlueLbl
AutoSize = False 
BackColor=Color Blue 
Width = 50 
. Height = 50 
SendToBack()

End With

При выделении элемента 
списка окна IntelliSense 
на экране появляется всплы­
вающая подсказка с поясне­
нием.

Добавьте в форму «Вызов 
методов объектов» еще один 
элемент управления Label, 
а затем установите его свой­
ства и методы в обработчике 
события загрузки формы 
(Form_Load) с помощью 
блока With.



Создание подпрограммы
Если вы дважды щелкнете мышью по форме или элементу управления 
Button, то увидите, что все обработчики событий начинаются и закан­
чиваются следующим образом:

Private Sub ... End Sub

Sub — это сокращение от английского слова subroutine — подпрограм­
ма, при этом каждая подпрограмма — это закрытый (Private) метод 
класса формы. Вы можете создать собственную подпрограмму-метод 
с нуля, которую можно вызывать из других участков кода при необхо­
димости.

1. Добавьте в форму сле­
дующие элементы управ­
ления: Label, Button 
и TextBox и расположи­
те их так, как показано 
на рисунке.

2. Выберите команду меню Вид => Код (View => Code) или нажмите 
сочетание клавиш F7, чтобы открыть редактор кода, и введите сле­
дующий программный код в раздел объявлений:
Private Sub ClearForm()

TextBoxl Text = ""
TextBox2 Text = ""
TextBox3 Text = ""

End Sub

3. Выберите команду меню Вид => Конструктор (View => Designer) 
или воспользуйтесь сочетанием клавиш Shift+F7, чтобы вернуться 
к конструктору форм и дважды щелкните мышью по кнопке Сбро­
сить, чтобы открыть редактор кода и обработчик события Click.

4. Введите ключевое слово Me. и обратите внимание, что новый метод 
ClearForm () был добавлен к списку во всплывающем окне систе­
мы IntelliSense. Дважды щелкните мышью, чтобы добавить вызов
Me.ClearForm () к программному коду.

5. Запустите приложение, введите какой-нибудь текст во все три 
текстовых поля, затем щелкните мышью по элементу управления 
Button, чтобы очистить все поля.

Выполняемый код обяза­
тельно должен находиться 
внутри процедуры, напри­
мер подпрограммы или 
функции.
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Прием информации во время вызова — одна из мощнейших возмож­
ностей подпрограмм. Информация, передаваемая в подпрограмму, на­
зывается «параметрами». Параметры помещаются в скобки и указыва­
ются в инструкции, вызывающей подпрограмму.

Для того чтобы подпрограмма могла обрабатывать принимаемые дан­
ные, вы должны указать имя и тип данных для каждого принимаемого 
параметра. Например, strAs String  получит от вызывающего кода 
единственный строковый параметр, при этом подпрограмма не может 
быть вызвана, если не осуществляется передача одной строки текста. 
Код подпрограммы в дальнейшем может обращаться к переданному 
значению по имени, в рассмотренном случае — str Подпрограмме 
можно передать сразу несколько параметров, однако не забывайте сле­
дить за соответствием количества, типов и порядка следования переда­
ваемых параметров.

1. Нажмите кнопку Остановить отладку (Stop Debugging), чтобы вер­
нуться к окну формы, изображенному на рисунке на предыдущей 
странице.

2. Выберите команду меню Вид => Код (View => Code) или нажмите со­
четание клавиш F7, чтобы перейти к редактору кода, а затем введите 
следующий код в раздел объявлений:
Private Sub Customer (name As String, addr As String) 

TextBoxl Text = name 
TextBox2 Text = addr 

End Sub

3. Отредактируйте код обработчика события Click кнопки Покупа­
тель, чтобы включить вызов новой подпрограммы:
Me Customer ("Михаил Райтман", "Москва, Зорге, 1")

4. Запустите приложение и щелкните мышью по кнопке Покупатель.

Вы можете сделать так, 
чтобы подпрограмма Sub 
имела глобальный уровень 
доступа, для этого замени­
те модификатор доступа 
Private на Public.

Попробуйте добавить третий 
параметр для заполнения 
поля Телефон.



Сохраняйте полезные функ­
ции в отдельном модуле 
кода, это позволит исполь­
зовать их повторно в других 
проектах и существенно рас­
ширит возможности языка 
Visual Basic.

Создавайте функцию, когда 
необходимо вернуть значе­
ние, если никакого значения 
возвращать не нужно — соз­
дайте подпрограмму Sub.

Создание функции
Функции подобны подпрограммам Sub с одним существенным отли­
чием: функции возвращают значение в вызывающий код. Это значит, 
что при создании функции вы должны указывать не только типы при­
нимаемых параметров, но и тип данных возвращаемого значения.

1. Добавьте в форму три элемента управления Label, одну кнопку 
Button и одно текстовое поле TextBox и расположите эти эле­
менты управления как показано на рисунке.

2. Выберите команду меню Вид => Код (View => Code) или нажмите 
сочетание клавиш F7, чтобы открыть редактор кода. В разделе объ­
явлений введите следующий код:
Private Function Inches (ByVal CmAs String) As Double 

Inches = Cm / 2 54 
Inches=FormatNumber(Inches, 2)
Return Inches 

End Function

Код в скобках указывает, что параметр Inches должен быть стро­
ковым: это значение используется для вычислений. Возвращаемое 
значение присваивается имени функции и представляет собой чис­
ло типа Double с двумя знаками после запятой.

3. В подпрограмму обработчика события Click элемента управления 
Button добавьте вызов функции Inches:
Labell.Text = Inches(TextBoxl Text) & " дюймов"

4. Запустите приложение, 
введите число и щелк­
ните мышью по элемен­
ту управления Button, 
чтобы воспользоваться 
созданной функцией.



Математические
вычисления
Для объекта Math языка Visual Basic реализовано большое количество 
методов, которые могут быть полезными при выполнении различных 
математических вычислений. Наиболее часто используемые методы пе­
речислены в таблице ниже и сопровождены примерами возвращаемых 
значений.

В классе Math также реали­
зована константа Math.PI, 
представляющая собой зна­
чение постоянной п — при­
мерно 3,142.

Примеры возвращаемых 
значений для косинусов, 
логарифмов, синусов и тан­
генсов округлены до трех 
символов после запятой.
В реальности возвращаемые 
значения предоставляют 
гораздо большую точность.
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Генерация 
случайных чисел
Случайные числа можно генерировать с помощью функции Rnd () 
языка Visual Basic. Данная функция возвращает десятичную дробь 
в интервале от 0,0 до 1,0. Умножение случайных чисел позволяет увели­
чить интервал возвращаемых значений. Например, мультипликатор 20 
позволит сгенерировать случайное число в интервале от нуля до два­
дцати. Чтобы упростить использование генерируемых случайных чи­
сел, вы можете округлять эти числа до ближайшего большего целого 
с помощью метода Math.Ceiling (), таким образом, в нашем случае, 
границы интервала генерируемых случайных чисел устанавливаются 
от 1 до 20.

Числа, генерируемые функцией Rnd () не являются истинно случайны­
ми, они представляют собой лишь последовательность псевдослучай­
ных чисел, сгенерированных специальных алгоритмов от обозначен­
ной начальной точки. Каждый раз при запуске приложения функция 
Rnd () начнет генерацию случайных чисел от определенной начальной 
точки, таким образом, последовательность чисел будет повторяться 
вновь и вновь. На самом деле это нежелательный эффект, поэтому, 
во избежание повторений, приложение при загрузке должно автомати­
чески создавать некую начальную точку. Эта задача может быть решена 
путем вызова функции Randomize () в обработчике события загруз­
ки формы (Form_Load). Таким образом, будет создано «семя», или 
начальная точка, для функции Rnd (), при этом значение начальной 
точки будет соответствовать системному времени, когда произошла 
загрузка приложения. Таким образом, последовательность случайно 
генерируемых чисел будет иной при каждой загрузке приложения.

1. Добавьте в форму по одному элементу управления Label, TextBox 
и Button, затем расположите их как показано на рисунке:

Я загадал число от 1 до 20 Попробуй 
отгадать!

2. Присвойте элементу управления Label имя Msg, свойству 
AutoSize установите значение False, а затем укажите значение 
свойства Text, как показано на рисунке.

Текст в элементе управления 
Label не будет перенесен 
на следующую строку, если 
свойству AutoSize не при­
своено значение False.

Числа, создаваемые ал­
горитмами функций 
Randomize () и Rnd(), 
поддаются предсказанию, 
поэтому эти методики 
не должны быть использова­
ны для криптографической 
защиты данных.



12 правильно
Я загадал новое число. Отгадай!

3. Присвойте элементу управления Тext Вох имя Guess, а затем уста­
новите значение свойства Text элемента управления Button, как 
показано на рисунке.

4. Выберите команду меню Вид => Код (View => Code) или нажмите 
сочетание клавиш F7, чтобы открыть редактор кода. В разделе объ­
явлений создайте новую переменную:
Dim num As Integer

5. Все еще находясь в разделе объявлений, добавьте подпрограмму 
Sub для присвоения случайного числа в интервале от 1 до 20 пере­
менной num:
Private Sub GetNumber()

num = Math Ceiling (Rnd () *20)
End Sub

6. В обработчике события загрузки формы (Form_Load) добавьте 
вызов функции для создания семени генератора случайных чисел, 
а также вызов функции для присвоения переменной num начально­
го псевдослучайного значения:
Randomize()
GetNumber()

7. Теперь добавим немного логики обработчику события Click эле­
мента управления Button:
Select Case (Val(Guess.Text))
Case Is > num

Msg Text = Guess Text & " слишком велико"
Case Is < num

Msg. Text = Guess .Text & " слишком мало"
Case Is = num

Msg Text = Guess Text &" правильно" &_
"Я загадал новое число Отгадай! "
Get Number ()

End Select 
Guess Text=""

8. Запустите приложение и отгадайте случайное число.

Прежде чем производить 
сравнение, извлеките 
целочисленное значение 
из текстового поля TextBox 
с помощью функции Val ()

Вы можете воспользовать­
ся константой VbCrLf для 
форматирования содержи­
мого элемента управления
Label.
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Заключение
• Основные элементы программы это: инструкции, переменные, 

функции, операции, свойства объектов и методы объектов.

• Комментарии помогают объяснить предназначение того или иного 
участка кода.

• Объявления переменных создают переменные и могут начинаться 
с ключевых слов Dim, Public и Private.

• Каждое объявление переменной должно содержать спецификатор 
типа данных, которые может содержать создаваемая переменная. 
Для этого используется ключевое слово As и название типа данных.

• Наиболее часто используемыми типами данных являются String, 
Integer,Double и Boolean.

• Числа могут быть извлечены из строк с помощью функции Str (), 
а с помощью функции Val () тип данных String может быть пре­
образован в число.

• Ключевые слова Private и Dim предоставляют локальную область 
действия, это означает, что переменная может быть доступна только 
в рамках одной процедуры или модуля.

• Ключевое слово Pub lie предоставляет глобальную область действия, 
иными словами, переменная будет доступна по всей программе.

• Массив переменных хранит данные в элементах, нумерация кото­
рых начинается с нуля.

• Для арифметических вычислений и операций сравнения использу­
ются операции.

• С помощью инструкций If Else или Select Case выполнение 
кода может разветвляться по условию.

• Инструкции For Next и Do Until создают цикличные повторе­
ния кода.

• Программный код может обращаться к свойствам и методам объ­
ектов.

• Функция возвращает значение, а подпрограмма нет.

• Функциям и подпрограммам могут передаваться значения, но они 
должны быть корректного типа и передаваться в корректном коли­
честве.

• Объект Math предоставляет большое количество полезных методов 
для математических вычислений.

• Псевдослучайные числа могут быть сгенерированы функцией 
Rnd (), при этом семя для генератора случайных чисел создается 
с помощью функции Randomize ()



Сборка приложений

В этой главе 
объединяются элементы 

из предыдущих глав для 
сборки законченного 

приложения: от этапа 
планирования до конечной 

развертки.

• План программы

• Присвоение статических свойств

• Создание интерфейса

• Инициализация динамических свойств

• Добавление функциональности времени 
работы

• Тестирование программы

• Развертка приложения

• Заключение
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При создании нового приложения может оказаться очень полезным 
посвятить немного времени планированию. Четко определите точное 
предназначение программы, решите, какие функции понадобятся при­
ложению, затем определите требующиеся элементы интерфейса.

План простого приложения по подбору чисел для лотереи может вы­
глядеть следующим образом.

Предназначение программы

• Программа будет генерировать набор из шести разных случайных 
чисел в диапазоне от 1 до 4 9, в программе также будет предусмо­
трена возможность сброса значений.

Требуемая функциональность

• Начальный вызов для запуска генератора случайных чисел.

• Процедура для генерации и отображения шести разных случайных 
чисел.

• Процедура для сброса последнего набора чисел.

Требуемые компоненты

• Шесть элементов управления Label для отображения набора чи­
сел: по одному числу на одном элементе управления.

• Один элемент управления Button, по нажатию которого програм­
ма сгенерирует и отобразит на экране числа в элементах управления 
Label. Данный элемент управления Button не будет активен, ко­
гда числа выведены на экран.

• Один элемент управления Button для удаления чисел из элементов 
управления Label. Данный элемент управления Button не будет 
активен, когда числа не выведены на экран.

• Один элемент управления PictureBox для отображения статиче­
ского изображения: просто для улучшения внешнего вида интер­
фейса приложения.

Пропуск стадий планирова­
ния может привести к трате 
большого количества време­
ни на внесение изменений 
в дальнейшем. Всегда лучше 
«планировать работу, а затем 
работать плану».

Переключайте значение 
свойства Enabled элемента 
управления Button для 
направления действий поль­
зователя. В данном случае 
перед генерацией нового 
набора случайных чисел 
пользователь должен выпол­
нить сброс приложения.



Набросав план разработки приложения, вы можете приступить к со­
зданию основ будущего приложения, добавляя в форму необходимые 
компоненты.

1. Запустите IDE Visual Studio и создайте новый проект Windows Forms 
под названием Lotto.

2. В конструкторе добавьте в форму шесть элементов управления 
Label из панели элементов.

3. Теперь добавьте в форму два элемента управления Button и один 
элемент управления PictureBox.

Вы можете переносить эле­
менты управления в форму 
с помощью мыши или два­
жды щелкать мышью по ним, 
чтобы добавить в форму.
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Вы можете открыть панель 
Свойства (Properties), нажав 
сочетание клавиш F4 или 
воспользовавшись коман­
дой меню Вид => Окно 
свойств (View => Properties 
Window).

В этой программе значения 
свойства Text элементов 
управления Label будут 
присваиваться динамиче­
ски, поэтому в присвоении 
статических значений нет 
необходимости.

3. Выделите элемент управления Button2, затем на панели Свой­
ства (Properties) присвойте свойству [Name] значение ResetBtn, 
а свойству Text — значение Сброс.

2. Выделите элемент управления Buttonl, затем на панели Свойства 
(Properties) присвойте свойству [Name] значение PickBtn, а свой­
ству Text — значение Получить счастливые числа.

1 Выделите форму, щелк­
нув по любому сво­
бодному от элементов 
участку, затем на панели 
Свойства (Properties) 
присвойте свойству 
Text значение Подбор 
чисел для лотереи.

Присвоение статических 
свойств
Теперь, когда вы создали основу будущего приложения, мы можем при­
ступить к присвоению статических свойств с помощью панели Свой­
ства (Properties).



4. Выделите элемент управления PictureBox, затем на панели Свой­
ства (Properties) щелкните по кнопке с многоточием в поле свой­
ства Image для открытия диалогового окна Выбор ресурса (Select 
Resources).

Для выбора нужного элемен­
та управления вы можете 
воспользоваться раскры­
вающимся списком в верх­
ней части окна Свойства 
(Properties).

5. Нажмите кнопку Импорт (Import), перейдите к папке, в которой 
сохранено изображение, затем щелкните мышью по кнопке ОК для 
импорта ресурсного изображения. Это действие автоматически 
присвоит новое значение свойству Image элемента управления
PictureBox.

Не забывайте периодиче­
ски сохранять свой проект 
по мере создания с помощью 
команды меню Файл => Со­
хранить все (File => Save All).
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Присвоив статические свойства, вы можете приступить к дизайну гра­
фического интерфейса приложения.

Вы также можете восполь­
зоваться кнопкой со смарт- 
тегом, чтобы установить 
свойство SizeMode элемен­
та управления PictureBox.

Убедитесь, что все свойства 
Margin элемента управле­
ния PictureBox обнулены, 
если вам не нужны рамки 
вокруг изображения.

Размеры элементов управ­
ления PictureBoxl 
и PickBtn необходимо 
изменить так, чтобы они 
могли вмещать содержимое 
свойств Image и Text соот­
ветственно. Эту задачу мож­
но решить, настроив свой­
ство AutoSize с тем, чтобы 
Visual Basic автоматически 
подгонял размеры элементов 
управления в соответствии 
с размерами содержимого.

1. Выделите элемент управления PictureBox, затем на панели 
Свойства (Properties) присвойте свойству SizeMode значение 
AutoSize.

2. Выделите элемент управления PickBtn, затем на панели Свойства 
(Properties) присвойте свойству AutoSize значение True.

Теперь для расположения элементов управления вы можете воспользо­
ваться как меню Формат (Format) конструктора форм, так и специаль­
ными направляющими линиями.

3. Нажав и удерживая левую кнопку мыши, проведите указателем над 
всеми элементами управления Label, чтобы выделить их.



4. Выберите команду меню 
Формат => Выровнять => 
Верхние границы
(Format => Align => Tops), 
чтобы сгруппировать 
элементы управления
Label.

5. Воспользуйтесь коман­
дой Формат => Интервал 
по горизонтали => Сде­
лать равным (Format =>
Horizontal Spacing => Make Equal), чтобы превратить группу элемен­
тов управления Label в равномерную строку.

6. Воспользуйтесь правым маркером формы, дабы увеличить ее ши­
рину таким образом, чтобы группа элементов управления Label 
и элемент управления PictureBox помещались на одной строке, 
затем перенесите получившуюся строку и оба элемента управления 
Button в правую верхнюю часть формы.

7. Перенесите элемент управления PictureBoxl в левую верхнюю 
часть формы, затем воспользуйтесь нижним маркером формы, что­
бы изменить высоту формы так, как показано на рисунке.

В нашем случае абсолютно 
неважно, в каком поряд­
ке элементы управления 
Label будут расположены 
на экране.

8. Воспользуйтесь направляющими линиями, появляющимися на эк­
ране при перемещении элементов управления по форме, чтобы рас­
положить элементы управления Label и Button так, как показано 
на рисунке.

Присвойте свойству 
MaximizeBox формы зна­
чение False, если не хоти­
те, чтобы кнопки сворачи- 
вания/разворачивания окна 
присутствовали в интерфей­
се приложения.
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динамических свойств
Создав визуальный интерфейс, вы можете приступить к добавлению 
функциональности для динамической установки начальных значений 
свойства Text элементов управления Label и состояний элементов 
управления Button.

1. Выберите команду меню Вид => Код (View => Code) или нажмите 
сочетание клавиш F7, чтобы открыть редактор кода.

2. В разделе объявлений введите следующий код и нажмите клавишу 
Enter:
Private Sub Clear

Интегрированная среда разработки Visual Studio распознает, что вы 
хотите создать новую подпрограмму с именем Clear. Система автома­
тически добавит скобки после имени подпрограммы и строку End Sub, 
завершающую блок подпрограммы.

3. Поместите текстовый курсор внутрь блока новой подпрограммы 
и нажмите сочетание клавиш Ctrl+J, чтобы открыть всплывающее 
окно системы IntelliSense.

4. Пролистайте вниз по списку окна системы IntelliSense и дважды 
щелкните мышью по пункту Label1, чтобы добавить его в блок 
кода подпрограммы Clear.

5. Введите точку, затем в появившемся окне системы IntelliSense два­
жды щелкните мышью по элементу Text, чтобы добавить его в код.

Методика, показанная в этом 
примере, иллюстрирует 
использование системы 
IntelliSense, но вы, конечно, 
можете ввести программный 
код с клавиатуры вручную.



6. Теперь для завершения строки введите текст "...", чтобы завершить 
строку, которая должна в итоге выглядеть следующим образом:
Label1. Text = "..."

7 Повторите данную процедуру для других элементов управления 
Label, для того чтобы подпрограмма Clear присваивала много­
точие всем элементам управления Label.

8. Поместите текстовый курсор внутрь блока подпрограммы Clear 
и воспользуйтесь системой IntelliSense для ввода следующего про­
граммного кода:
PickBtn Enabled=True
ResetBtn Enabled=False

Эти две строки завершают код подпрограммы Clear, устанавливая 
состояния элементов управления Button. Теперь осталось лишь до­
бавить вызов подпрограммы Clear для выполнения всех введенных 
инструкций при запуске программы.

9. В окне конструктора дважды щелкните мышью по форме, чтобы 
открыть редактор кода и обработчик события загрузки формы 
(Form_Load), затем воспользуйтесь сочетанием клавиш Ctrl+J, 
чтобы открыть окно IntelliSense.

10. Пролистайте список в окне системы IntelliSense и дважды щелкните 
мышью по только что созданной подпрограмме Clear.

Чтобы сделать код более 
удобочитаемым, добавляйте 
комментарии и смысловые 
разрывы строк.



5.
 С

бо
рк

а 
пр

ил
ож

ен
ий Добавление 

функциональности 
времени работы
Написав программный код для инициализации динамических свойств, 
вы можете теперь добавить код для ответа на нажатие кнопок Button.

1. В окне конструктора форм дважды щелкните мышью по элементу 
управления ResetBtn, чтобы открыть редактор кода и обработчик 
события Click, затем добавьте следующий вызов процедуры Clear:
Clear()

Это все, что нужно для реализации динамической функциональности 
элемента управления ResetBtn. Основная динамическая функцио­
нальность данного приложения реализуется через элемент управления 
PickBtn, для которого требуется запуск генератора случайных чисел 
при запуске программы.

2. В окне конструктора дважды щелкните мышью по форме, чтобы 
открыть редактор кода и обработчик события загрузки формы 
(Form_Load) и вставьте следующую строку для запуска генератора 
случайных чисел:
Randomize()

3. В окне конструктора форм дважды щелкните мышью по элементу 
управления PickBtn, чтобы открыть редактор кода и обработчик 
события Click, затем добавьте следующую строку кода для одно­
временного объявления нескольких переменных:
Dim i, г, temp, nums (50) As Integer

4. Добавьте цикл для заполнения элементов массива 1-49 числами от 1 
до 49:
For i = 1 То 49 

nums(i) = i
Next

5. Добавьте второй цикл для перемешивания значений элементов мас­
сива num. Ниже представлен алгоритм рандомизации порядка сле­
дования элементов:
For i = 1 То 49

г = Int (49 * Rnd () ) + 1 
temp = nums(i) 
nums(i) =nums(r) 
nums(r) =temp

Next

У вас нет необходимости де­
тально запоминать алгоритм, 
используемый нами для 
перемешивания значений.



6. Теперь добавьте следующие строки для вывода на экран в элементы 
управления Label значений, сохраненных в элементах 1-6 массива
nums:
Labell Text=nums(1)
Label2 Text=nums(2)
Label3 Text=nums(3)
Label4 Text=nums(4)
Label5 Text=nums(5)
Label6 Text=nums(6)

7.  Наконец, добавьте следующие две строки кода для подготовки эле­
ментов управления Button к сбросу приложения:
PickBtn Enabled=False 
ResetBtn.Enabled=True

Объявление переменных 
создает целочисленные 
переменные i, г и temp, 
а также целочисленный мас­
сив nums, состоящий 
из 50 элементов, при этом 
элемент nums (0) в про­
грамме не используется.

Для уточнения предназначе­
ния участков кода добавляй­
те комментарии и разрывы 
строк, это упростит пони­
мание программного кода 
сторонними программи­
стами или даже вами, когда 
через некоторое время вы 
вернетесь к ранее создан­
ной программе.
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Проработав план создания программы и добавив все необходимые 
компоненты и всю требуемую функциональность, мы готовы проте­
стировать приложение.

1. Щелкните мышью по кнопке Запуск (Start) или нажмите клавишу 
F5, чтобы запустить приложение и ознакомиться с его изначальным 
внешним видом.

Обработчик события загрузки формы (Form Load) уже установил на­
чальные динамические значения каждого элемента управления Label 
и отключил кнопку Сброс, как и требовалось.

2. Нажмите кнопку PickBtn, чтобы выполнить программные ин­
струкции, помещенные в обработчик события Click данного эле­
мента управления.

На экране отобразится набор чисел требуемого диапазона, состояния 
элементов управления Button изменены как было задано: новый на­
бор чисел не может быть сгенерирован до тех пор, пока не будет выпол­
нен сброс приложения.

3. Запишите числа, сгенерированные для первого набора, чтобы сопо­
ставить их с числами из последующих наборов.

4. Щелкните мышью по кнопке ResetBtn, чтобы выполнить про­
граммные инструкции, помещенные в обработчик события Cl ick  
данного элемента управления. Обратите внимание, что приложение 
вернулось в изначальное состояние, как сразу же после запуска.

Обратите внимание, что 
ни в одном из наборов 
не встречаются повторяю­
щиеся два числа.



5. Еще раз щелкните мышью по кнопке PickBtn, чтобы во второй раз 
выполнить обработчик события Click данного элемента управле­
ния.

На экране появится еще один набор чисел требуемого диапазона, при 
этом числа данного набора отличаются от чисел предыдущего — и это 
хорошо: значит, рандомизация работает как нужно.

6. Нажмите кнопку Остановить отладку (Stop Debugging), а потом на­
жмите кнопку Запуск (Start) еще раз, чтобы перезапустить прило­
жение, и вновь нажмите кнопку PickBtn.

Числа в этом наборе отличаются от чисел первого набора, которые вы 
записали при первом запуске приложения, — отлично: генератор слу­
чайных чисел не повторяет одну и ту же последовательность чисел при 
каждом запуске приложения.

Отсутствие метода 
Randomize () приведет 
к тому, что приложение бу­
дет вновь и вновь повторять 
один и тот же порядок чисел 
при каждом запуске.
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Приложение не может быть 
опубликовано без предвари­
тельной сборки.

Публикация приложения
Если тестирование приложения имело положительные результаты, вы 
можете создать независимую версию программного продукта, который 
может выполняться вне IDE Visual Studio и распространяться на другие 
компьютеры с целью развертки.

1. В меню Проект (Project) выберите пункт Свойства Lotto (Lotto 
Properties) и перейдите на вкладку Подписывание (Signing).

2. Сбросьте флажок Подписать манифесты ClickOnce (Sign the 
ClickOnce manifests).

3. Выберите команду меню Сборка => Построить Lotto (Build => Build 
Lotto), чтобы собрать готовую для выпуска версию проекта.

4. Выберите команду Сборка => Опубликовать Lotto (Build => Publish 
Lotto), чтобы опубликовать приложение.

5. Перейдите в каталог данного проекта и откройте в нем папку Lotto\ 
bin\Debug.



Если вы выбрали в раскры­
вающемся списке конфи­
гураций пункт Release 
(Релиз), путь будет выглядеть 
несколько иначе — Lotto\ 
bin\Release.

Мастер публикации генерирует целый набор файлов, в том числе файл 
Lotto.exe исполняемый файл приложения.

6. Запустите файл Lotto.exe — готовую версию приложения, которая 
будет функционировать точно так же, как и версия для отладки 
в Visual Studio.



Заключение
• Всегда намечайте изначальный план создания программы, чтобы 

избежать трудоемкого, занимающего много времени процесса вне­
сения изменений.

• План программы должен четко определять предназначение про­
граммы, требуемую функциональность и необходимые компоненты.

• Статические свойства, не изменяющиеся во время работы приложе­
ния, могут быть настроены во время разработки с помощью панели 
Свойства (Properties).

• Значение свойства AutoSize позволяет точно подогнать размеры 
элемента управления под размеры его содержимого.

• Меню Формат (Format) конструктора форм содержит полезные 
функции для быстрого выравнивания и распределения нескольких 
элементов управления относительно друг друга.

• Направляющие линии облегчают выравнивание выделенного эле­
мента управления относительно других элементов управления 
во время разработки приложения.

• Динамические свойства, изменяющиеся во время работы приложе­
ния, могут быть инициализированы в обработчике события загруз­
ки формы (Form_Load).

• Всплывающее окно IntelliSense позволяет запросто добавлять про­
граммный код при использовании Редактора кода.

• Функциональность времени работы приложения отвечает на дей­
ствия пользователя, изменяя динамические свойства.

• Версия приложения для отладки позволяет протестировать его 
функционирование, во время создания приложения в текстовом 
формате.

• Процесс построения приложения компилирует готовую для выпу­
ска версию приложения в двоичном формате.

• Процесс публикации создает финальную версию приложения. Та­
ким образом, приложение может быть запущено на других компью­
терах.



Решение проблем

В этой главе 
рассказывается 

о способах исправления 
ошибок, отладки кода, 

обработки исключений 
и получения справочных 

сведений в IDE Visual 
Studio.

• Обнаружение ошибок в режиме реального 
времени

• Исправление ошибок компиляции

• Отладка кода

• Установка точек останова для отладки

• Обнаружение ошибок времени выполнения

• Перехват ошибок времени выполнения

• Получение справки

• Заключение
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В то время, когда вы вводите код в окно редактора кода, Visual Studio осу­
ществляет постоянный мониторинг вводимого вами программного кода 
на предмет возможных ошибок. Когда вы нажимаете клавишу Enter в кон­
це каждой строки, среда разработки проверяет только что введенную стро­
ку и в режиме реального времени выдает рекомендации по возможным 
ошибкам, подчеркивая волнистой линией спорный участок кода.

Предупреждения о возможных проблемах форматируются зеленым 
волнистым подчеркиванием. Выделяемые таким образом проблемы 
не являются критичными и не будут препятствовать выполнению при­
ложения. Всплывающая подсказка содержит комментарий к вынесен­
ному предупреждению.

1. В окне редактора кода введите следующее объявление переменной 
в блоке любой подпрограммы, затем нажмите клавишу Enter:
DimnumAs Integer

2. Установите указатель мыши поверх волнистого подчеркивания, 
чтобы выяснить, в чем суть вынесенного предупреждения. Оказы­
вается, система информирует лишь о том, что возможно возник­
новение проблемы, так как объявленной переменной еще не было 
присвоено значение.

Ошибки выделяются красным подчеркиванием. В отличие от преду­
преждений, ошибки являются критичными и предотвращают выпол­
нение приложения. Всплывающая подсказка содержит объяснение до­
пущенной ошибки.

1. В окне редактора кода введите следующее объявление переменной 
в блоке любой подпрограммы, затем нажмите клавишу Enter:
Dim num As Integer =

Вы можете проигнорировать 
предупреждения, но ошибки 
необходимо исправить.



2. Установите указатель мыши поверх волнистого подчеркивания 
и выясните, что ошибка возникла из-за того, что в выражении от­
сутствует присваиваемое значение.

Обнаружение ошибок в режиме реального времени это потрясаю­
щий инструмент IDE Visual Studio, позволяющий предотвратить воз­
никновение ошибок при вводе программного кода. Данный инструмент 
не только выделяет ошибки, но и предоставляет список возможных ва­
риантов для их исправления.

1. В окне редактора кода введите следующее объявление переменной 
в блоке любой подпрограммы, затем нажмите клавишу Enter:
DimnumAs Integr

2. Обратите внимание, что подчеркивание сопровождается прямо­
угольником с лампочкой, обозначающим, что у системы есть вари­
анты для исправления данной ошибки. Установите указатель мыши 
поверх волнистого подчеркивания, чтобы выяснить, что ошибка 
возникла из-за использования неизвестного системе спецификато­
ра типа данных.

3. Установите указатель мыши поверх прямоугольника с лампочкой, 
чтобы увидеть варианты исправления ошибки.

4. Щелкните мышью по прямоугольнику с лампочкой, а затем выбери­
те вариант для исправления ошибки и убедитесь, что ваш код был 
исправлен верно.

Установив указатель мыши 
поверх волнистого подчер­
кивания, вы можете просмо­
треть сведения о способе 
исправления ошибки.
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компиляции
В то время как синтаксические ошибки, наподобие тех, что были продемон­
стрированы нами на предыдущей странице, могут быть обнаружены ре­
дактором кода в режиме реального времени, другие ошибки, возникающие 
при использовании корректного синтаксиса программных инструкций, 
не могут быть обнаружены до того, как код программы скомпилирован. 
Ошибки компиляции, как правило, — это логические ошибки, вызываю­
щие остановку выполнения приложения при возникновении «исключе­
ния». Например, когда в выражении используются несовместимые типы 
данных, возникает исключение IncompatibleCastException и вы­
полнение программы немедленно прекращается.

1. В окне редактора кода введите следующие строки в блоке любой 
подпрограммы:
Dim num As Double = 7.5 
Dim str As String = "five"
MsgBox(num*str)

2. Нажмите кнопку Запуск (Start) или клавишу F5, чтобы запустить 
выполнение подпрограммы и убедитесь, что в скором времени вы­
полнение программы будет прервано. В окне редактора кода систе­
ма выделяет строку кода, вызвавшую исключение, а на экране появ­
ляется окно, содержащее информацию о проблеме.

Чтобы исправить возникшее исключение InvalidCastException, 
очевидно, потребуется отредактировать программный код таким обра­
зом, чтобы оба значения в выражении были одного типа Double.

Причина других ошибок компиляции может быть менее очевидна и тре­
бовать более тщательного исследования проблемного участка кода. На­
пример, цикл, считывающий элементы массива, может пробовать об­
ращаться к элементу с несуществующим индексом, что также приведет 
к возникновению исключения IndexOutOfRangeException.

Вы можете щелкнуть мышью 
по кнопке Прервать (Abort), 
чтобы прервать выполнение 
программы, или же про­
должить ее работу с помо­
щью кнопки Продолжить 
(Continue).



Выполнение программы остановится незамедлительно, поэтому полез­
но будет проверить значение счетчика, чтобы выяснить, какая из ите­
раций цикла вызывает ошибку компиляции.

1. В окне редактора кода введите следующее объявление переменной 
и цикл в блоке любой подпрограммы:
Dimi, nums(10) As Integer
For i = 1 To 20

nums(i) = i
Next

2. Щелкните мышью по кнопке Запуск (Start) или нажмите клавишу 
F5, чтобы запустить подпрограмму — и убедитесь, что в скором вре­
мени выполнение программы будет прервано. В окне редактора кода 
система выделяет строку кода, вызвавшую исключение, а на экране 
появляется окно, содержащее информацию о проблеме.

3. Установите указатель мыши над переменной-счетчиком. Текущее 
значение переменной появится во всплывающей подсказке.

Теперь ясно, что выполнение программы было остановлено, когда цикл 
попытался обратиться к элементу массива nums (11), находящемуся 
вне границ последнего элемента массива nums (10). Чтобы исправить 
данное исключение IndexOutOfRangeException, потребуется ре­
дактирование кода и остановка выполнения цикла после десятой ите- 
папии.

Еще одна частая ошиб­
ка компиляции — 
FileNotFoundException, 
возникающая, если нужный 
файл не был найден или ука­
зан неверный путь к данно­
му файлу.
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Иногда очень полезно отслеживать построчно выполнение программ­
ного кода, чтобы оперативно находить ошибки. Выполнение програм­
мы можно отследить, щелкнув мышью по кнопке Шаг с заходом (Step 
Into) на панели IDE или нажав клавишу F8, что позволит пройтись 
по всему программному коду строка за строкой. Начав отладку, вы мо­
жете воспользоваться панелью Контрольные значения (Watch), чтобы 
отследить значение интересующей вас переменной по мере выполнения 
программного кода.

1. Дважды щелкните мышью по форме, чтобы открыть редактор кода 
и обработчик события загрузки формы (Form_Load), затем введи­
те следующий код:
Dim i As Integer 
Dim pass As Integer = 0 
Dim base As Integer = 2 
For i = 1 To 2

pass = pass + 1 
base = Square(base)

Next

2. Теперь добавьте функцию Square в раздел объявлений программ­
ного кода:
Function Square (ByVal numAs Integer) 

num = num * num 
Return num 

End Function

3. Щелкните мышью по серому полю слева от обработчика события 
загрузки формы, чтобы установить в этой позиции точку останова.

4. Щелкните мышью по кнопке Шаг с заходом (Step Into) на панели 
IDE или нажмите клавишу F8, чтобы начать отладку.

5. Воспользуйтесь командой Отладка => Окна => Контрольные зна­
чения => Контрольные значения 1 (Debug => Windows => Watch => 
Watch 1) в меню, чтобы открыть одноименную панель.

6. Введите имя перемен­
ной pass в столбец Имя 
(Name) и нажмите клави­
шу Enter, затем повторите 
эту же операцию для пере­
менной base.

Вы можете нажать кнопку 
Остановить отладку (Stop 
Debugging), чтобы вернуть­
ся к нормальному режиму 
редактора кода.



7. Щелкните мышью по кнопке Шаг с заходом (Step Into) пять раз, что­
бы достичь вызова функции Square в первом цикле, и запишите 
значения переменных.

8. Щелкните мышью по кнопке Шаг с заходом (Step Into) еще восемь 
раз, чтобы пройти по всем строкам функции Square и цикла, а так­
же вернуться к вызову функции во втором повторении цикла.

9. Щелкните мышью по кнопке Шаг с обходом (Step Over) еще один 
раз, чтобы выполнить функцию без прохода по каждой строке.

Кнопка Шаг с выходом (Step 
Out) может быть использова­
на, чтобы вернуться к коду, 
вызывающему функцию, ко­
гда вы проходите по строкам 
программного кода вызван­
ной функции.
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При работе с большинством программ, кроме самых маленьких, при­
ходится каждый раз проходить по всем строкам программного кода. 
Вместо этого вы можете быстро достичь нужного участка кода, устано­
вив «точку останова», приостанавливающую выполнение программы 
на заданной строке. Установка одной или нескольких точек останова 
поможет вам понять принцип работы некоторых конструкций языка 
Visual Basic, например вложенных циклов, продемонстрированных 
в этом примере.

1. Дважды щелкните мышью по форме, чтобы открыть редактор кода 
и обработчик события загрузки формы (Form_Load), затем введи­
те следующий код:
Dimi, j, k As Integer 
Dim pass As Integer = 0 
For i = 1 To 3 

For j = 1 To 3
For k = 1 To 3

pass = pass + 1
Next

Next
Next

2. В окне редактора кода щелкните мышью по серой рамке напротив 
каждой строки, содержащей ключевое слово Next, чтобы устано­
вить три точки останова. В результате на серой рамке напротив каж­
дой инструкции Next появится красная точка, а каждая инструк­
ция Next будет выделена цветом, обозначающим установку точки 
останова.

3. Щелкните мышью по кнопке Запуск (Start) или нажмите клавишу F5. 
Запущенное приложение будет выполнено до первой точки останова.

Выделение желтым цветом 
означает текущее поло­
жение. Щелкните мышью 
по красной точке, чтобы 
отменить точку останова.



Во время прогона прило­
жения окно Локальные 
(Locals) отображает все пе­
ременные текущей области 
действия.

Любой код, вводимый на па­
нели Окно интерпретации
(Immediate), динамически 
применяется к приложе­
нию и участвует в процессе 
отладки, но не изменяет 
исходный код приложения. 
Попробуйте ввести инструк­
цию MsgBox("Привет!") 
на панели Окно интерпре­
тации (Immediate) и нажми­
те клавишу Enter.

4. Воспользуйтесь командой Отладка => Окна => Локальные (Debug => 
Windows => Locals), чтобы открыть окно Локальные (Locals), и за­
пишите текущее значение всех переменных.

5. Пронаблюдайте изменение значений переменных при повторных 
нажатиях кнопки Запуск (Start) и переходите к следующим точкам 
останова до тех пор, пока вы не достигнете третьей, внешней, ин­
струкции Next, после чего щелкните мышью по кнопке Шаг с захо­
дом (Step Into), чтобы дойти до конца подпрограммы.

По окончании работы подпрограммы, все переменные-счетчики до­
стигли значения, превышающего верхний предел, установленный ци­
клами For Это сделано для того, чтобы программа вышла из всех ци­
клов. В общей сложности было произведено 27 итераций (3x3x3).

6. Нажмите кнопку Остановить отладку (Stop Debugging), чтобы за­
вершить работу программы, а затем еще раз нажмите кнопку Запуск 
(Start) для прогона программы до первой точки останова.

7. Выберите команду меню Отладка => Окна => Интерпретация 
(Debug => Windows => Immediate) или воспользуйтесь сочетанием 
клавиш Ctrl+Alt+I, чтобы открыть панель Окно интерпретации 
(Immediate).

8. На панели Окно интерпретации (Immediate) введите инструк­
цию i = 3 и нажмите клавишу Enter, после чего щелкните мышью 
по кнопке Шаг с заходом (Step Into), чтобы пройти по всем строкам 
последней итерации внешнего цикла.



6.
 Р

еш
ен

ие
 п

ро
бл

ей Обнаружение ошибок 
времени выполнения
В то время как редактор кода предоставляет возможность обнаружения 
синтаксических ошибок в режиме реального времени, а компилятор пе­
рехватывает логические ошибки, предсказывание действий пользова­
теля, способных повлечь возникновение ошибок времени выполнения, 
полностью ложится на плечи программиста. Размышление о том, каким 
образом пользователь может применять ваше приложение, очень по­
лезно для предсказания потенциальных ошибок времени выполнения.

1. Создайте новый проект 
и разместите на фор­
ме элементы управле­
ния Label, TextBox
и Button, как показано 
на рисунке.

2. Назовите желтый эле­
мент управления Label 
ResultLbl.

3. Дважды щелкните мышью по кнопке Вычислить, чтобы открыть ре­
дактор кода и обработчик события Click данного элемента управле­
ния, а затем введите следующий код для создания простого сумматора:
Dim numl As Integer =.Val (TextBoxl. Text)
Dim num2 As Integer = Val (TextBox2 Text)
ResultLbl text = numl+ num2

4. Воспользуйтесь командой Сохранить все (Save АН), обратите вни­
мание на путь, по которому был сохранен проект, затем закройте 
Visual Studio.

5. Перейдите к расположению проекта и дважды щелкните мышью 
по исполняемому файлу в папке /bin/Debug, чтобы запустить при­
ложение вне среды Visual Studio.

6. Введите числовое значе­
ние в каждое текстовое 
поле, затем нажмите 
кнопку Вычислить 
и убедитесь, что при­
ложение работает, как 
ожидается.

Сложение десятичных 
дробей с помощью данного 
сумматора приведет к округ­
лению результата до бли­
жайшего целого.



Точный диапазон зна­
чений типа данных 
Integer от-2.147.483.648 
до 2.147.483.647.

7. Теперь попробуйте 
сложить большие числа, 
например те, что показа­
ны на рисунке: возник­
нет ошибка и система 
остановит выполнение 
программы, выдав сооб­
щение о переполнении.

Несмотря на то, что программист, возможно, не рассчитывал на то, 
что приложение будет использоваться для сложения таких больших 
чисел, всегда существует вероятность того, что пользователь пожела­
ет это сделать, — и программист должен учесть эту возможность, что­
бы избежать возникновения ошибок времени выполнения подобного 
рода. На самом деле переполнение возникло из-за того, что тип данных 
Integer может хранить числовые значения в диапазоне примерно 
только до двух миллиардов. Эту проблему можно исправить, изменив 
спецификатор типа данных переменных на Long.

8. Выйдите из приложения и отредактируйте обработчик события 
Click  кнопки Вычислить следующим образом:
Dim numl As Long = Val (TextBoxl Text)
Dim num2 As Long = Val (TextBox2 . Text)
ResultLbl text = numl + num2

9.  Сохраните исправ­
ленный проект, затем 
запустите приложение 
и снова попытайтесь 
сложить эти два длин­
ных числа.
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времени выполнения
Если вы можете предсказать потенциальные ошибки времени выполне­
ния, обдумав все возможные варианты поведения пользователя, значит 
вы можете предоставить код для обработки возникающих исключений 
с помощью блока Try Catch. Если вы пожелаете, то ваша программа 
может предоставить пользователю информацию о возникшей ошибке 
и продолжить выполнение в нормальном режиме. Эту методику сле­
довало бы использовать в предыдущем примере вместо предложения 
отредактировать исходный код программы.

1. Повторите шаги 1, 2 и 3 предыдущего упражнения, чтобы создать 
простой сумматор, затем щелкните мышью по кнопке Запуск (Start) 
или нажмите клавишу F5, чтобы запустить приложение в режиме 
отладки.

2. Введите два длинных 
числа и нажмите кноп­
ку Вычислить, чтобы 
попытаться вычислить 
сумму этих чисел.
В результате компиля­
тор сообщит о возник­
новении исключения 
OvertlowException.

3. Щелкните мышью по кнопке Остановить отладку (Stop Debugging), 
чтобы отредактировать программный код.

4. Щелкните правой кнопкой мыши в блоке кода обработчика события 
Click кнопки Вычислить и выберите пункт Фрагмент кода => Вста­
вить фрагмент кода => common code patterns => exception handling
(Snippet => Insert Snippet => common code patterns => exception 
handling).

Вы можете воспользоваться 
контекстным меню, от­
крывающимся при щелчке 
правой кнопкой мыши, для 
быстрого переключения 
между редактором кода 
и конструктором форм.



5. Дважды щелкните мышью по пункту Оператор Try...Catch...End 
Try (Try. .Catch..End Try Statement), чтобы вставить блок оператора 
Try Catch в окно редактора кода.

Команда Фрагмент кода
(Insert Snippet) содержит 
большое количество полез­
ных шаблонов кода, которые 
вы также можете вставить 
в окно редактора кода. 
Уделите немного времени 
изучению содержимого 
этого меню.

6. Во вставленном блоке кода замените инструкцию
ApplicationException на OvertlowException.

7 Вырежьте и вставьте между ключевыми словами Try и Catch стро­
ки исходного кода.

8. Между ключевыми словами Catch и End Try введите следующий 
программный код:
MsgBox ("Вычисляет числа в пределах 2 миллиардов")

Try
Dim num1 As Integer = Val(TextBox1.Text)
Dim num2 As Integer = Val(TextBox2.Text)
ResultLbl.Text = num1 + num2

В разделе «Исправление 
ошибок компиляции» 
данной главы попробуйте 
вставить обработчик исклю­
чения вместо редактирова­
ния программного кода.

9. Щелкните мышью
по кнопке Запуск (Start) 
и введите длинные чис­
ла, как и в прошлый раз, 
затем нажмите кнопку 
Вычислить — и убеди­
тесь, что приложение об­
рабатывает исключение.

10. Щелкните мышью по кнопке ОК, чтобы закрыть диалоговое окно, 
измените числа так, чтобы они попадали в разрешенный диапазон, 
и продолжайте нормальную работу с приложением.

Catch ex As OverflowException
MsgBox("Вычисляет числа в пределах 2 миллиардов”) 

End Try
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Система справки IDE Visual Studio это библиотека, представляю­
щая собой богатейший ресурс информации, могущий помочь решить 
большинство проблем. Библиотека системы справки доступна из меню 
Справка (Help) или по нажатию сочетания клавиш F1. Однако прежде 
чем вы получите доступ к справочной системы, при самом первом об­
ращении вы должны решить, какими источниками следует пользовать­
ся: локальными или онлайн. Онлайн-справка — это наилучший выбор, 
если у вас есть широкополосный доступ в Интернет. Вы можете изме­
нить приоритет источников в любое время.

1. Выберите команду меню Справка => Задать параметры справки
(Help => Set Help Options) и далее выберите источник справки, он­
лайн или локальный.

2. В нашем случае установите флажок Запустить в браузере (Run in 
browser).

3. Загрузить локальную справочную систему на компьютер вы можете, 
нажав сочетание клавиш Ctrl+Alt+Fl, чтобы открыть окно Средство 
просмотра справки (Help Library Manager). В данном окне вы можете 
выбрать разделы документации, которые требуется загрузить.

Окно Средство просмо­
тра справки (Help Library 
Manager) позволяет загру­
зить на компьютер и исполь­
зовать справочную систему 
без доступа к Интернету, 
а также проверять доступные 
обновления документации.



В документации Visual Studio вы можете найти ответы на вопросы, свя­
занные с созданием программного кода. Например, вы можете узнать, 
какие типы данных доступны для программистов на языке Visual Basic.

1. Активируйте подключение к Интернету, затем выберите коман­
ду меню Справка => Просмотр справки (Help => View Help) или 
воспользуйтесь сочетанием клавиш F1, чтобы открыть начальную 
страницу справочной системы в веб-браузере, используемом в ва­
шей системе по умолчанию.

Вы также можете выбрать 
команду меню Справка => 
Техническая поддержка
(Help =>Technical Support), 
чтобы задать вопрос, 
связанный с программиро­
ванием, на форумах MSDN 
и CodeZone Community, спе­
циализирующихся на про­
граммировании в средах 
Microsoft. Кроме того, посмо­
трите сайт VBCity.com для 
получения справки по языку 
Visual Basic.

2. В поле ввода текста введите поисковый запрос «типы данных visual 
basic», затем щелкните мышью по кнопке поиска, чтобы выполнить 
поиск.

3. Когда поисковая система вернет результаты, щелкните по ссылке 
«Типы данных в Visual Basic».

Библиотека справки — это 
общий ресурс для несколь­
ких продуктов по про­
граммированию компании 
Microsoft. Убедитесь, что 
результаты поиска относятся 
именно к языку Visual Basic.



Заключение
• Редактор кода осуществляет постоянный мониторинг вводимого 

программного кода для выявления ошибок в режиме реального 
времени.

• Предупреждения не являются критичными и представляют собой 
подчеркивание зеленой волнистой линией, в то время как ошибки 
критичны и представляют собой подчеркивание красной волнистой 
линией.

• Прямоугольник с лампочкой рядом с красной волнистой линией 
означает, что доступен список вариантов исправления ошибки.

• Как правило, ошибки реального времени синтаксические, тогда как 
ошибки компиляции — логические.

• Когда в режиме отладки обнаруживается ошибка компиляции, вы­
полнение программы останавливается, а в диалоговом окне отобра­
жается причина ошибки.

• Кнопка Шаг с заходом (Step Into) позволяет пройтись по программ­
ному коду строка за строкой.

• Кнопка Шаг с обходом (Step Over) позволяет пропустить стро­
ки кода вызванной функции, а кнопка Шаг с выходом (Step Out) 
позволяет вернуться к той строке кода, которая вызывала данную 
функцию.

• Во время выполнения программы с помощью окон Контрольные 
значения (Watch) и Локальные (Locals) можно отследить значения 
переменных.

• Точки останова прекращают выполнение программы на тех строках 
кода, на которых они установлены, для предоставления возможно­
сти осмотра состояния программы.

• В режиме отладки вы можете динамически применить программ­
ный код с помощью панели Интерпретация (Immediate).

• Ошибки времени выполнения возникают, когда то или иное дей­
ствие пользователя не было предсказано программистом.

• Воспользуйтесь блоком Try Catch для обработки ожидаемых ис­
ключений.

• Библиотека справки — это богатый ресурс и система помощи в Ин­
тернете.



Расширение
возможностей
интерфейса

В этой главе мы покажем 
вам, как приложения 

могут задействовать 
диалоговые окна, меню, 
состоять из нескольких 

форм и подключаться, 
к Windows Media Player.

• Диалоговые окна выбора цвета, шрифта 
и изображения

• Диалоговые окна открытия, сохранения 
и печати

» Создание меню приложений

• Как заставить меню работать

• Добавление дополнительных форм

• Управление множеством форм

• Воспроизведение звуков

• Воспроизведение мультимедийных 
материалов

• Заключение
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выбора цвета, шрифта 
и изображения
Интегрированная среда разработки Visual Studio предоставляет про­
стой доступ к возможности вызывать стандартные диалоговые окна 
Windows, чтобы при работе с вашим приложением пользователь мог, 
например, осуществлять выбор цвета, шрифта или изображения.

1. Создайте новый проект Windows и добавьте в форму по одному эле­
менту управления PictureBox и TextBox, а также три элемента 
управления Button.

2. Присвойте элементам управления Button следующие имена:
ColorBtn,FontBtn и ImgBtn.

3. Из категории Диалоговые окна (Dialogs) панели элементов до­
бавьте в форму компоненты ColorDialog, FontDialog 
и OpenFileDialog. Вы увидите, что данные компоненты появи­
лись в нижней части конструктора форм.

4. Дважды щелкните мышью по кнопке ColorBtn и введите следую­
щие строки кода в обработчик события Click данного элемента 
управления:
If ColorDialogl.ShowDialog =

Windows Forms.DialogResult OK Then 
Me BackColor=ColorDialogl Color 

End If

5. Дважды щелкните мышью по кнопке FontBtn и введите следую­
щие строки кода в обработчик события Click  данного элемента 
управления:

Присвойте свойству 
Multiline элемента управ­
ления TextBox значение 
True, чтобы сделать его 
чуть шире, чем стандартное 
однострочное поле ввода 
текста.

ColorDialogl FontDialog! OpenFileDialog!

ColorFontlmageDiaiogs

Цвет Шрифт Рисунок



Диалоговое окно 
OpenFileDialog позво­
ляет пользователю вы­
брать любое изображение. 
Инструкция Try Catch 
обрабатывает исключение 
ArgumentException, 
возникающее, если пользо­
ватель выбрал файл, не яв­
ляющийся изображением.

IfFontDialogl ShowDialog=
Windows Forms DialogResult OK Then 
TextBoxl.Font = FontDialogl.Color

End If

6. Дважды щелкните мышью по кнопке ImageBtn и введите следую­
щие строки кода в обработчик события Cl ick  данного элемента 
управления:
IfOpenFileDialogl ShowDialog=

Windows Forms DialogResult.OK Then
Try

PictureBoxl Image =
New Bitmap(OpenFileDialogl.FileName)

Catch ex As ArgumentException
MsgBox("He изображение")

End Try 
End If

7.  Щелкните мышью по кнопке За­
пуск (Start) или нажмите клавишу 
F5, чтобы запустить приложение, 
затем щелкните мышью по кнопке 
ColorBtn, чтобы увидеть знакомое 
диалоговое окно Цвет (Colour) опе­
рационной системы Windows.

8.  Выберите цвет, затем щелкните мы­
шью по кнопке ОК, чтобы приме­
нить новый цвет фона формы.

9. Введите какой-нибудь текст в элемент управления TextBox, затем 
нажмите кнопку FontBtn, чтобы выбрать гарнитуру шрифта для 
введенного текста.

10. Щелкните мышью по кнопке ImageBtn, чтобы найти и выбрать изо­
бражение, отображаемое в окне элемента управления PictureBox.

ColorFontlmageDialogs
.......... ..... ............ . . .... ............. ............. ..........................................

Visual Basic - новая книга!

Цвет Шрифт Рисунок
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Всегда настраивайте па­
раметры фильтрации, 
чтобы определить, какие 
типы файлов отобража­
ются в диалоговом окне 
OpenFileDialog, а ка­
кие — нет.

Диалоговые окна 
открытия, сохранения 
и печати
Приложения, создаваемые с помощью Visual Studio, могут вызывать 
стандартные диалоговые окна Windows, позволяющие пользователям 
открывать, сохранять и распечатывать файлы.

1. Создайте новый проект Windows 
и добавьте в форму элемент 
управления RichTextBox, 
а также три элемента управ­
ления Button, присвоив им 
имена OpenBtn, SaveBtn 
и PrintBtn.

2. Из категории Диалоговые окна (Dialogs) панели элементов добавь­
те в форму компоненты OpenFileDialog и SaveFileDialog, 
затем из раздела Печать (Printing) = добавьте компонент 
PrintDialog. Вы увидите, что данные компоненты появились 
в нижней части конструктора форм.

3. Дважды щелкните мышью по кнопке OpenBtn и введите следую­
щие строки кода в обработчик события Click данного элемента 
управления:
With OpenFileDialogl

Title— "Открыть файл"
Filter = "Rich Text Files | *.rtf"
.FileName = ""
CheckFileExists = True

End With

If OpenFileDialogl.ShowDialog = _
Windows.Forms.DialogResult OK Then 

RichTextBox1 LoadFile(OpenFileDialogl FileName,_ 
RichTextBoxStramType RichText)
End if

4. Дважды щелкните мышью по кнопке PrintBtn и введите следую­
щие строки кода в обработчик события Click данного элемента 
управления:



If PrintDialogl ShowDialog = _
Windows Forms.DialogResult.OK Then 
'Вставить код для печати

End if

5. Дважды щелкните мышью по кнопке SaveBtn и введите следую­
щие строки кода в обработчик события Click данного элемента 
управления:
With SaveFileDialog1

Title = "Сохранить файл"
Filter = "Rich Text Files I * rtf"
.DefaultExt = " rtf"
.OverWritePrompt = True

End With

IfSaveFileDialogl ShowDialog = _
Windows.Forms.DialogResult.OK Then

RichTextBoxl.SaveFile(SaveFileDialogl.FileName,_ 
RichTextBoxStramType RichText)

End if

6. Щелкните мышью по кнопке Запуск (Start) или нажмите клавишу 
F5, чтобы запустить приложение, затем щелкните мышью по кноп­
ке OpenBtn, чтобы открыть стандартное в операционной системе 
Windows диалоговое окно открытия файлов.

7 Выберите любой файл формата 
RTF, нажмите кнопку Открыть, 
чтобы загрузить файл в элемент 
управления RichTextBox.

8. Нажмите кнопку Сохранить, что­
бы пересохранить загруженный 
файл под другим именем.

Диалоговое окно печати 
не определяет автоматиче­
ски, каким образом следует 
распечатать ваш документ: 
вам необходимо предоста­
вить программный код, осу­
ществляющий возможность 
печати документа. В начале 
главы 9 приведен пример 
печати простых текстовых 
документов.

9. Щелкните мышью по кнопке PrintBtn, чтобы запустить стан­
дартное для операционной системы Windows диалоговое окно пе­
чати, в котором вы можете выполнить настройку принтера перед 
запуском процесса печати.
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Создание меню 
приложений
В свое приложение на языке Visual Basic вы запросто можете добавить 
раскрывающиеся меню, панели инструментов и строки состояния, ко­
торые вы можете встретить в большинстве приложений Windows. Все 
перечисленные элементы могут быть добавлены в приложение с помо­
щью панели элементов.

1. На панели элементов найдите раздел Меню и панели инструмен­
тов (Menus & Toolbars) и дважды щелкните по элементу управления
Menus trip, чтобы добавить его в форму.

2. Щелкните мышью по смарт-тегу (кнопка со стрелкой) элемен­
та управления MenuStrip, затем в открывшемся контекстном 
меню щелкните по ссылке Вставить стандартные элементы (Insert 
Standard Items).

Вы можете создавать соб­
ственные элементы меню 
с помощью полей Вводить 
здесь (Туре Неге) вместо 
использования команды 
Вставить стандартные 
элементы (Insert Standard 
Items).

3. Когда знакомые заголовки и элементы меню добавлены на элемент 
управления MenuStrip, щелкните правой кнопкой мыши по лю­
бому элементу меню, чтобы отредактировать его. При необходи­
мости введите имена собственных элементов меню в поля Вводить 
здесь (Туре Неге).



4. На панели элементов дважды щелкните мышью по элементу 
ToolStrip, чтобы добавить его в форму. Затем щелкните мы­
шью по смарт-тегу и в открывшемся контекстном меню щелкните 
по ссылке Вставить стандартные элементы (Insert Standard Items).

5. Когда стандартные значки и кнопки добавлены на элемент управле­
ния ToolStrip, щелкните правой кнопкой мыши по любому эле­
менту, чтобы отредактировать его с помощью контекстного меню. 
При необходимости вы также можете добавить дополнительные 
элементы из раскрывающегося списка.

6. На панели элементов дважды щелкните мышью по элементу 
StatusStrip, чтобы добавить его в форму.

7 Из раскрывающегося списка элемента управления StatusStrip 
выберите элемент StatusLabel и присвойте его свойству Text 
значение Готово. Используйте строку состоя­

ния (элемент управления 
StatusBar) для оповеще­
ния пользователя о состоя­
нии приложения и выпол­
няемых задач.

8. В центр формы вставьте элемент управления RichTextBox, щелк­
ните по смарт-тегу и выберите команду Закрепить в родительском 
контейнере (Dock in parent container). Затем убедитесь, что свойству 
ScrollBars присвоено значение Both.
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Будьте аккуратны и не щел­
кайте мышью по имени эле­
мента меню, если вы не хо­
тите изменить используемое 
по умолчанию клавиатурное 
сокращение: чтобы открыть 
редактор кода, щелкните 
мышью рядом с именем 
элемента меню.

Как заставить меню 
работать
Элементы меню и кнопки панели инструментов, добавленные в прило­
жение на предыдущей странице, не будут выполнять ожидаемых от них 
действий до тех пор, пока вы не введете программный код, заставляю­
щий их работать. Для действий, выполняемых как элементами меню, 
так и кнопками панели инструментов, лучше всего создать подпрограм­
му Sub, которую можно вызывать из обработчика события Cl ick  эле­
мента меню и кнопки, это позволит избежать дублирования кода.

1. В окне конструктора форм щелкните мышью по элементу меню 
Файл => Создать (File => New), чтобы выбрать пункт меню Создать 
(New).

2. Дважды щелкните по элементу меню Создать (New), чтобы открыть 
редактор кода, и введите в следующий вызов в обработчик события 
данного элемента меню:
NewFile()

3. Сразу после инструкции End Sub обработчика события пункта 
меню Создать (New) введите код следующей подпрограммы:
Private Sub NewFile ()
RichTextBoxl Text = ""
ToolStripStatusLabell Text = "Готов"
End Sub

4. Вернитесь в окно конструктора форм, дважды щелкните мышью 
по кнопке Создать (New) на панели инструментов, чтобы открыть 
редактор кода. Введите следующий вызов пользовательской подпро­
граммы в обработчик события данной кнопки:
NewFile()

5. Добавьте компоненты OpenFileDialog и SaveFileDialog 
из раздела Диалоговые окна (Dialogs) панели элементов.

6. В обработчике события Click пункта меню Открыть (Open) и кноп­
ки панели инструментов Открыть (Open) введите следующий код:
OpenFile ()



7. Сразу после инструкции End Sub обработчика события пункта 
меню Открыть (Open) введите код следующей подпрограммы:
Private Sub OpenFile()
OpenFileDialogl Filter = "Текстовый документ | * txt"
IfOpenFileDialogl ShowDialog=

Windows Forms DialogResult OK Then
RichTextBoxl.LoadFile(OpenFileDialogl FileName,_ 

RichTextBoxStreamType PlainText)
End If
End Sub

8. В обработчике события Click  пункта меню Сохранить (Save) 
и кнопки панели инструментов Сохранить (Save) введите следую­
щий код:
SaveFile()

9. Сразу после инструкции End Sub обработчика события пункта 
меню Сохранить (Save) введите код следующей подпрограммы:
Private Sub SaveFile()
SaveFileDialogl Filter= "Текстовый документ | * txt"
If SaveFileDialogl.ShowDialog =_

Windows Forms DialogResult.OK Then
RichTextBoxl SaveFile(SaveFileDialogl.FileName,_ 

RichTextBoxStreamType.PlainText)
End If
End Sub

10. Запустите приложение и протестируйте работу пунктов меню 
и кнопок панели инструментов: Создать (New), Открыть (Open) 
и Сохранить (Save).

Вы можете добавить функ­
циональность элементу 
меню Файл => Выход (File => 
Exit), добавив выражение 
Application.Exit()  
в обработчик события дан­
ного пункта меню.
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Добавление 
дополнительных форм
Большинство приложений Windows состоят из нескольких форм: даже 
в самых простых приложениях, как правило, есть диалоговое окно 
О программе и, к примеру, заставка, содержащие информацию о номе­
ре версии программного обеспечения. Обе эти функции запросто могут 
быть добавлены в ваше приложение на языке Visual Basic.

1. Откройте диалоговое окно Добавить новый элемент (Add New 
Item) воспользовавшись командой меню Проект => Добавить но­
вый элемент (Project => Add New Item). В открывшемся диалоговом 
окне выберите пункт Окно "О программе" (About Box), нажми­
те кнопку Добавить (Add) — и убедитесь в том, что новая форма 
с именем AboutBoxl.vb добавлена на панель Обозреватель реше­
ний (Solution Explorer).

2. На панели Обозреватель
решений (Solution Explorer) 
щелкните правой кнопкой мыши 
по верхнему значку проекта 
и из открывшегося контекстного 
меню выберите пункт Свойства 
(Properties) или выберите коман­
ду меню Проект => Свойства 
(Project => Properties), чтобы 
открыть панель проекта.

3. На вкладке Приложение (Applica­
tion) открывшейся панели щелк­
ните мышью по кнопке Сведения 
о сборке (Assembly Information)
и измените информацию об автор­
ских правах, компании и описание 
приложения по своему желанию 
и нажмите кнопку ОК.

4. В окне конструктора форм дважды щелкните мышью по подпункту 
О программе меню Справка и введите следующий код в обработ­
чик события Click  данного элемента меню:
AboutBoxl ShowDialog()

. Щелкните мышью по кнопке Запуск (Start) или нажмите клавишу F5, 
чтобы запустить приложение, после чего выберите команду меню 
Справка => О программе.

Описательная информация, 
редактируемая в диалого­
вом окне Сведения о сбор­
ке (Assembly Information), 
появится в диалоговом окне 
О программе (About).

Если панель Обозреватель
решений (Solution Explorer) 
закрыта, откройте ее, вос­
пользовавшись командой 
меню Вид => Обозреватель 
решений (View => Solution 
Explorer) или нажмите соче­
тание клавиш Ctrl+Alt+L.



Добавление заставки

1. Выберите команду меню Проект => Добавить новый элемент
(Project => Add New Item). В открывшемся диалоговом окне выберите 
пункт Заставка (Splash Screen), нажмите кнопку Добавить (Add) 
и убедитесь в том, что новая форма с именем SplashScreenl.vb 
добавлена на панель Обозреватель решений (Solution Explorer).

2. На панели Обозреватель решений (Solution Explorer) щелкните 
правой кнопкой мыши по верхнему значку проекта и из открывше­
гося контекстного меню выберите пункт Свойства (Properties) или 
выберите команду меню Проект => Свойства (Project => Properties), 
чтобы открыть панель проекта.

3. На открывшейся панели в раскрывающемся списке Экран-заставка 
(Splash Screen) выберите элемент SplashScreenl.

4. Щелкните мышью по кнопке Запуск (Start) или нажмите клавишу 
F5, чтобы запустить приложение, и убедитесь, что примерно за две 
секунды до открытия основной формы на экране появится заставка.
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Управление множеством 
форм
Иногда для размещения всех возможностей пользовательского интер­
фейса приложения требуется несколько форм. Когда пользователь пе­
реходит ко второй форме, первая может быть скрыта, а все ее данные 
сохранены в памяти с тем, чтобы программа могла вновь отобразить 
эту форму, когда пользователь вернется к ней. Аналогично, вторая фор­
ма может быть скрыта, таким образом, все данные, введенные поль­
зователем, остаются в программе, когда пользователь возвращается 
к первой форме. Кроме того, вторая форма также может быть закрыта, 
когда пользователь возвращается к первой форме, но все введенные 
данные будут потеряны, если они не были сохранены в переменных.

1. Добавьте в форму два эле­
мента управления Button 
и расположите их, как пока­
зано на рисунке. Присвойте 
элементу управления Label 
имя ValueLbl.

2.    Выберите команду меню Проект => Добавить новый элемент
(Project => Add New Item) и добавьте в проект новую форму Windows.

3. Добавьте на новую форму 
два элемента управления 
Button и один элемент 
управления TextBox. 
Элементам управления 
Button присвойте имена 
CloseBtn и HideBtn, 
соответственно.

4. В окне конструктора форм дважды щелкните мышью по кнопке 
Скрыть форму 1 на форме № 1 и введите в обработчик события 
Click следующий код:
Me Hide()
Form2 Show()

5. Теперь дважды щелкните мышью по кнопке Отобразить значение 
на форме № 1 и введите в обработчик события Click следующую 
инструкцию:
ValueLbl Text = Form2 TextBoxl Text

Подумайте о добавлении 
дополнительных форм, если 
интерфейс приложения 
начинает казаться перепол­
ненным элементами управ­
ления.



6. В окне конструктора форм дважды щелкните мышью по кнопке 
Скрыть форму 2 на форме № 2 и введите в обработчик события 
Click следующий код:
Me Hide()
Forml Show()

7 В окне конструктора форм дважды щелкните мышью по кнопке 
Закрыть форму 1 на форме № 2 и введите в обработчик события 
Click следующий код:
Me Close()
Forml Show()

8. Щелкните мышью по кнопке Запуск (Start) или нажмите клавишу 
F5, чтобы запустить приложение, затем щелкните мышью по кнопке 
Скрыть форму 1 форма № 1 пропадет с экрана, при этом на экран 
будет выведена форма № 2.

9. Введите любой текст в поле, 
затем щелкните мышью
по кнопке Скрыть форму 2 — 
форма № 2 исчезнет с экра­
на, при этом на экран будет 
выведена форма № 1.

10. На форме № 1 щелкните мы­
шью по кнопке Отобразить 
значение — и программа 
скопирует текст, введенный 
вами в элемент управле­
ния TextBox на форме
№ 2, в элемент управления 
ValueLbl на форме № 1.

11. Еще раз щелкните мышью по кнопке Скрыть форму 1 и попробуйте 
ввести другой текст в управления TextBox на форме № 2, а затем 
нажмите кнопку Скрыть форму 2.

12. Еще раз нажмите кнопку Отобразить значение: на этот раз на эле­
менте управления ValueLbl никакой текст отображен не будет, так 
как все введенные вами данные были потеряны.

Создайте переменную, 
которая хранила бы значе­
ние, введенное пользовате­
лем в элемент управления 
TextBox для того, чтобы 
у программы была возмож­
ность обратиться к этим дан­
ным при закрытии формы № 2.
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Звуковые файлы, как и графические, могут быть включены в приложе­
ние в качестве ресурсов, для улучшения функциональности приложе­
ния. При необходимости звуковые файлы могут проигрываться на ло­
кальном компьютере через вызов программы Windows Media Player.

1. Создайте новый проект Windows Application и добавьте в форму 
единственный элемент управления Button.

2. На панели Обозрева­
тель решений (Solution 
Explorer) щелкните 
правой кнопкой мыши 
по верхнему значку 
проекта, затем в от­
крывшемся контекстном 
меню выберите пункт 
Свойства (Properties), 
чтобы открыть панель 
проекта.

3. На панели проекта 
перейдите на вкладку 
Ресурсы (Resources), 
затем выберите элемент 
Звук (Audio) из раскры­
вающегося списка.

4. В раскрывающемся спис­
ке Добавить ресурс (Add 
Resource) выберите коман­
ду Добавить существую­
щий файл (Add Existing 
File), чтобы открыть одно­
именное диалоговое окно.

Вы можете загрузить в про­
ект ресурс и использовать 
его в качестве значка прило­
жения. Для этого присвойте 
данный ресурс свойству 
Icon формы.

Для удаления ресурса 
всегда пользуйтесь панелью 
проекта, удаление ресурса 
через панель Обозреватель 
решений (Solution Explorer) 
невозможно.



5. Перейдите к месту расположения звукового файла, который необ­
ходимо добавить, и нажмите кнопку Открыть (Add). Выбранный 
файл (в нашем случае, tada.wav) будет добавлен в каталог Ресурсы 
(Resources) на панели Обозреватель решений (Solution Explorer).

6. Нажмите кнопку х, чтобы закрыть панель проекта. Если IDE запро­
сит сохранение изменений, щелкните мышью по кнопке Да (Yes).

7 Выберите команду меню Вид => Код (View => Code) или нажмите 
сочетание клавиш F7, чтобы открыть редактор кода, и в раздел объ­
явлений введите следующий код:
Friend WithEvents player As New System.Media.
SoundPlayer

8. В окне конструктора форм дважды щелкните мышью по кнопке, 
затем введите следующий программный код в обработчик события
Click:
player Stream=Му Resources tada 
player PlayO

9. Щелкните мышью по кнопке Запуск (Start) или нажмите клавишу 
F5, чтобы запустить приложение, а затем щелкните мышью по кноп­
ке, чтобы проиграть звуковой файл.

Как правило, стандартные 
звуки Windows можно найти 
в папке C:\Windows\Media.

С помощью метода 
PlayLooping() можно 
задать повторное воспро­
изведение звукового файла, 
а метод Stop () позволяет 
прекратить воспроизведе­
ние.
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Воспроизведение
мультимедиа
Приложения на языке Visual Basic могут использовать элемент ActiveX 
программы Windows Media Player для проигрывания всех типов локаль­
ных мультимедийных файлов в собственном программном интерфейсе.

1. Создайте новый проект и добавьте в форму элемент управления 
Button, а также диалоговое окно OpenFileDialog.

2. На панели элементов щелкните правой кнопкой мыши по заголовку 
раздела Компоненты (Components) и выберите пункт Выбрать эле­
менты (Choose Items) в контекстном меню.

3. Когда на экране появится диалоговое окно Выбор элементов пане­
ли элементов (Choose Toolbox Items), перейдите на вкладку Ком­
поненты COM (COM Components). Установите флажок Windows 
Media Player, затем щелкните мышью по кнопке ОК.

4. Добавьте в форму компонент Windows Media Player из па­
нели элементов и измените его размер так, чтобы дисплей и эле­
менты управления данного компонента были полностью видны

Технология COM (Component 
Object Model — Объектная 
модель компонентов) пред­
ставляет собой стандартную 
платформу, позволяющую 
совместно использовать 
компоненты.



на форме. Обратите внимание, что компоненту было присвоено имя
AxWindowsMediaPlayerl.

Обратите внимание, что 
расширения разных фор­
матов файлов в инструкции 
Filter должны быть разде­
лены точкой с запятой.

Добавьте в приложение 
строку состояния для ото­
бражения имени воспроиз­
водимого в текущий момент 
времени файла.

6. Запустите приложение и щелкните мышью по элементу управления 
Button, чтобы открыть диалоговое окно OpenFileDialog и вы­
брать подходящий мультимедийный файл, — программа начнет 
воспроизведение этого файла в собственном интерфейсе.

IfOpenFileDialogl ShowDialog=_
Windows Forms.DialogResult OK Then 

AxWindowsMediaPlayerl URL = _
OpenFileDialogl FileName

End If

5. В окне конструктора форм дважды щелкните мышью по элементу 
управления Button, чтобы открыть редактор кода и ввести следую­
щий код в обработчик события Click:
With OpenFileDialogl

Title= "Media File Browser"
.Filter= "Файлымультимедиа (* wmv; * mp3) 
* wmv, *.mp3"
FileName = ""
CheckFileExists = True 

End With



Заключение
• Раздел Диалоговые окна (Dialogs) панели элементов содержит ком­

поненты, добавляемые в приложение и вызывающие стандартные 
диалоговые окна операционной системы Windows для выбора цве­
та, шрифта, изображений и файлов.

• Диалоговые окна открытия и сохранения файлов могут быть на­
строены для фильтрации типов файлов с тем, чтобы отображать 
только файлы с заданным расширением.

• Диалоговое окно Печать (Print) позволяет пользователю выбрать 
принтер, но само окно не может автоматически распечатывать файлы.

• Знакомые всем пункты меню могут запросто быть добавлены в при­
ложение с помощью команды Вставить стандартные элементы
(Insert Standard Items) элемента управления MeriuStrip.

• Компонент ToolStrip предоставляет стандартные значки панели 
инструментов.

• Вы можете добавить в приложение компонент StatusBar, позво­
ляющий вывести на экран статус приложения.

• Если в приложении присутствуют оба компонента, MenuStrip 
и ToolStrip, лучше всего создавать подпрограммы, позволяющие 
пользователю выбирать, следует ли использовать элементы меню 
или соответствующие значки панели инструментов.

• Компонент MenuStrip автоматически предоставляет клавиатур­
ные сокращения для всех пунктов меню.

• Команда Добавить новый элемент (Add New Item) на панели проек­
та может быть использована для добавления в проект новой формы, 
диалогового окна «О программе» или заставки.

• Вы можете управлять отображением нескольких форм приложения 
при помощи методов Show (), Hide () и Close ()

• Приложения могут быть усовершенствованы путем добавления 
аудиофайлов в каталог Ресурсы (Resources) и предоставления воз­
можности воспроизводить звуки.

• Компоненты Windows СОМ могут быть добавлены в раздел Ком­
поненты (Components) панели Панель элементов (Toolbox) среды 
разработки Visual Studio.

• Элемент ActiveX программы Windows Media Player может быть до­
бавлен в приложение для предоставления возможности воспроиз­
водить различные мультимедийные файлы.



Создание сценариев 
Visual Basic

В этой главе мы 
пpooe.MOHcmpt 1руем, как 

язык Visual Basic может 
быть использован вне 

интегрированной среды 
разработки Visual 

Studio для создания 
дополнительных функций 

приложений Microsoft 
Office. Кроме того, 

вы научитесь писать 
простые сценарии Visual 

Basic и взаимодействовать 
с пользователем.

• Введение в макросы VBA

• Создание макросов Word

• Создание макросов Excel

• Запуск сложных макросов

• Объявление переменных

• Проверка ввода

• Слияние текстовых файлов

• Извлечение данных из реестра

• Заключение
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Visual Basic for Applications (VBA) — это встроенный язык програм­
мирования приложений Microsoft Office. VBA реализован на том же 
языковом ядре, что и язык Visual Basic в IDE, однако для каждого 
приложения в VBA предусмотрен собственный набор доступных для 
использования объектов, например в приложении Word это объект 
ActiveDocument, а в Excel — ActiveSheet.

Если на компьютере установлен пакет Microsoft Office, то все объекты 
Office доступны вне зависимости от версии языка Visual Basic, таким 
образом, вы можете запрограммировать функции Word через приложе­
ние Excel или через независимое приложение, созданное в Visual Studio.

В системе VBA вы встретите редактор форм и отладчик, очень похожие 
на соответствующие компоненты Visual Studio, но с более ограничен­
ным набором функций.

Большинство сочетаний 
клавиш VBA совпадают 
с сочетаниями Visual Studio, 
например, клавиша F5 запу­
скает выполнение програм­
мы и т. д.

Кнопка «Запуск» Окно свойств Окно проекта

Конструктор форм 

Панель элементов

Редактор кода

С помощью языка Visual Basic for Applications вы не сможете создать неза­
висимое выполняемое приложение, так как у данного языка нет машинно­
го компилятора кода, но вы подготовите сценарий, скрытый внутри фай­
ла документа и выполняющий ряд программных инструкций при работе 
с данным документом. Такой подход более известен как «макрос» и, как 
правило, применяется для автоматизации выполнения часто требующих­
ся задач, подразумевающих использование нескольких команд, например 
для вставки таблицы с требуемым стилем и количеством строк и столбцов.



1. Откройте программу 
Microsoft Word или любое 
другое приложение пакета 
Office, затем перейдите 
на вкладку Разработчик
(Developer) и щелкните мышью по кнопке 
Visual Basic, чтобы открыть редактор Visual Basic.

2. В окне редактора Visual Basic выберите команду меню Insert => 
Module (Вставить => Модуль), чтобы открыть окно редактора кода.

3. В окне редактора кода введите следующую подпрограмму Visual 
Basic:
Private Sub Hello ()

MsgBox("Привет от VBA!")
End Sub

Если вкладка Разработчик
(Developer) не отображается, 
перейдите на вкладку Файл 
(File), выберите команду 
меню Параметры (Options) 
и на вкладке Настроить 
ленту (Ribbon Options) уста­
новите флажок Разработчик 
(Developer).

В более ранних версиях 
Microsoft Office (до версии 
2003 включительно) редак­
тор Visual Basic можно запу­
стить, воспользовавшись 
командой меню Сервис => 
Макрос (Tools => Macros).

4. В окне редактора Visual Basic 
щелкните мышью по кнопке 
Run (Запуск) или нажмите 
клавишу F5, чтобы запустить 
выполнение подпрограммы. 
Окно редактора Visual Basic при 
этом автоматически свернется, 
до тех пор, пока вы не щелкнете 
мышью по кнопке ОК.
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В документ Word могут быть вставлены специальные закладки, отме­
чающие места, в которые макрос должен вставить какое-либо содер­
жимое.

1. Откройте новый документ Word, введите любой текст, а затем 
на вкладке Вставка (Insert) нажмите кнопку Закладка (Bookmark), 
чтобы добавить закладку. Назовите эту закладку маркер.

2. Перейдите на вкладку Разработчик (Developer) и нажмите кнопку 
Visual Basic или сочетание клавиш Alt+Fll, чтобы запустить редак­
тор Visual Basic.

3. В окне редактора Visual Basic выберите команду меню Insert => 
Module (Вставить => Модуль), чтобы открыть окно редактора кода.

4. В окно редактора кода введите следующий программный код:
Sub AddTable ()

If ActiveDocument Bookmarks Exists("маркер") Then 
ActiveDocument Bookmarks("маркер").Select 
Set tbl =ActiveDocument Tables Add(Range: =

_Selection.Range, NumRows:=3, NumColumns:=9) 
tbl AutoFormat Format:=wdTableFormatClassic2 
End If 

End Sub

Вы можете воспользоваться 
кнопкой Отменить (Undo) 
в окне программы Microsoft 
Word, чтобы отменить два 
шага, сделанные систе­
мой VBA для добавления 
и форматирования данной 
таблицы.



Если вы создали макрос, который желаете использовать и при работе 
с другими документами, то данный макрос может быть сохранен в ма­
стере шаблонов Microsoft Word в файле Normal, dotm и добавлен в каче­
стве элемента меню программы Word.

1. Перейдите на вкладку Разработчик 
(Developer) и нажмите кнопку Макро­
сы (Macros), чтобы открыть диало­
говое окно Макрос (Macros), а затем 
щелкните мышью по кнопке Органи­
затор (Organiser).

2. Перейдите на вкладку Макросы (Macro Project Items), выберите 
макрос из списка макросов текущего документа, затем щелкните 
по кнопке Копировать (Сору), чтобы скопировать данный макрос 
в файл Normal.dotm.

3. Закройте окно Организатор (Organiser) и текущий документ, затем со­
здайте новый документ и вставьте в него закладку с именем «маркер».

4. Щелкните правой кнопкой мыши по панели быстрого запуска про­
граммы Microsoft Word и выберите команду Настроить панель 
быстрого запуска (Customise Quick Access Toolbar), чтобы открыть 
диалоговое окно Параметры Word (Options Word).

5. В диалоговом окне Параметры Word (Options) выберите пункт 
Макросы (Macros) в раскрывающемся списке Выбрать коман­
ды из (Choose Commands From), затем добавьте модуль AddTable 
и щелкните мышью по кнопке ОК, чтобы добавить значок макроса 
на панель быстрого запуска.

6. Щелкните мышью по только что добавленному значку макроса 
AddTable, чтобы запустить макрос и еще раз вставить форматиро­
ванную таблицу в отмеченный участок документа.

Кнопка Выполнить (Run) 
диалогового окна Макрос 
(Macros) может быть исполь­
зована для запуска любого 
макроса, сохранного в файле 
Normal.dotm, без необхо­
димости создавать новый 
элемент меню.
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Значения могут быть вставлены в ячейки электронной таблицы
Microsoft Excel при помощи специального макроса, использующего
цикл для прохода по ячейкам заданного диапазона.

1. Откройте новую книгу Excel и воспользуйтесь кнопкой Visual 
Basic на вкладке Разработчик (Developer) или сочетанием клавиш 
Alt+Fll, чтобы открыть редактор Visual Basic.

2. В окне редактора Visual Basic выберите команду Insert => Module 
(Вставить => Модуль), чтобы открыть окно редактора кода.

3. В окно редактора кода введите следующий программный код:
Private Sub AddMonthNames()
Dim i As Integer 
i = 0
Do Until i = 12

Set currentCell= ActiveSheet Cells (_ 
ActiveCell.Row + i, ActiveCell.Column) 
i = i + 1
currentCell Font Bold=True 
currentCell Font Color=vbRed 
currentCell Value=MonthName(i)

Loop 
End Sub

4. Выделите любую ячейку электронной таблицы и щелкните мышью 
по кнопке Run (Запуск) или нажмите клавишу F5, чтобы запустить 
макрос, — в результате названия месяцев, напечатанные жирным 
шрифтом красного цвета, должны появиться в ячейках, следующих 
за выделенной по вертикали.

В языке VBA реализован 
лишь небольшой набор 
констант цвета, таких как 
vbRed, использованный 
нами в данном примере. 
Воспользуйтесь справкой 
по языку VBA, чтобы узнать 
имена всех доступных кон­
стант.



Макросы Microsoft Excel могут запускаться автоматически при загрузке 
книги или вручную с помощью соответствующего клавиатурного со­
кращения или по щелчку мышью по специально созданному элементу 
управления Button.

1. В окне проекта щелкните пра­
вой кнопкой мыши по пункту 
ЭтаКнига (ThisWorkbook) 
и в открывшемся контекстном 
меню выберите пункт View 
Code (Просмотр кода).

2. Из раскрывающегося списка в верхней части окна редактора кода 
выберите пункт Workbook и введите следующий программный код:
Private Sub Workbook_Open ()
MsgBox ("Книга открыта в " + Str (Time) )
End Sub

3. Закройте редактор Visual Basic, затем щелкните мышью по кноп­
ке Макросы (Macros) и в появившемся диалоговом окне нажмите 
кнопку Параметры (Options), чтобы добавить клавиатурное сокра­
щение вида Ctrl+ к макросу.

4. На вкладке Разработчик (Developer) в раскрывающемся списке 
Вставить (Insert) выберите элемент управления Button (Кнопка) 
из раздела Элементы ActiveX (ActiveX Elements).

5. Дважды щелкните мышью по элементу управления Button, чтобы 
открыть редактор кода и обработчик события Click  данного эле­
мента управления, а затем введите следующую инструкцию, осуще­
ствляющую вызов функции:
Call AddMonthName () .

6. Сохраните изменения и закройте книгу. Повторно откройте кни­
гу — и на экране появится сообщение MsgBox. Щелкните мышью 
по элементу управления Button, чтобы запустить макрос.

При необходимости отре­
дактировать или переме­
стить элементы управления 
в открытой электронной 
таблице, воспользуйтесь 
кнопкой Режим конструк­
тора (Design Mode) на вклад­
ке Разработчик (Developer).
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Вы также можете создавать более сложные макросы, позволяющие 
управлять одним приложением Microsoft Office из другого. Зачастую 
может потребоваться включить информацию из электронной таблицы 
Excel в документ Word. Использование макросов позволит автоматизи­
ровать процесс получения данных.

1. Откройте программу Excel и введите какие-нибудь данные в ячейку 
В2. Назовите эту ячейку Итого, затем сохраните электронную таб­
лицу с именем Sales.xlsx в папке Документы и закройте Excel.

2. Создайте новый документ Word, затем вставьте закладку также 
с именем Итого. Имя закладки не обязательно должно совпадать 
с именем ячейки Excel, однако так удобнее.

3. Откройте редактор Visual Basic, а затем выберите команду меню 
Tools => References (Инструменты => Ссылки), чтобы открыть диа­
логовое окно References (Ссылки). Убедитесь, что флажок Microsoft 
Excel Object Library установлен, и закройте диалоговое окно.

Номер версии библиотеки 
объектов Excel будет варь­
ироваться в зависимости 
оттого, какую версию пакета 
Microsoft Office вы исполь­
зуете.



4. В редакторе Visual Basic выберите команду меню Insert => Module 
(Вставить => Модуль), чтобы открыть окно редактора кода.

5. Теперь введите следующий программный код в окно редактора кода, 
изменив путь к файлу Sales.xlsx в соответствии с гем, где данный 
файл сохранен на вашем компьютере:
Private Sub GetTotal ()
Set xl = CreateObject("Excel.Application") 
xl.Workbooks Open ("D:\Sales xlsx") 
xl Worksheets("Sheetl") Activate 
ActiveDocument Bookmarks("Total") Select

Dim sum As String 
sum = FormatCurrency(_

xl.ActiveSheet.Range("Итого").Value, 0)
Selection.InsertAfter (sum) 
xl Workbooks.Close 
Set xl = Nothing 
End Sub

6. Щелкните мышью по кнопке Run (Запуск) или нажмите клавишу 
F5, чтобы запустить макрос. Значение, полученное из ячейки Excel, 
будет отформатировано в соответствии с настройками местной ва­
люты и появится в документе Word.

Обратиться к именован­
ной ячейке из данного 
примера можно так же,
как xl.ActiveSheet 
Cells ( 2 , 2 )  строка 2 ,  
столбца 2.

Не забывайте добавлять 
в код макроса инструкцию, 
закрывающую книгу и осво­
бождающую программу 
Excel после получения необ­
ходимого значения.
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Рекомендуется начинать все сценарии Visual Basic с оператора Option 
Explicit. Он указывается в начале сценария и требует явного объяв­
ления всех переменных с помощью инструкции Dim, прежде чем они 
могут быть использованы. Без этого оператора код сценария может не­
явно создавать переменные путем присвоения имени переменной, ука­
зываемого пользователем. Хотя это может показаться и нормальным, 
такое поведение приводит к непредвиденным ошибкам, сложным для 
отладки. Добавление оператора Option Explicit в начале сценария обес­
печивает проверку на наличие ошибок для их избегания. Рассмотрим 
простой пример.

1. Напишите код сценария, в котором строка текста присваивается 
неявной переменной, позволяя отобразить диалоговое окно с сооб­
щением.
ЬооkTitlе="Программирование на Visual Basic для 
начинающих"
MsgBox bookTile, vblnformation, "Сообщение"

Explicit.vbs

2. Запустите сценарий, чтобы увидеть, что строка не появляется, так 
как имя переменной во второй строке содержит опечатку — компи­
лятор считает, что это просто еще одна неявная переменная, поэто­
му нет никаких предупреждений.

3. Измените код сценария, добавив указанные ниже строки в самом 
его начале, для правильного объявления переменной.
Option Explicit 
DimbookTitle



4. Выполните сценарий еще раз. Вы увидите ошибку компиляции из-за 
того, что допущена опечатка в имени переменной.

5. Исправьте опечатку и вновь запустите сценарий.
Рекомендуется начинать все 
сценарии Visual Basic с опе­
ратора Option Explicit.
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Остальная часть этой главы посвящена трем сценариям, которые об­
рабатывают пользовательский ввод, текстовые файлы и данные из ре­
естра Windows.

Сценарии Visual Basic позволяют запрашивать пользовательские дан­
ные через диалоговые окна с полями ввода. Поступающие данные при­
сваиваются в виде текстовой строки переменной и могут быть провере­
ны на соблюдение определенных требований, например использование 
только букв и пробелов. В этом примере мы как раз рассмотрим такой 
случай.

GetName.vbs

1. Начните сценарий Visual Basic со стандартной директивы компиля­
тора, а затем объявите переменную для хранения входных данных 
и переменную для хранения выражения, относящегося к проверке 
вводимых данных.
Option Explicit
Dim паше, regX

2. Добавьте блок функции, присваивающий ввод в качестве имени пе­
ременной и включающий заполнитель для проверяющих выраже­
ний.
Private Function GetName ()
name = InputBox ("Как тебя зовут?" , "Вопрос")
'Сюда помещаются операторыIf-Else
End Function

3. Ниже добавьте код, позволяющий завершить сценарий, если поль­
зователь нажимает кнопку «Отмена».
If VarType (name) =vbEmptyThen
Exit Function

4. Далее вставьте код, обнаруживающий отсутствие ввода и отобра­
жающий сообщение, что пользователь ничего не ввел. В этом случае 
вновь открывается диалоговое окно ввода для корректного указа­
ния имени.
Elseif name = "" Then
MsgBox "Ты же ничего не написал: (", vblnformation,

"Ошибка"
Call GetName

Функция VarType () 
возвращает целое число, 
определяющее тип данных 
переменной. Если пере­
менная неинициализиро­
ванная (например, если 
пользователь нажал кнопку 
«Отмена»), возвращается 
ноль — аналогично констан­
те vbEmpty.



5. Далее вставьте код, обнаруживающий ввод недопустимых символов 
и отображающий сообщение об ошибке. Затем вновь открывается 
диалоговое окно ввода для корректного указания имени.
Elseif InvalidO Then
MsgBox "Приветствуются только русские буквы 

и пробелы!", vbCritical, "Ошибка"
Call GetName

6. В завершение вставьте код для отображения сообщения об успеш­
ном вводе имени.
Else
MsgBox"Привет, " & name &" ! vbExclamation,

"Сообщение"
End If

7. Добавьте вторую функцию, выполняющую проверку вводимых 
символов на основе регулярного выражения.
Private Function Invalid ()
Set regX = New RegExp 
regX Pattern = "[ ^А-Я a-я] "
Invalid=regX Test(Name)
End Function

8. В конце сценария добавьте код вызова первой функции, запраши­
вающей пользовательский ввод.
Call GetName 

9. Запустите сценарий и проверьте его выполнение.

Объект RegExp содержит 
свойство Pattern, опреде­
ляющее допустимые симво­
лы, и метод Test (), сравни­
вающий указанное значение 
с шаблоном.

Более подробную инфор­
мацию о регулярных выра­
жениях вы можете получить 
на сайте
regular-expressions.info.
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В предыдущем примере мы использовали объект RegExp, который 
поддерживает специальные свойства и методы для обработки регу­
лярных выражений. Теперь мы рассмотрим объект под названием 
Scripting. FileSystemOb j ect, который поддерживает специаль­
ные свойства и методы для обработки файловой системы компьютера.

После того, как вы создали экземпляр объекта FileSystemOb j ect, 
вы сможете открывать в файловой системе папки и файлы для чтения 
и записи. В частности, вы сможете копировать текст из нескольких ис­
ходных файлов в один новый файл.

FileMerge.vbs

1. Создайте папку с именем Textfiles на рабочем столе и поместите в нее 
несколько простых текстовых файлов с каким-либо содержимым.

2. Создайте сценарий Visual Basic, начав его код со стандартной дирек­
тивы компилятора, а затем объявите пять переменных для управле­
ния текстовыми файлами.
Option Explicit
Dimfso, folder, textOut, file, textln



Обратите внимание, что 
в данном примере в методе 
GetFolderO указаны 
и имя, и путь к папке. Если 
используются папки с разны­
ми именами или они нахо­
дятся в разных расположе­
ниях, вы можете указать это 
в операторе Set folder.

Числовое значение, 
указанное в методе
OpenTextFile (), опреде­
ляет режим ввода/вывода. 
Значение 1 определяет 
режим ForReading, 
а значение 8 — режим 
ForAppending.

Сценарий должен быть 
расположен в одном катало­
ге с папкой Textfiles, или же 
измените код оператора Set
folder.

3. Добавьте код для создания экземпляра объекта FileSystemOb j ect.
Set fso = CreateObject("Scripting FileSystemObject")

4. Далее добавьте код для получения списка имен всех файлов, находя­
щихся внутри папки Textfiles.
Set folder = fso.GetFolder(".\Textfiles").Files

5. Теперь добавьте код для создания нового текстового файла, в ко­
торый будет скопировано содержимое всех файлов, находящихся 
внутри папки Textfiles.
Set textOut = fso CreateTextFile("Merged.txt")

6. Добавьте цикл, открывающий и закрывающий каждый файл вну­
три папки и включающий заполнитель для размещения операторов
read/write.
For Each file In folder

Set textln = fso OpenTextFile(file, 1) 
textln Close
' Сюда помещаются операторы Read/write

Next

7. Ниже заполнителя добавьте код для записи имени и содержимого 
каждого файла и разделителей в виде пустой строки.
textOut WriteLine "Файл: "&file Name
textOut WriteLine textln ReadAll
textOut WriteLine vbCr

8. В конце сценария, после цикла, добавьте код для закрытия нового 
файла после завершения записи в него имен и контента всех файлов.
textOut Close

9. Сохраните сценарий на рабочем столе, рядом с папкой Textfiles, за­
тем запустите его. Откройте появившийся файл после завершения 
работы сценария.
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Операционная система Windows поддерживает объект WScript 
Shell, который предоставляет специальные свойства и методы для 
обработки переменных окружения, ярлыков и элементов системного 
реестра. К примеру, вы можете использовать эти методы и свойства, 
чтобы узнать номер версии, идентификатор и ключ продукта опера­
ционной системы Windows. Ключ хранится в зашифрованном виде, 
но может быть расшифрован с помощью VBScript.

Winlnfo.vbs

1. Создайте сценарий Visual Basic, начав его код со стандартной дирек­
тивы компилятора, а затем объявите пять переменных для управле­
ния данными системного реестра.
Option Explicit 
Dimwss, dir, sys, pid, bin

2. Добавьте код для создания экземпляра объекта Shell.
Set wss = CreateObject("WScript.Shell")

3. Теперь инициализируем четыре оставшихся переменных, указав ад­
рес в реестре и значения, которые необходимо считать.
dir ="HKLM\SOFTWARE\Microsoft\Windows NT\ 

CurrentVersionV'
sys = "Версия: " & wss RegRead(dir &"ProductName")

& vbCr
pid="ID: " &wss RegRead(dir &"ProductID") &vbCr 
bin = wss RegRead(dir &"DigitalProductld")

4. Добавьте код для отображения информации о Windows.
MsgBox sys & pid & "Ключ: " & Decrypt (bin) , 

vblnformation, "Winlnfo"

5. Добавьте блок функции, который извлекает зашифрованный ключ 
операционной системы из реестра, тот, который должен быть рас­
шифрован.
Private Function Decrypt (bin)
' Сюда помещаются операторы 
End Function



Необдуманное изменение 
значений в системном 
реестре Windows может 
привести к сбоям в работе 
компьютера. Описываемый 
сценарий только считывает 
существующие значения 
из реестра без внесения 
в него изменений.

Этот пример сценария де­
монстрирует мощь VBScript.

В операционной системе 
Windows 8/10 данный сце­
нарий может быть полезен, 
если наклейка с ключом 
утеряна, а сам он зашифро­
ван в реестре. Этот сценарий 
поможет узнать ключ.

6.  В блоке функции объявите 10 переменных, а затем инициализируй­
те три из них, как показан ниже:
Dim win, map, i, j, cut, seq, fin, top, add, key 
win = (bin (66) \ 6) And 1
bin (66) = (bin (66) And &HF7) Or ( (winAnd2) * 4) 
map = "BCDFGHJKMPQRTVWXY2346789"

7.   Добавьте следующие вложенные циклы, чтобы интерпретировать 
зашифрованный ключ.
i = 24 
Do

cut = 0 
j = 14 
Do

cut = cut * 256 
cut = bin (j +52) + cut 
bin(j + 52) = (cut \ 24) 
cut = cut Mod 24
j= j-1

Loop Until j < 0 
i =1-1
seq = Mid (map, cut + 1, 1) & seq 
fin = cut

Loop Until i < 0

8. Теперь добавьте следующий код, чтобы выполнить замены символов.
top = Mid (seq, 2, fin) 
add ="N”
seq = Replace (seq, top, top & add, 2, 1, 0)
If fin = 0 Then seq = add & seq

9. Добавьте финальный код для форматирования и возврата расши­
фрованного ключа вызывающей функции для отображения.
key = ""
For i = 1 То 25

key = key + Mid (seq, i, 1)
If (i Mod 5 = 0) And (i < 25) Then 

key = key + "-"
End If 

Next
Decrypt = key

10. Запустите сценарий и про­
верьте, отображается ли 
версия, идентификатор 
и ключ операционной систе­
мы Windows, установленной 
на компьютере.



Заключение
• Язык Visual Basic for Applications (VBA) встроен во все приложения 

Microsoft Office, однако для каждого из этих приложений предусмо­
трены уникальные объекты.

• Среда VBA очень похожа на IDE Visual Studio, однако с ее помощью 
невозможно создать независимое приложение.

• Макрос может вставить в обозначенный закладкой участок доку­
мента Word необходимые данные.

• Сохранение макросов в основном шаблоне макросов Normal.dotm 
делает их доступными для использования при работе с другими до­
кументами Word.

• Циклы могут использоваться в макросах VBA для чтения и записи 
данных в указанном диапазоне ячеек электронной таблицы Excel.

• Более сложные макросы позволяют одному приложению Office кон­
тролировать другое.

• Нет необходимости в установке специальной среды разработки для 
VBScript — сценарии создаются в любом текстовом редакторе, на­
пример Notepad++.

• Интерпретатор инструкций VBScript может быть вызван из графи­
ческого интерфейса Windows или оболочки командной строки.

• Все сценарии Visual Basic должны начинаться с оператора Option 
Explicit для правильного объявления переменных перед их ис­
пользованием.

• Функция VarType (), проверяющая тип данных переменной, вер­
нет значение vbEmpty, если переменная не инициализирована.

• Объект RegExp имеет свойство Pattern и метод Test () для 
сравнения регулярных выражений, например для проверки вводи­
мых данных.

• Объект Scripting. FileSystemObj ect поддерживает свой­
ства и методы для чтения и записи текстовых файлов в операцион­
ной системе.

• В методе OpenTextFile () необходимо указать режим обработки 
файлов, ForReading или ForAppending.

• Объект WScript. Shell поддерживает свойства и методы для об­
работки переменных окружения, ярлыков и значений системного 
реестра.



Работа
сданными

В этой главе мы покажем 
вам, как приложения, 
написанные на языке 

Visual Basie, могут 
импортировать данные 

из различных внешних 
источников.

• Чтение текстовых файлов

• Потоковое чтение строк текста

• Чтение электронных таблиц Excel

• Чтение файлов XML

• Создание набора данных XML

• Заключение
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У объекта Му. Computer.FileSystem есть специальные мето­
ды, упрощающие работу приложений на языке Visual Basic с ло­
кальными файлами. Текст может быть импортирован с помощью 
метода ReadAllText () и экспортирован — с помощью метода 
WriteAllText (), позволяющего вставить текст в существующий 
файл или создать новый. Файлы могут быть удалены с помощью метода 
DeleteFile (), тогда как метод FileExists () позволяет подтвер­
дить наличие нужного файла на диске.

1. Создайте новый проект Windows Forms Application и добавьте 
в форму два элемента управления TextBox и три Button.

2. Присвойте свойству Multiline элемента управления TextBox2 
значение True, а затем присвойте элементам управления Button 
следующие имена: WriteBtn, ReadBtn и DeleteBtn.

3. Нажмите сочетание клавиш F7, чтобы открыть редактор кода, 
и в разделе объявлений создайте переменную, хранящую путь 
к файлу, изменив путь в соответствии с местонахождением папки 
Документы на вашем компьютере
DimmyFile As String = "C:\Users\Mike\Documents\log.txt"

4. Дважды щелкните мышью по кнопке WriteBtn, чтобы открыть ре­
дактор кода, и введите следующий программный код в обработчик 
события данного элемента управления:
Му Computer.FileSystem.WriteAllText(_ 

myFile, TextBoxl.Text &vbCrLf, True)
TextBoxl.Text = ""

5. Вернитесь к конструктору форм, дважды щелкните мышью по кноп­
ке ReadBtn и введите следующий программный код в обработчик 
события данного элемента управления:
Try
TextBox2.Text = _
Му.Computer.FileSystem ReadAllText(myFile)
Catch ex As Exception
TextBox2.Text = "Невозможно прочитать текст из файла " &
myFile
End Try

При установке компилято­
ра устанавливаются также 
стандартные заголовочные 
файлы (указанные на преды­
дущей странице).



6. Вернитесь к конструктору форм, дважды щелкните мышью по кноп­
ке DeleteBtn и введите следующий программный код в обработ­
чик события данного элемента управления:
TextBoxl Text = ""
TextBox2 Text = ""
If My Computer FileSystem FileExists(myFile) Then 
My Computer FileSystem DeleteFile(myFile)
End If

7. Щелкните мышью по кнопке Запуск (Start) или нажмите клави­
шу F5, чтобы запустить приложение. Введите какой-нибудь текст 
в верхнее текстовое поле TextBox.

8. Щелкните мышью по кнопке WriteBtn, чтобы записать введенный 
текст в файл. Обратите внимание, что верхнее текстовое поле очи­
стилось.

9. Щелкните мышью по кнопке ReadBtn, чтобы прочитать содержи­
мое файла и вывести текст в нижний элемент управления TextBox.

10. Повторите шаги 7 и 8, чтобы добавить еще строки в текст, затем 
щелкните мышью по кнопке DeleteFile, чтобы удалить файл log. 
txt и его содержимое.

Удалите файл log.txt, а затем 
щелкните мышью по кнопке 
ReadBtn, чтобы попытаться 
прочитать несуществующий 
файл — на экране появит­
ся сообщение об ошибке 
из блока Catch программ­
ного кода.

Убедитесь, что у приложения 
достаточно прав для внесе­
ния изменений в файл log.txt.



Потоковое чтение 
строк текста
Класс System.IO языка Visual Basic может быть использован для им­
портирования данных и файлов в приложение в виде «потока». Поток 
гораздо более гибкая сущность, чем файл, так как потоком можно ма­
нипулировать, а также выполнять поиск данных в потоке. Сначала 
поток создается в качестве нового экземпляра объекта System.IO. 
FileStream, для которого в качестве параметров указываются рабочий 
файл и выполняемая операция. Затем можно создать новый экземпляр 
объекта System.IO.StreamReader для чтения информации из от­
крытого файла. Операция чтения может быть осуществлена нескольки­
ми способами, например метод ReadToEnd () выполнит чтение файла 
до самого конца. По окончании работы с файлом важно освободить объ­
екты StreamReader и FileStream с помощью метода Dispose ()

1 Добавьте в форму компонент OpenFileDialog, элемент управ­
ления TextBox и два элемента управления Button с именами 
OpenBtn и PrintBtn.

2. Дважды щелкните мышью по кнопке OpenBtn, чтобы открыть ре­
дактор кода и введите следующую строку кода в раздел объявлений:
Dim txt As String

3. Теперь добавьте следующий программный код в обработчик собы­
тия Click элемента управления OpenBtn:
IfOpenFileDialogl ShowDialog=_

Windows Forms.DialogResult OK Then 
Dim stream As New System. IO.FileStream_
(OpenFileDialogl FileName, System 10 FileMode.Open) 
Dim reader As New System. I0 StreamReader (stream) 
txt = reader.ReadToEnd() 
reader Dispose (): stream Dispose()
TextBoxl Text = txt 
End If

4. Запустите приложение и щелкните мышью по кнопке OpenBtn, 
выберите текстовый файл на компьютере, который будет загружен 
в элемент управления TextBox.

Две инструкции могут нахо­
диться на одной строке, если 
их разделить двоеточием.
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Добавление возможности вывода на печать

1. Из раздела Печать (Printing) панели элементов добавьте в форму два 
компонента: PrintDialog и PrintDocument.

2. Дважды щелкните мышью по кнопке PrintBtn и введите следую­
щий программный код в обработчик события Click данного эле­
мента управления:
PrintDialogl AllowSomePages = True 
PrintDialogl.ShowHelp = True 
If PrintDialogl.ShowDialog = _

Windows Forms.DialogResult OK Then 
If txt <> "" Then 
PrintDocumentl.Print()
End If

End If

Данная подпрограмма настраивает диалоговое окно Печать (Print). 
Если переменная txt не пуста, то происходит вызов метода Print () 
компонента PrintDocumentl. Однако этого недостаточно для авто­
матической печати. Данный программный код лишь генерирует собы­
тие PrintPage, обработчик которого должен содержать программ­
ный код для вывода текста на печать.

3. Дважды щелкните мышью по значку компонента PrintDocument1 
в нижней части окна конструктора форм, чтобы открыть редактор 
кода. В обработчике события PrintPage введите следующий про­
граммный код:
е Graphics Drawstring(txt, Me Font, Brushes Black,_ 
e.MarginBounds, StringFormat.GenericTypographic)

В приведенном выше программном коде буква "е" используется 
в списке параметров обработчика события для представления объ­
екта PrintPageEventArgs, использующего метод Graphics. 
DeawString () для вывода текста на печать.

4. Щелкните мышью по кнопке Запуск (Start) или нажмите клави­
шу F5, чтобы запустить приложение. Воспользуйтесь кнопкой 
OpenBtn, чтобы выбрать текстовый файл, затем щелкните мышью 
по кнопке PrintBtn, чтобы отправить выбранный текстовый файл 
на принтер.

Компонент PrintDialog 
позволяет приложению 
запускать стандартное 
диалоговое окно Печать 
(Print) операционной 
системы Windows, но для 
печати необходимо так­
же добавить компонент 
PrintDocument.

Для того чтобы принтер мог 
обрабатывать несколько 
страниц, в обработчик собы­
тия PrintPage необходимо 
ввести дополнительный 
программный код.
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таблиц Excel
Данные, содержащиеся в электронной таблице Excel, могут быть импор­
тированы в приложение и сохранены в элементах двумерного массива, 
измерения которого представляют соответственно строки и столбцы. 
Это позволяет обратиться к каждой отдельной ячейке по тому же са­
мому номеру строки и столбца, как и в электронной таблице, например 
элемент cell ( 2 , 3 )  обращается к третьей ячейке на второй строке.

1. Создайте книгу Excel и присвойте файлу имя Data.xlsx. Введите 
значения, как показано на рисунке, и сохраните таблицу в папке 
Документы.

2. Создайте новое приложение Windows Forms и добавьте в форму три 
элемента управления ListBox, три Label и один элемент управ­
ления Button.

3. Щелкните мышью по команде Проект => Добавить ссылку (Project 
=> Add Reference), чтобы открыть диалоговое окно Добавить ссыл­
ку (Add Reference). На вкладке СОМ выберите элемент Microsoft 
Excel Object Library и нажмите кнопку OK.

Еще раз вернитесь к пре­
дыдущей главе, в которой 
приводится снимок диалого­
вого окна References (Связи) 
и сравните, насколько похож 
этот пример с примером 
на языке VBA.



4. Нажмите сочетание клавиш F7, чтобы открыть редактор кода, 
и в разделе объявлений создайте переменную, хранящую путь 
к файлу Data.xlsx:
DimmySS As String="С:\Users\Mike\Docuinents\Data.xlsx"

5. Дважды щелкните мышью по элементу управления Button, что­
бы открыть редактор кода, и введите следующий программный код 
в обработчик события данного элемента управления:
Dim row, col, finalRow, finalCol as Integer
Dim xl = CreateObject("Excel.Application")
xl Workbooks Open(mySS)
xl.Worksheets("Sheetl") Activate()
finalRow = xl.ActiveSheet.UsedRange.Rows Count
finalCol = xl ActiveSheet.UsedRange.Columns.Count
Dim vals (finalRow, finalCol) As String

Приведенный выше программный код открывает электронную табли­
цу, подсчитывает количество использованных строк и столбцов, а за­
тем создает двумерный массив нужного размера.

6. Добавьте нижеприведенный цикл, чтобы присвоить элементам мас­
сива значения из ячеек таблицы, а также чтобы отобразить их в эле­
ментах управления ListBox
For row = 1 То finalRow 

For col = 1 To finalCol 
vals (row, col) =_

Str(xl ActiveSheet Cells(row, col) Value) 
ListBoxl Items.Add(row)
ListBox2 Items Add(col)
ListBox3.Items Add(vals(row, col))
Next col 

Next row

7.   Наконец, введите следующие две строки, чтобы освободить ресур­
сы, затем запустите приложение и щелкните мышью по элементу 
управления Button: 
xl Workbooks Close() 
xl = Nothing

Во многих примерах из этой 
книги успешно используется 
инструкция Try Catch, 
внутрь которой заключается 
некий программный код, 
однако во многих случаях 
данная инструкция не ис­
пользуется в листингах 
программного кода для 
экономии места. Попробуйте 
воспользоваться инструкци­
ей Try Catch при работе 
с данным примером, что­
бы программа сообщала 
пользователю о возникшем 
исключении, если запрошен­
ная электронная таблица 
не может быть прочитана.

Более подробную информа­
цию о многомерных масси­
вах см. в главе 4.



Чтение XML-файлов
Объект System.Xml языка Visual Basic может быть использован для 
простого импорта в приложение данных из документа XML. Сначала 
необходимо создать контейнер для данных в объекте System.Xml. 
Xml Document, затем загрузить данные в созданный объект с помо­
щью метода Load (), копирующего данные из файла документа.

Затем можно использовать объект System.Xml.XmlNodeList для 
создания массива Item (), хранящего все элементы документа XML. 
Доступ к отдельным элементам можно получить, указав их имена в ка­
честве параметра метода SelectSingleNode () массива Item() 
Также необходимо указать значение данного элемента, которое, в свою 
очередь, можно получить из свойства InnerText.

1. Откройте любой простой текстовый редактор, например Блокнот 
(Notepad), и создайте XML-документ с элементами, как показано 
на рисунке ниже. Сохраните созданный файл с именем books.xml 
в папке Документы.

Вы можете скачать данный 
документ XML, а также 
другие файлы, используе­
мые в этой книге, по адресу 
eksmo.ru/fiies/VB_Primers.rar
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2. Создайте новый проект Windows Forms Application и добавьте 
в форму элементы управления ListBox и Button.

3. Дважды щелкните мышью по элементу управления Button, что­
бы открыть редактор кода, и введите следующий программный код 
в обработчик события Click данного элемента управления:
Dim doc As New System Xml XmlDocument
doc Load("C:\Users\Mike\Documents\books.xml")

4. Добавьте следующий код для создания экземпляра объекта 
XmlNodeList из элементов book и вложенных элементов.
Dim nodes As System.Xml .XmlNodeList 
node = doc SelectNodes("shelf/book")

5. Теперь создайте цикл для отображения текста, содержащегося 
в каждом элементе title и author, и запустите приложение.
Dim counter = 0
Do Until counter - nodes . Count 
ListBoxl.Items.Add(nodes.Item(counter)__ 
SelectSingleNode ("title") InnerTextS",
& nodes.Item(counter)
SelectSingleNode("author").InnerText & vbCrLf) 

counter + = 1 
Loop

Обратите внимание на ис­
пользование свойства
XmlNodeList для установ­
ки предела цикла.



Создание набора 
данных XML
Язык Visual Basic предоставляет набор специализированных компонен­
тов для работы с данными в табличном формате, например с такими, 
что содержатся в элементах XML или в таблицах баз данных. Нужные 
компоненты находятся в разделе Data (Данные) панели элементов.

В приложение можно добавить компонент DataSet, создающий в па­
мяти компьютера таблицу, в которую можно загрузить данные из лю­
бого подходящего ресурса. В большинстве случаев гораздо удобнее ото­
бражать табличные данные с помощью компонента DataGridView. 
Этот компонент позволяет сохранить данные в памяти компьютера 
и манипулировать ими динамически с помощью приложения, а также 
записать обратно в файл.

1. Создайте новый проект Windows Forms Application и добавьте 
в форму компонент DataGridView, а также два элемента управле­
ния Button. Назовите добавленные элементы управления Button 
соответственно ReadBtn и WriteBtn.

2. Дважды щелкните мышью по компоненту DataSet на панели 
элементов, затем установите переключатель в положение Нетипи- 
зированный набор данных (Untyped DataSet) в открывшемся диа­
логовом окне Добавление набора данных (Add DataSet) и нажмите 
кнопку ОК. В результате в нижней части окна конструктора форм 
появится значок компонента DataSet.

3. Дважды щелкните мышью по кнопке ReadBtn, чтобы открыть ре­
дактор кода, и введите следующий код в обработчик события Click 
данного элемента управления, чтобы создать набор данных из XML- 
файла, приведенного в предыдущем разделе.
DataSetl ReadXml("C:\Users\Mike\Documents\books xml")
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Файл books.xml должен 
находиться в папке Докумен­
ты на вашем компьютере. 
Исправьте путь к файлу в со­
ответствии с настройками 
вашей системы.



4. Добавьте следующий программный код для загрузки элементов, 
включенных в элемент book, из компонента DataSet в элемент 
управления DataGridView.
DataGridViewl DataSource = DataSetl
DataGridViewl DataMember = "book"

5. Вернитесь в окно конструктора форм, дважды щелкните мышью 
по кнопке WriteBtn и введите следующую строку кода в обработ­
чик события Click данного элемента управления:
DataSetl WriteXml("C:\Users\Mike\Documents\books xml")

6. Щелкните мышью по кнопке Запуск (Start) или нажмите клавишу F5, 
чтобы запустить приложение, а затем нажмите кнопку ReadBtn, 
чтобы загрузить набор данных DataSet в элемент управления
DataGridView.

Элемент управления DataGridView отображает в качестве заголовка 
столбца таблицы имя соответствующего элемента XML, при этом содер­
жимое данного элемента отображается на отдельной строке таблицы. 
По умолчанию программа выделяет первую ячейку первой строки, но вы 
можете щелкнуть мышью по любой другой ячейке, чтобы выделить ее. 
При двойном щелчке мышью по выделенной ячейке она переходит в ре­
жим редактирования и вы можете обновить ее содержимое.

7 Добавьте новую строку после последней строки таблицы и нажмите 
кнопку WriteBtn, чтобы сохранить измененные данные.

8. Перезапустите приложение и щелкните мышью по кнопке ReadBtn 
еще раз, чтобы снова загрузить данные XML в элемент управления 
DataGridView. Обратите внимание, что добавленная вами строка 
была сохранена в файле.

Полосы прокрутки появля­
ются автоматически, если 
содержимое ячейки слиш­
ком велико для отображе­
ния в элементе управления 
DataGridView. Присвое­
ние свойству ScrollBars 
значение None может 
привести к невозможности 
отображения всего содержи­
мого таблицы.

Вы можете на­
значить свойству
AutoSizeColumnsMode 
элемента управления 
DataGridView значение 
AllCells, чтобы автомати­
чески отображать все тексто­
вое содержимое каждой 
ячейки.



Заключение
• Для чтения и записи файлов на компьютере может быть использо­

ван объект Му. Computer.FileSystem.

• Объект System.Ю.Stream может хранить текст, считанный из локаль­
ного файла или внешнего источника, например ответа веб-сервера.

• Очень важно освобождать объекты System.IO.Streamn System. 
IO.StreamReader после использования.

• Метод Print () компонента Print Document на самом деле 
не отправляет данные на принтер: данный метод лишь генерирует 
событие PrintPage, обработчик которого должен содержать про­
граммный код для вывода данных на печать.

• Данные, импортированные из электронной таблицы Excel, лучше 
всего хранить в двумерном массиве, элементы которого представ­
ляют соответственно строки и столбцы.

• Для хранения представления документа XML используется объект
System.Xml.XmlDocument.

• Объект System.Xml.XmlNodeList создает массив Items () 
из элементов, выбранных в документе System.Xml.XmlDocument.

• Свойство InnerText хранит актуальное текстовое содержание 
выбранного элемента.

• Компонент DataSet создает в памяти компьютера таблицу, кото­
рую можно заполнить данными из любого подходящего источника.

• Зачастую удобнее всего выводить на экран табличные данные ком­
понента DataSet с помощью компонента DataGridView. Дан­
ный компонент позволяет редактирование и последующую запись 
в файл новых данных.



Использование 
баз данных

В этой главе 
мы представим 

вам базы данных 
и продемонстрируем 

использование мощных 
средств работы с базами 

данных SQL Server 
в приложениях на языке 

Visual Basic.

• Введение в базы данных

• Проектирование базы данных

• Создание базы данных

• Добавление таблиц в базу данных

• Определение столбцов таблицы

• Создание табличных связей

• Ввод табличных данных

• Создание наборов данных

• Добавление элементов управления данными

• Создание связей данных

• Создание собственных запросов SQL

• Заключение
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Базы данных — это просто-напросто удобные контейнеры для структу­
рированного хранения данных. Каждая база данных состоит из одной или 
нескольких таблиц, позволяющих представлять эти данные в виде структу­
рированных строк и колонок. Этот метод хранения упрощает процедуры 
доступа и манипулирования данными. Каждый столбец таблицы базы дан­
ных имеет заголовок, позволяющий идентифицировать данные, сохранен­
ные в ячейках этого столбца. Каждая строка — это элемент таблицы, нося­
щий название «запись». Этот элемент размещает данные в ячейках таблицы 
по горизонтали, например, следующим образом:

Строки баз данных не упорядочиваются автоматически, поэтому они 
могут быть отсортированы по алфавиту, по убыванию или возраста­
нию числовых значений, либо в соответствии с иными критериями. 
Таким образом, очень важно предусмотреть средства идентификации 
каждой записи в таблице. В примере выше для этих целей использует­
ся столбец ID_Участника, такой уникальный идентификатор принято 
называть первичным ключом таблицы.

Хранение данных в единственной таблице полезно, однако реляцион­
ные базы данных, состоящие из нескольких таблиц, предоставляют 
большее количество возможностей, позволяя различными способами 
комбинировать данные. Например, таблица ниже могла бы быть добав­
лена к базе данных, содержащей таблицу, приведенную выше.

В заголовках колонок 
использование пробелов 
недопустимо, поэтому, 
вам необходимо вводить 
«Ю_Участника» вместо «Ю 
Участника».

В таблице перечислены названия фильмов, отсортированные по воз­
растанию числовых значений столбца ID_Видео. Кроме того, таблица 
также описывает связь идентификационного номера каждого участни­
ка и взятого напрокат видеодиска: Джон (ID_Участника 1) взял напро­
кат «Звездные войны» (ID_Видео 3), Энн (ID_Участника 2) взяла «Тита­
ник» (ID_Видео 1), а Майк (ID_Участника 3) взял напрокат «Фантазию» 
(ID_Видео 2). В этой таблице значения первичного ключа хранятся



в столбце ID_Видео и позволяют идентифицировать записи таблицы, 
при этом столбца ID_Участника содержит значения Вторичного клю­
ча, ссылающиеся на записи первой таблицы.

SQL Server

Система управления базами данных (СУБД) SQL Server, включаемая 
в комплект поставки Visual Studio, придерживается реляционной мо­
дели, как и другие системы управления реляционным базами данных 
(СУРБД), например Oracle или IBM DB2. Это значит, что данное про­
граммное обеспечение предполагает соблюдение правил «нормализа­
ции», о которых вы должны знать при проектировании базы данных.

Нормализация данных

Правила нормализации настаивают на эффективной организации дан­
ных без повторений и избыточности с целью избегания возможных 
аномалий при проведении операций с данными. Правила требуют, что­
бы для каждой таблицы был создан первичный ключ, а для всех осталь­
ных колонок были определены допустимые типы данных (что позволя­
ет установить, могут ли ячейки содержать текст или числа заданного 
диапазона, а также могут ли ячейки оставаться пустыми).

Использование правил нормализации при проектировании базы данных 
предполагает, что данные должны появляться в таблице только единожды, 
таким образом, любые повторяемые данные должны быть перенесены 
в другие таблицы и при необходимости связаны с данными текущей таб­
лицы. Например, если имя и адрес клиента повторяются в двух таблицах, 
то эти данные должны быть перенесены в собственную таблицу и связа­
ны с обеими исходными таблицами. Такой подход упрощает процедуру 
обновления информации о клиенте и позволяет избежать возникновения 
аномалии, когда обновлен лишь один из двух наборов данных.

Целостность данных

Еще один важный аспект СУРБД касается сохранения целостности 
данных путем запрета «потерянных» записей. Это значит, что записи, 
на которые созданы ссылки из других таблиц, не могут быть удалены 
прежде, чем будут удалены ссылки. В противном случае ссылка окажет­
ся «потерянной» так как она не сможет найти данные в «родительской» 
таблице. Например, если таблица с перечнем товаров, заказанных кли­
ентом, содержит ссылку на запись в таблице с товарами, СУРБД не по­
зволит удалить товарную позицию, так как это сделает ссылку из таб­
лицы с заказом клиента бесполезной.

Вторичный ключ всегда 
является ссылкой на первич­
ный ключ другой таблицы. 
Для упрощения процедуры 
распознавания присваивай­
те данным столбцам похо­
жие имена.

ПО SQL Server устанавлива­
ется вместе с Visual Studio 
(см. начало этой книги).
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базы данных
Процесс проектирования базы данных можно отнести к процессам 
шлифовки и улучшения восприятия правил нормализации. Начните 
проектирование с создания одной таблицы для всех полей данных, за­
тем перенесите повторяющиеся в отдельные таблицы.

Представьте себе проект базы данных имеющихся в продаже вообра­
жаемых мотоциклов моделей Sport, Cruiser и Touring, которые, в свою 
очередь, также доступны в трех конфигурациях: Standard, Deluxe 
и Classic, при этом каждая модель и конфигурация имеет уникальную 
стоимость. Единая таблица Bikes для всего ассортимента и всех данных, 
плюс столбец для заметок, может выглядеть следующим образом:

Первичный ключ — это 
уникальный идентификатор 
строки таблицы, поэтому 
значение первичного ключа 
изменять не следует.

Столбец BikelD предоставляет уникальный идентификатор каждой 
строки и может быть установлен в качестве первичного ключа табли­
цы. Столбец Price также содержит уникальные значения, а все ячейки 
столбца Note изначально пусты. Столбцы Model и Version содержат по­
вторяющиеся данные, что противоречит правилам нормализации дан­
ных, а это значит, что каждая из этих колонок должна быть перенесена 
в отдельную таблицу, например, как показано ниже:



Столбцы ModellD и VersionID предоставляют уникальный идентифи­
катор для каждой строки и могут быть установлены в качестве первич­
ного ключа (ПК) соответствующей таблицы, они также могут быть ис­
пользованы в качестве вторичных ключей (ВК) усовершенствованной 
таблицы Bikes:

Что касается допустимых типов данных для каждой из колонок — в со­
ответствии с правилами нормализации столбцы BikelD, ModellD, 
VersionID и Price должны допускать сохранение только целых чисел. 
Столбцы Model и Version должны допускать использование не более 
10 символов, а столбец Note — не более, скажем, пятидесяти символов. 
Все ячейки, кроме ячейки Note, обязательно должны содержать данные, 
на языке баз данных, эти ячейки должны быть «не пустыми». Схема 
базы данных, приведенная ниже, иллюстрирует вышеперечисленные 
ограничения типов данных и отношения таблиц:

Данный проект используется нами на последующих страницах для со­
здания базы данных SQL Server и приложения Visual Basic, связываю­
щегося с базой данных для динамического получения данных и выпол­
нения операций над ними.

Устанавливая ограничения 
по типам данных, всегда ду­
майте о возможных измене­
ниях в будущем: например, 
вдруг, случится так, что неко­
торые названия моделей или 
конфигураций мотоциклов 
будут состоять больше, чем 
из 10 символов?
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Убедитесь, что в диалоговом 
окне Мастер настройки 
источника данных (Data 
Source Configuration Wizard) 
вы нажимаете именно 
кнопку Отмена (Cancel), 
а не кнопку Готово (Finish).

Создание базы данных
СУБД SQL Server очень хорошо интегрирована с Visual Basic, поэтому 
вы запросто можете создать новую базу данных средствами интегриро­
ванной среды разработки.

1. В IDE Visual Studio создайте новый проект Windows Forms Application 
и назовите его BikesApplication.

2. Выберите команду меню Вид => Обозреватель решений (View => 
Solution Explorer) или воспользуйтесь сочетанием клавиш Ctrl+AIt+L, 
чтобы открыть панель Обозреватель решений (Solution Explorer).

3. На панели Обозреватель решений (Solution Explorer) щелкните 
правой кнопкой мыши по названию проекта и в открывшемся кон­
текстном меню выберите команду Добавить => Создать элемент 
(Add => New Item), чтобы открыть диалоговое окно Добавление но­
вого элемента (Add New Item).

4.  В диалоговом окне Добавление нового элемента (Add New Item) выбе­
рите раздел Данные (Data), щелкните мышью по значку База данных, 
основанная на службах (Service-based Database), в поле Имя (Name) 
введите BikesDatabase.mdf и нажмите кнопку Добавить (Add).

5. Пока что закройте появившееся диалоговое окно Мастер настрой­
ки источника данных (Data Source Configuration Wizard), щелкнув 
мышью по кнопке Отмена (Cancel).



Подключение к базе данных

1. На панели Обозреватель решений (Solution Explorer) щелкните 
правой кнопкой мыши по значку только что добавленной базы дан­
ных BikesDatabase.mdf, затем в контекстном меню выберите коман­
ду Open (Открыть), открывающую панель Обозреватель серверов 
(Server Explorer).

2. Осмотрите значок базы данных BikesDatabase.mdf на панели Обо­
зреватель серверов (Server Explorer), вы должны увидеть значок 
в виде зеленого сетевого штекера в нижней его части, обозначаю­
щий, что вы подключены к базе данных.

3. Щелкните правой кнопкой мыши по значку базы данных 
BikesDatabase.mdf на панели Обозреватель серверов (Server 
Explorer) и в открывшемся контекстном меню выберите команду За­
крыть подключение (Close Connection). В результате значок кабеля 
должен измениться на красный крестик.

4. Щелкните правой кнопкой 
мыши по значку базы данных 
BikesDatabase.mdf на панели 
Обозреватель серверов (Server 
Explorer) и в открывшемся кон­
текстном меню выберите команду 
Обновить (Refresh), чтобы вы­
полнить подключение к базе данных. В результате на значке дол­
жен вновь отобразиться значок в виде зеленого сетевого штекера, 
обозначающий, что вы подключены к базе данных.

5. Чтобы проверить подключение, вновь щелкните правой кнопкой 
мыши по значку базы данных BikesDatabase.mdf и выберите команду 
меню Изменить подключение (Modify Connection), чтобы открыть 
диалоговое окно Изменить подключение (Modify Connection). В по­
явившемся диалоговом окне нажмите кнопку Проверить подклю­
чение (Test Connection) — в результате на экране должно появиться 
сообщение об успешном подключении к базе данных.

6. В обоих окнах нажмите кнопку ОК, чтобы закрыть их.

Панель Обозреватель
серверов (Server Explorer) 
также можно открыть, вос­
пользовавшись командой 
меню Вид => Обозреватель 
серверов (View => Server 
Explorer), либо дважды щелк­
нув мышью по значку базы 
данных BikesDatabase.mdf 
на панели Обозреватель 
решений (Solution Explorer).

В этой главе создается 
законченное приложение, 
работающее с базой данных. 
При воссоздании во избе­
жание ошибок очень важно 
тщательно следовать всем 
шагам строго в приведенной 
последовательности.
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в базу данных
Создав базу данных BikesDatabase, вы можете начать добавлять в нее таб­
лицы Bikes, Models и Versions из проекта, созданного ранее. Для каждой 
из создаваемых таблиц необходимо указать столбец с первичным ключом.

1 На панели Обозреватель 
серверов (Server Explorer) 
щелкните правой кнопкой 
мыши по значку Таблицы 
(Tables) и в открывшемся 
контекстном меню выбе­
рите команду Добавить 
новую таблицу (Add New 
Table), чтобы открыть окно 
конструктора таблиц.

2. В окне конструктора таблиц введите BikelD в поле под заголовком 
Имя столбца (Column Name).

При работе с конструктором 
таблиц вы можете закрыть 
окно конструктора форм, 
чтобы уменьшить размеры 
окна IDE.

3. Щелкните мышью под заголовком Тип данных (Data Туре) и выбе­
рите вариант int из раскрывающегося меню с тем, чтобы позволить 
ввод в данную ячейку только целочисленных данных.

4. Убедитесь, что флажок Допустимы значения null (Allow Nulls) сбро­
шен, таким образом вы запретите пустые ячейки в данном столбце.

5. В окне конструктора таблиц щелкните правой кнопкой мыши по стро­
ке таблицы и выберите пункт Задать первичный ключ (Set Primary 
Key) в контекстном меню, чтобы установить первичный ключ.



6. На панели Свойства (Properties) откройте раскрывающийся список 
Идентификатор (Identity), находящийся под пунктом Специфика­
ция идентификатора (Identity Specification), и выберите пункт True, 
чтобы включить автоматическую нумерацию строк таблицы.

7.  Выберите команду меню Файл => Сохранить (File => Save) или вос­
пользуйтесь сочетанием клавиш Ctrl+S, чтобы открыть диалоговое 
окно Сохранить (Save), назовите эту таблицу Bikes и щелкните мы­
шью по кнопке ОК.

Вы можете выполнить двой­
ной щелчок мышью по знач­
ку любой таблицы на панели 
Обозреватель серверов
(Server Explorer), чтобы 
повторно открыть интере­
сующую вас таблицу в окне 
конструктора таблиц.

8. Повторите вышеперечисленные шаги для создания таблиц Models 
и Versions со столбцами ModellD и VersionID соответственно. 
На панели Обозреватель серверов (Server Explorer) должны по­
явиться значки обеих таблиц.
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таблицы
Создав таблицы Bikes, Models и Versions, вы можете начать определять 
столбцы каждой из таблиц, устанавливая значения свойств Имя столб­
ца (Column Name), Тип данных (Data Туре) и Допустимы значения 
null (Allow Nulls).

1. На панели Обозреватель серве­
ров (Server Explorer) щелкните 
правой кнопкой мыши по значку 
таблицы Bikes в папке Таблицы 
(Tables), затем выберите коман­
ду меню Открыть определение 
таблицы (Open Table Definition), 
чтобы открыть данную таблицу 
в окне конструктора таблиц.

2. Щелкните мышью по следующей свободной строке под заголовком 
Имя столбца (Column Name) после строки, содержащей имя BikelD, 
и введите имя нового столбца ModellD, установите тип данных int 
и сбросьте флажок Допустимы значения null (Allow Nulls).

3. Повторите шаг 2 для определения колонок VersionID и Price.

4. Добавьте столбец с именем Note, установите тип данных varchar(50) 
и установите флажок Допустимы значения null (Allow Nulls). Таким 
образом, полное определение таблицы должно выглядеть следую­
щим образом:

5. На панели Обозреватель серверов (Server Explorer) щелкните правой 
кнопкой мыши по значку таблицы Models, затем выберите команду 
меню Открыть определение таблицы (Open Table Definition), чтобы 
открыть данную таблицу в окне конструктора таблиц.

Столбец Note — единствен­
ный из всех создаваемых 
в данном примере таблиц, 
для которого допускается 
наличие пустых ячеек.



6. Щелкните мышью по следующей свободной строке под заголовком 
Column Name (Имя столбца) после строки, содержащей имя ModellD, 
и введите имя нового столбца Model, установите тип данных char(10) 
и сбросьте флажок Допустимы значения null (Allow Nulls).

7. На панели Обозреватель серверов (Server Explorer) щелкните 
правой кнопкой мыши по значку таблицы Versions, затем выбе­
рите команду меню Открыть определение таблицы (Open Table 
Definition), чтобы открыть данную таблицу в окне конструктора.

8. Щелкните мышью по следующей свободной строке под заголовком 
Column Name (Имя столбца) после строки, содержащей имя VersionID, 
и введите имя нового столбца Version, установите тип данных char(10) 
и сбросьте флажок Допустимы значения null (Allow Nulls).

Когда таблица открыта 
в конструкторе, вы можете 
воспользоваться командой 
меню Вид => Окно свойств 
(View => Properties window), 
чтобы просмотреть свойства 
данной таблицы.

Если среда разработки 
выводит предупреждение 
о сохранении с повторным 
созданием таблиц, выберите 
команду меню Сервис => Па­
раметры (Tools Options), 
перейдите в категорию 
Инструменты базы данных 
=> Конструкторы таблиц 
и базы данных (Database 
Tools => Table and Database 
Designers) и сбросьте фла­
жок He допускать измене­
ний, требующих повторно­
го создания таблиц (Prevent 
saving changes that require 
table recreation).

9. Воспользуйтесь коман­
дой Файл => Сохранить 
все (File => Save All), 
чтобы сохранить проект 
и все обновленные 
определения таблиц.
На панели Обозрева­
тель серверов (Server 
Explorer) раскройте все 
таблицы, чтобы про­
смотреть перечень всех 
определенных колонок.
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связей
Завершив создание таблиц, мы можем приступить к установке связей 
между столбцом ModellD таблицы Bikes и таблицей Models, а также 
между столбцом VersionID этой таблицы и таблицей Versions.

1. На панели Обозреватель серверов (Server Explorer) щелкните пра­
вой кнопкой мыши по значку Представления (Database Diagrams) 
и в открывшемся контекстном меню выберите команду Добавить 
новую схему (Add New Diagram).

2. В появившемся диалоговом окне, спрашивающем, действительно ли 
вы хотите создать требующиеся объекты, щелкните мышью кнопку 
Да (Yes) — и после непродолжительной задержки на экране появит­
ся диалоговое окно Добавление таблицы (Add Table).

3. В списке диалогового окна Добавление таблицы (Add Table) вы­
делите все три таблицы (Bikes, Models и Versions), затем нажмите 
кнопку Добавить (Add), чтобы создать схему, по окончании нажми­
те кнопку Закрыть (Close), чтобы закрыть окно Добавление табли­
цы (Add Table).

Вы можете автоматически 
изменить расположение 
таблиц, для этого выберите 
команду Упорядочить таб­
лицы (Arrange Tables) пункта 
меню Схема базы данных 
(Database Diagram).

4. Щелкните мышью по кнопке Сохранить все (Save All) или восполь­
зуйтесь сочетанием клавиш Ctrl+Shift+S, чтобы сохранить создан­
ную схему.

В нашем случае создаваемые табличные связи будут ограничены созда­
нием вторичных ключей столбцов ModellD и VersionID в таблице Bikes 
путем связывания этих столбцов с соответствующими таблицами.



5.  На панели Схема базы данных (Database Diagram) щелкните по кноп­
ке с изображением ключа в таблице Models, а затем перенесите ука­
затель мыши на столбец ModellD в таблице Bikes и нажмите кнопку 
ОК в открывшемся диалоговом окне Отношение. В результате между 
двумя точками появится линия, обозначающая состояние связи.

Порядок создания связи 
очень важен. Всегда в пер­
вую очередь выполняйте 
щелчок мышью по ключу 
таблицы, из которой необхо­
димо взять первичный ключ, 
затем переносите указатель 
мыши на столбец с вто­
ричным ключом во второй 
таблице.

Щелкните правой кнопкой 
мыши по любой из нарисо­
ванных линий связи и в от­
крывшемся контекстном 
меню выберите пункт Пока­
зать подписи отношений 
(Show Relationship Labels), 
чтобы добавить текст над ли­
ниями для описания связей, 
как показано на рисунке.

6. Теперь щелкните по кнопке с изображением ключа в таблице 
Versions и перенесите указатель мыши на столбец VersionID в таб­
лице Bikes. В результате на схеме будет создана еще одна линия.

7.  Щелкните мышью по кнопке Сохранить все (Save All) или восполь­
зуйтесь сочетанием клавиш Ctrl+Shift+S, чтобы добавить связи 
в базу данных, и нажмите кнопку Yes (Да), когда система запросит, 
действительно ли вы желаете сохранить изменения.

Для успешного создания 
табличных связей реко­
мендуется использование 
программного обеспечения 
Microsoft SQL Server 2012 SP1 
и входящего в комплект 
ПО SQL Server Management 
Studio (SSMS), доступного 
для загрузки по адресу: 
msdn.microsoft.com/ru-ru/ 
Iibrary/y5a4ezk9.aspx.
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Установив отношения между таблицами, вы можете приступить к вво­
ду записей данных в каждую таблицу.

1.  На панели Обозрева­
тель серверов (Server 
Explorer) раскройте 
дерево Tables Табли­
цы (Tables) и щелкните 
правой кнопкой мыши 
по значку таблицы 
Models. В открывшем­
ся контекстном меню 
выберите пункт Пока­
зать таблицу данных 
(Show Table Data), чтобы 
открыть таблицу Models 
на панели Таблица дан­
ных (Table Data).

2. Щелкните мышью по ячейке под заголовком Model и введите на­
звание модели Sport, затем нажмите клавишу Tab, чтобы перейти 
к следующей строке столбца Model. Обратите внимание на авто­
матическое добавление нумерации в столбце ModellD, как и было 
установлено нами в момент создания данной таблицы.

3. На второй строке введите 
название модели Cruiser, 
a Touring — на третьей, 
так, чтобы ваша табли­
ца выглядела точно как 
на рисунке, затем щелк­
ните мышью по кнопке х, 
чтобы закрыть это окно.

4. Откройте таблицу 
Versions на панели Таб­
лица данных (Table Data), 
затем в столбце под заго­
ловком Version введите 
название конфигураций 
Standard на первой стро­
ке, Deluxe — на второй
и Classic — на третьей.

Вы можете перемещаться 
между строками с помощью 
клавиш     ,  ,    и    



5. Откройте таблицу Bikes на панели Таблица данных (Table Data), за­
тем щелкните мышью по столбцу под заголовком ModellD и введи­
те в него данные, для перемещения между ячейками таблицы поль­
зуясь клавишей Tab. Введите также данные в столбцы VersionID 
и Price, чтобы таблица выглядела следующим образом:

Если при вводе данных 
система выдает ошибку, 
то, скорее всего, ограниче­
ния таблицы не позволяют 
вводить данные. Проверьте 
определение таблицы и ис­
правьте проблему.6. Чтобы проверить, что ограничения таблицы работают правильно, 

щелкните мышью по первой ячейке столбца ModellD и замените 
числовое значение на текстовое, а затем нажмите клавишу Tab. В ре­
зультате на экране должно появиться диалоговое окно, сообщающее 
о неправильном вводе данных.

7. Нажмите клавишу Esc, чтобы вернуть исходное значение ячейки, 
затем щелкните мышью по кнопке х, чтобы закрыть панель Таблица 
данных (Table Data).

Вы можете проверить 
работоспособность ограни­
чений вторичных ключей, 
попытавшись удалить любую 
строку из таблиц Models или 
Versions. На экране должно 
появиться диалоговое окно, 
сообщающее о невозмож­
ности проведения данной 
операции.
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Вы можете щелкнуть мышью 
по кнопке +, чтобы просмо­
треть строку подключения.

3. Выберите базу данных BikesDatabase.mdf в качестве используемого 
подключения и нажмите кнопку Далее (Next).

Создание наборов данных
Создав на протяжении последних нескольких страниц базу данных 
со связанными таблицами и записями данных, вы можете наконец при­
ступить к созданию программы BikesApplication, использующей набор 
данных.

1. Выберите команду меню Проект => Добавить новый источник 
данных (Project => Add New Data Source), чтобы открыть диало­
говое окно Мастер настройки источника данных (Data Source 
Configuration Wizard).

2. Щелкните мышью по значку База данных (Database) и нажмите 
кнопку Далее (Next) для продолжения работы.



4. Установите флажок Да, сохранить подключение как (Yes, save the 
connection as) и снова нажмите кнопку Далее (Next).

5. Установите флажок Таблицы (Tables), чтобы включить в набор 
данных все таблицы базы данных, затем нажмите кнопку Готово 
(Finish).

Набор данных — это форма 
представления таблиц баз 
данных в оперативной памя­
ти компьютера. С набором 
данных можно производить 
необходимые действия, 
а по завершении данные мо­
гут быть записаны обратно 
в таблицы.

6. На панели Обозрева­
тель решений (Solution 
Explorer) обратите вни­
мание, что набор данных 
был создан в формате 
XSD, а конфигурация 
приложения сохранена 
в XML-документе с име­
нем app.config.
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управления данными
Создав набор данных из базы данных, мы готовы начать добавлять 
в форму элементы управления для отображения данных на экране.

1. Убедитесь, что открыто окно конструктора форм и щелкните мы­
шью по команде меню Вид => Другие окна => Источники данных 
(View => Other Windows => Data Sources), чтобы открыть панель Ис­
точники данных (Data Sources).

Кнопка раскрывающегося 
списка (со стрелкой) не бу­
дет отображаться, если 
не открыто окно конструкто­
ра форм.

2. Щелкните мышью по значку 
таблицы Bikes, нажмите кнопку 
раскрывающегося списка и вы­
берите пункт Таблица (Details).

3. Раскройте дерево Bikes, вы­
берите любой элемент, затем 
щелкните мышью по кнопке 
раскрывающегося списка, 
чтобы отобразить перечень 
возможных элементов управ­
ления. Для столбцов ModellD 
и VersionID выберите элемент 
управления ComboBox, для 
остальных — элемент управле­
ния Textbox.

4. Приготовьтесь испытать одну 
из самых захватывающих воз­
можностей языка Visual Basic! 
Щелкните мышью по значку
таблицы Bikes, удерживая нажатой левую кнопку мыши, перенеси­
те указатель мыши и таблицу в форму — и отпустите кнопку мыши. 
В форму автоматически будет добавлено большое количество эле­
ментов управления, а также следующие пять компонентов:

Значок напротив каждо­
го пункта списка Bikes 
показывает тип элемента 
управления, в котором будет 
отображен данный элемент 
таблицы.



Как и было установлено 
в раскрывающемся списке 
панели Источники данных 
(Data Sources), в форму до­
бавлено два элемента управ­
ления ComboBox и три эле­
мента управления Textbox, 
кроме того, на форме также
появилась панель инструментов навигации и надписи, соответствую­
щие названиям столбцов.

Помимо этого, были добавлены следующие невидимые компоненты
для управления потоком данных:

• TableAdapterManager — высокоуровневый компонент, коор­
динирующий операции обновления компонентов TableAdapter;

• TableAdapter объект доступа к данным, обладающий мето­
дами Fill () и GetData (), используемыми для действительного 
предоставления данных элементам управления;

• DataSet содержит таблицы данных в формате, используемом 
для представления таблиц в оперативной памяти;

• BindingSource посредник между элементами управления 
формы и набором данных;

• BindingNavigator — осуществляет поддержку Панели инстру­
ментов навигации, используемой для перемещения по записям, 
а также позволяет добавлять и удалять данные.

5. Запустите приложение и испытайте элементы управления навига­
ции. На форме должны отобразиться данные из таблицы Bikes.

Вы можете вывести на экран 
графическое представление 
набора данных. Для этого 
щелкните правой кнопкой 
мыши по значку DataSet 
на панели Источники дан­
ных (Data Sources) и выбери­
те команду Изменить набор 
данных в конструкторе 
(Edit DataSet with Designer).
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Если окно конструктора 
форм не видно, то, чтобы от­
крыть его, дважды щелкните 
мышью по значку формы 
в окне Обозреватель реше­
ний (Solution Explorer).

Создание связей данных
На предыдущей странице мы добавили в форму элементы управления 
данными, теперь ваше приложение может отображать данные, содер­
жащиеся в таблице Bikes, однако поля ModellD и VersionID по-преж­
нему отображают лишь идентификационные номера, а не ассоцииро­
ванные значения из связанных таблиц. Чтобы исправить этот недочет 
и заставить приложение отображать действительно что-то значащие 
данные, необходимо привязать эти таблицы к соответствующим эле­
ментам управления.

1. Нажав и удерживая кнопку мыши на значке таблицы Models на па­
нели Источники данных (Data Sources), перетащите его в окно 
конструктора форм и, установив указатель мыши над элементом 
управления ComboBox столбца ModellD, отпустите кнопку мыши. 
Обратите внимание, что было добавлено два новых элемента: 
ModelsBindingSource и ModelsTableAdapter.

2.  Нажав и удерживая кнопку мыши на значке таблицы Versions на па­
нели Источники данных (Data Sources), перетащите его в окно 
конструктора форм и, установив указатель мыши над элемен­
том управления ComboBox столбца VersionID, отпустите кнопку 
мыши. Обратите внимание, что было добавлено два новых элемента 
VersionsBindingSource и VersionsTableAdapter.

3. Щелкните мышью по кнопке со стрелочкой каждого элемента 
управления ComboBox, чтобы открыть настройки режима привяз­
ки в окне смарт-тега.

Все настройки режима 
привязки устанавливаются 
автоматически при привязке 
связанных таблиц к элемен­
там управления ComboBox.



Теперь элемент управления ComboBox столбца ModellD привязан 
к компоненту ModelsBindingSource и будет отображать название 
модели мотоцикла, а не ее идентификационный номер.

Аналогично, элемент управления ComboBox столбца VersionID теперь 
привязан к компоненту VersionsBindingSource и отображает на­
звание конфигурации модели мотоцикла, а не ее идентификационный 
номер.

4. Отредактируйте текст элементов управления Label рядом с каж­
дым элементом управления ComboBox, так чтобы он соответство­
вал отображаемому значению.

5. Так как содержание таблицы BikelD не является полезным для 
пользователя, на панели Свойства (Properties) присвойте свойству 
Visible этого столбца значение False, а затем удалите с формы 
соответствующий элемент управления Label.

6. Запустите приложение и пронаблюдайте за отображением в элемен­
тах управления действительно значимых данных.

7. Чтобы протестировать способность приложения сохранять измене­
ния в базе данных, введите какой-либо текст в поле Заметки и на­
жмите кнопку Сохранить данные (Save Data). Теперь перезапустите 
приложение и убедитесь в том, что текст примечания был сохранен.

Чтобы убедиться в том, что 
данные сохранены в базе, вы 
также можете запустить ис­
полняемый файл приложе­
ния, находящийся в подпап­
ке bin/debug папки проекта.
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запросов SQL
Добавив в приложение возможность отображать действительно значи­
мые данные, вы можете начать пользоваться истинной мощью баз дан­
ных путем создания собственных запросов SQL для извлечения из базы 
только конкретных требуемых данных.

1. Щелкните мышью по значку компонента BikesTableAdapter, 
затем в окне смарт-тега выберите команду Добавить запрос (Add 
Query), чтобы открыть диалоговое окно Построитель условий по­
иска (Search Criteria Builder).

SQL (Structured Query 
Language) — Язык структу­
рированных запросов — это 
стандартный язык, исполь­
зующийся для создания 
запросов к базам данных. 
Более подробную инфор­
мацию вы можете получить 
в любой книге по SQL.

В диалоговом окне Построитель условий поиска (Search Criteria Builder) 
по умолчанию отображается запрос SQL под названием FillBy, вы­
полняющийся обработчиком события загрузки формы (Form_Load) 
с целью записи данных в элементы управления и Панель инструментов 
навигации. Данный запрос выбирает все столбцы и строки таблицы 
Bikes. Данный запрос также может быть использован для создания ва­
ших собственных запросов SQL, например когда пользователь требует 
отображения всех данных.

2. В поле Имя нового запроса (New Query Name) укажите значение 
Get All и нажмите кнопку ОК. На форме должна появиться новая 
панель инструментов с кнопкой с надписью GetAll.

3. Выделите новую панель инструментов, затем на панели Свойства 
(Properties) присвойте свойству AutoSize значение False и из­
мените значения свойств MaximumSize и Size так, чтобы данная 
кнопка походила по размеру на обычную кнопку, 100, 30.

Чтобы создать собственный запрос SQL, выбирающий нужные дан­
ные, вы можете отредактировать запрос по умолчанию, лишь добавив 
к нему дополнительные критерии отбора.

4. Щелкните мышью по значку компонента BikesTableAdapter, 
затем в окне смарт-тега выберите команду Добавить запрос (Add 
Query), чтобы снова открыть диалоговое окно Построитель усло­
вий поиска (Search Criteria Builder).



5. В поле New Query Name (Имя нового запроса) укажите значение 
GetClassics, а в поле Текст запроса (Query Text) введите следую­
щую инструкцию:
WHERE VersionID = 3

Конфигурация Classic пред­
ставлена номером 3, а модель 
Cruiser — номером 2, как 
показано в проектах таб­
лиц, и введено в программу 
ранее в этой главе.

6. Нажмите кнопку ОК для создания новой панели инструментов, за­
тем измените ее размер, как показано ранее (чтобы панель инстру­
ментов была не больше стандартной кнопки).

7 Откройте диалоговое окно Построитель условий поиска (Search 
Criteria Builder) и создайте новый запрос GetCruisers, добавив 
к тексту запроса следующую инструкцию:
WHERE Model ID = 2

8. Измените размер новой панели инструментов, как было показано 
ранее, затем запустите приложение, щелкните мышью по кнопке 
GetClassics, чтобы осуществить выбор данных только по конфигу­
рации Classic.

На панели инструментов 
навигации отображается 
количество записей, выбран­
ных заданным запросом.
В нашем случае это две 
конфигурации Classic и три 
модели Cruiser.

9.  Щелкните мышью по кнопке GetAll, чтобы снова выбрать все дан­
ные, затем щелкните мышью по кнопке GetCruisers, чтобы осуще­
ствить выбор данных только по конфигурации Cruiser.



Заключение
• Базы данных используются для хранения данных в виде структури­

рованных строк и столбцов. Такой метод хранения упрощает поиск 
и осуществление операций с данными.

• Строки в таблице базы данных называются записями, при этом каж­
дой строке должен быть присвоен первичный ключ — уникальный 
идентификатор записи.

• В реляционных базах данных таблица может ссылаться на собствен­
ные записи по первичному ключу и на записи других таблиц — 
по вторичному ключу.

• Согласно правилам нормализации, данные в базе не должны повто­
ряться, а для каждого столбца должен быть определен тип данных.

• Целостность данных обеспечивается ограничениями базы данных.

• ПО SQL Server интегрировано с Visual Studio, что позволяет созда­
ние баз данных напрямую из среды разработки.

• Ограничения таблицы устанавливаются в окне конструктора таблиц.

• Присвоение свойству Спецификация идентификатора (Identity 
Specification) первичного ключа значения True позволит создать ав­
томатическую нумерацию каждой строки.

• Отношения таблиц могут быть установлены с помощью инструмен­
та SQL Server Management Studio (SSMS).

• Ограничения таблиц можно протестировать в режиме реального 
времени, введя на панели Таблица данных (Table Data) заведомо 
неправильные данные.

• Набор данных — это форма представления данных таблиц базы 
данных в оперативной памяти компьютера.

• Чтобы автоматически создать нужные элементы управления, пере­
несите с помощью мыши нужную таблицу из панели Источники 
данных (Data Sources) в форму.

• Компонент BindingSource управляет потоками данных между 
набором данных и элементами управления формы.

• Для привязки действительно значимых данных перенесите с помо­
щью мыши нужную таблицу из панели Источники данных (Data 
Sources) в форму.

• Для компонента TableAdapter реализован набор методов для 
вывода данных в элементы управления формы и для добавления 
ваших собственных запросов SQL, позволяющих использовать ис­
тинную мощь баз данных путем выбора из базы только нужных кон­
кретных данных.
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диалоговое окно, 168,178 

Мастер публикации, 93 

Мастер шаблонов, Normal.dotm, 133 

Меньше или равно, операция < =, 64



Меньше чем, операция <, 64 
Меню, добавление, 116 
Меню, кодирование, 118 
Методы, 56
Многомерные массивы, 63 
Мультимедиа, 126 
Надпись, форма, 24 
Направляющие линии, 85 
Начальная страница, 13 
Независимое приложение, 9 2 
Необрабатываемое исключение, 106 
Неравенство, операция, 64 
Несколько форм, 122 
Нет, кнопка диалогового окна, 36 
Новый проект, 14 
Нормализация данных, 165,166 
Нормализация, данные, 165 
О программе, диалоговое окно, 120 
Область действия переменных, 60 
Обнаружение ошибок, 96 
Обнаружение ошибок в режиме реаль­

ного времени, 96
Обозреватель серверов, панель, 169 
Обозреватель решений, 14 
Обработчик событий, 19 
Общие элементы управления, 16

Button, 41 
CheckBox, 48 
ComboBox, 43 
Label, 44 
ListBox, 46 
PictureBox, 45 
RadioButton, 49 
RichTextBox,114 
TextBox, 42 
WebBrowser, 50 

Объединение кода,65 
Объекты, 56

Свойства и методы, 70 
Ограничения, 167 
Операции, 56

Больше, чем, >, 64 
Больше или равно, >=, 64 
Вычитания, —, 64 
Конкатенации, &, 65 
Меньше, чем, <, 64 
Меньше или равно <=, 64 
Неравенства <>, 64 
Продолжить на следующей 
строке, _, 65

Равенства, =, 64 
Сложения, +, 64 
Умножения, * 64 

Операции сравнения, 64 
Операция деления, /, 64 
Операция равенства, =, 64 
Операция сложения, +, 64 
Описание, поле, 120 
Открепить в родительском контейне­

ре, 50
Открыть проект, 21 
Открыть, диалоговое окно, 112 
Отладка кода, 100
Отмена, кнопка диалогового окна, 36 
Ошибки

Коррекция компиляции, 98 
Обнаружение во время выполне­
ния приложения104 
Обнаружение в реальном 
времени, 97 
Отладка, 100 
Перехват, 106
Установка точек останова, 102 

Ошибки времени выполнения, 104 
Ошибки компиляции, 98 
Панель инструментов, 13 
Панель компонентов, 52,112,181 
Панель элементов, 13,16 

Данные, раздел, 156 
Добавление элементов, 126 
Диалоговые окна, раздел, 112 
Компоненты, раздел, 52 
Меню и панели инструментов, 
раздел, 11 б
Общие элементы управления, 
раздел, 16 
Печать, раздел, 151 

Параметры, 73 
Параметры фильтрации, 114 
Первичный ключ, 164,167 
Переменная, 56 

Массивы, 62 
Область действия, 60 
Объявление, 58 
Определение, 56 
Типы данных, 58

Перехват исключений, 106 
Печать, 151
Печать, диалоговое окно, 114 
План программы, 80 
Пользовательские значения, 32

Порядок наложения, 71 
Порядок табуляции, 40 
Построитель условий поиска, диалого­

вое окно, 184
Потоковый вывод текста, 150 
Приложение Windows Forms, 14 
Продолжить на следующей строке, 

операция, _, 65
Проектирование базы данных, 166 
Проигрыватель аудио, 124 
Развертка приложения, 9 2 
Размер, форма, 24 
Редактирование свойств формы, 27 
Редактор кода, 18 
Сборка, команда, 92 
Свойства, 56 
Свойства формы, 24 
Свойства, окно, 15,25 
Сеть разработчиков Microsoft 

(MSDN), 13
Система справки, 108 
Система управления базами данных 

(СУБД), 165
Система управления реляционными 

базами данных (СУРБД), 165 
Создание связей данных, 182 
Сохранить проект, 20 
Сохранить файл, диалоговое окно, 114 
Ссылки, диалоговое окно, 136 
Статические свойства, 82 
Столбцы, 164 
Строка меню, 13 
Строка подключения, 178 
Строка состояния, 13 
Строки, 164
Схема базы данных, 167,174 
Таблица данных, окно, 176 
Таблицы, база данных

Добавление данных, 176 
Проектирование, 166 
Определение столбцов, 172 
Отношения, 174 
Создание, 170

Тестирование приложения, 90 
Тестирование программы, 90 
Типы данных, 58 
Точка, IntelliSense, 86 
Точки останова, 102



Умножение, операция, 64 
Условное ветвление, 66 
Установка Visual Studio, 11 
Файл проекта (.vbroj, .sin), 21 
Файлы

Чтение таблиц Excel, 152 
Чтение текстовых файлов, 148 
Чтение файлов XML, 154 

Формы
О программе, диалоговое окно, 120 
управление несколькими, 122 
Экран-заставка, 121

Функции, 56,74 
Функциональность времени 

выполнения, 88 
Цвет, диалоговое окно, 112 
Целостность данных, 165 
Целостность, данные, 165 
Циклическое повторение кода, 68 
Чтение таблиц Excel, 152 
Чтение текстовых файлов, 148 
Чтение файлов XML, 154
l l l j r r™,  гчья  i / unn i / a  1П1

Шаг с заходом, кнопка, 100 
Шаг с обходом, кнопка, 101 
Шрифт, диалоговое окно, 112 
Элементы массива, 62 
Элементы программы, 56 
Элементы управления данными, 180 
Язык структурированных запросов 

(SQL), 184
Ячейка, таблица Excel, 136
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ПРОГРАММИРОВАНИЕ
ДЛЯ НАЧИНАЮЩИХ

НАЧНИ ПРОГРАММИРОВАТЬ ПРЯМО СЕЙЧАС!



Начни программировать прямо сейчас!
В этой книге содержится полная пошаговая 
инструкция для тех, кто решил начать самостоя­
тельное изучение языка Visual Basic. При помощи 
наглядных примеров и понятных разъяснений автор 
показывает, как, не тратя лишнего времени и сил, 
освоить азы программирования на Visual Basic и 
начать разработку собственных Widows-приложений 
в среде Visual Studio. В книге приводятся примеры 
кода, снимки экрана и пошаговые инструкции, 
наглядно иллюстрирующие каждый аспект языка 
Visual Basic.

Повествование начинается с описания процесса 
установки, после чего вы познакомитесь с различ­
ными элементами управления форм, свойствами 
приложения, языком программирования, а также 
методиками решения проблем. Создание и развер­
тывание приложений для Windows проиллюстри­
ровано множеством примеров.

Кроме того, в книге исследуются возможности напи­
сания сценариев с помощью языка Visual Basic для 
создания макросов Microsoft Office и существующих 
динамических веб-страниц для Internet Explorer, 
а также многое-многое другое, чтобы помочь вам 
создавать свои собственные интерактивные 
приложения.

Книга «ПРОГРАММИРОВАНИЕ НА VISUAL BASIC 
ДЛЯ НАЧИНАЮЩИХ» — ваш правильный выбор 
для самостоятельного изучения языка!

САМОЕ ВАЖНОЕ:

РАЗРАБОТКА НА ПРИМЕРЕ 
СРЕДЫ VISUAL STUDIO

ЭЛЕМЕНТЫ УПРАВЛЕНИЯ 
И ТИПЫ ПЕРЕМЕННЫХ

ФУНКЦИИ И ВЫЧИСЛЕНИЯ

ПОШАГОВАЯ СБОРКА 
ПРИЛОЖЕНИЙ

ОТЛАДКА КОДА 
И РЕШЕНИЕ ПРОБЛЕМ

СОЗДАНИЕ СЦЕНАРИЕВ

СОЗДАНИЕ БАЗ ДАННЫХ

«Книга посвящена вопросам программирования на языке Visual Basic под управлением новейшей версии интегри­
рованной среды разработки Visual Studio 2017 В ней рассмотрен широкий круг вопросов - от установки и настройки 
среды разработки до изучения особенностей языка и программирования приложений, в том числе для работы с 
базами данных, Excel-таблицами и XML-файлами. Доступно написанная, с большим количеством иллюстраций и 
примеров, эта книга легко позволит освоить Visual Basic начинающим программистам».

Ирина Карпова,
кандидат технических наук, доцент МФТИ




